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Legal Notices

Warranty
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additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
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commercial license.
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AMD is a trademark of Advanced Micro Devices, Inc.
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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:
https://softwaresupport.hp.com

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:
https://hpp12.passport.hp.com/hppcf/createuser.do

Or click the the Register link at the top of the HP Software Support page.

You will also receive updated or new editions if you subscribe to the appropriate product support service.
Contact your HP sales representative for details.

Support
Visit the HP Software Support Online web site at: https://softwaresupport.hp.com

This web site provides contact information and details about the products, services, and support that HP
Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to
access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the support web site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
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l Download software patches
l Manage support contracts
l Look up HP support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To register for an HP Passport ID, go to:

https://hpp12.passport.hp.com/hppcf/createuser.do

To find more information about access levels, go to:

https://softwaresupport.hp.com/web/softwaresupport/access-levels

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables
you to explore HP Product Solutions to meet your business needs, includes a full list of Integrations between
HP Products, as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp

About this PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print multiple
topics from the help information or read the online help in PDF format. Because this content was originally
created to be viewed as online help in a web browser, some topics may not be formatted properly. Some
interactive topics may not be present in this PDF version. Those topics can be successfully printed from
within the online help.
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Getting Started with Administration Tasks
Getting Started with administrative tasks:

l Understand the logon, password and tab access issues. For details, see "Logon" on page 13.
l Understand the security recommendations, LW-SSO, logs, Web server, cryptography,
Supervisor, and working with Xcelsius. For details, see "Security Recommendations" on
page 21, "LW-SSO " on page 22, "Logs and the LogTool" on page 23, "Web Server" on page 30,
"Cryptography" on page 31, "IT Executive Scorecard Supervisor" on page 32, and "Xcelsius" on
page 33

l Understand the Start menu. For details, see "Start Menu" on page 37.
Manage Licenses. For details, see "Licenses" on page 46.

l Chrome and BOE reports. For details, see "Chrome and BOE Reports" on page 53.
l Manage users, roles, and resources, and work with LDAP. For details, see "Users, Roles,
Resources, and Permissions" on page 55.

l Manage the datasources. For details, see "Data SourceManagement" on page 131.
l Manage the ETL. For details, see "Data SourceManagement" on page 131.
l Configure Settings:

l Configure Foundation, pages, Single Sign On, and Website settings. For details, see
"Perform Administration Tasks for Foundation" on page 176.

l Configure Dashboard Settings, Score thresholds, XS settings and engine settings. For
details, see "Perform Administration Tasks for Foundation" on page 176

l Configure ITFM settings. For details, see "ITFM " on page 198

l ConfigureData WarehouseSettings. Information about DataWarehouse configuration is
provided in "DataWarehouse" on page 177.

l Manage the Semantic Layer (Business Contexts and Universes). This includes information
about SAP BusinessObjects universes, out-of-the-box Contexts, user-defined Contexts and
explains how to Import Data from Static Files using Context Designer. For details, see Semantic
Layer - Contexts and Universes.

l Manage Content Acceleration Packs. Content Acceleration Packs are used for Proof of Concepts
(POCs) sessions or to start creating your own application. For details, see Content Acceleration
Pack. You can also create your ownCAPs using existing Dashboard pages, Contexts, Scorecards,
KPIs, Metrics, and Data (.CSV files). For details, see Create Content Acceleration Packs.

l Partitioning. Activate partitioning. For details, see "Partitioning" on page 218.
l Connect servers in a 4 servers configuration. For details, see "4 Servers Configuration - Server
Connection" on page 222

l Add dimensions to the FinancialManagement context For details, see Add Dimensions to
FinancialManagement Context and Integrate with PPM.

l View the Data Lineage of a KPI. The data lineage of a KPI enables you to view, in graphical
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format, all the entities, fields, views, tables, contexts, andmore, up to the data source fields that
provide the data used to calculate the KPI. For details, see KPIs, Metrics, Contexts, and Data
Source Integrations.

l Work with Telcom Management Forum KPIs. For details, see "Work with Enhanced Telecom
Operations Map KPIs" on page 224.

l Localize and Globalize IT Executive Scorecard. For details, see "Localization andGlobalization"
on page 234.

l Use Entity Relationship Tools. For details, see "Enterprise Readiness (ER) Tools" on page 237
l Migrate from a Development or Test Environment to Production. For details, see "Migrate
from Development or Test Environment to Production" on page 243.

l Back up Data Warehouse. For details, see "DataWarehouse Back Up " on page 265.
l Back up Executive Scorecard. For details, see "Executive Scorecard Back Up " on page 268.
l Perform recovery tasks. This includes the backup tasks (Executive Scorecard, and Data
Warehouse back ups). For details, see "Disaster and Recovery" on page 270.

l Recovery. For details, see "Disaster and Recovery" on page 270.
l Perform Administration Tasks. Information about administration tasks that need to be performed
in IT Executive Scorecard and IT Financial Management is provided in "Perform Administration
Tasks for Foundation" on page 176.
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Logon
You access the Dashboard, STUDIO, EXPLORER, Finance, and ADMIN tabs from themain logon
page.

Note: Only users with the required permissions can view specific tabs.

When you have completed your session, it is recommended that you log out to prevent unauthorized
entry.

You access the IT Executive Scorecard application using a supportedWeb browser, from any
computer with a network connection (intranet or Internet) to the servers. It is recommended to restore
your browser settings to default.

The level of access granted to a user depends on the user’s permissions. For details, see "User
Management" on page 79.

You can initially access the ADMIN tab through the IT Executive Scorecard logon page, using your
administrator user name and password, created during installation.

Tasks
This section includes:

• Access the logon page 13
• Change the default session timeout of the automatic Log out 14
• Configure the default lockout on log on 14
• Access the logon page and all tabs 15
• User Authentication 15
• User Passwords 15
• Working with Secure Sockets Layer (SSL) in a Production Environment 16
• Log out 19
• Shared Secret Key 19

Access the logon page
To access the logon page, enter:

l http://<full resolution host>:<port>/xs. If you are using a non-default port youmust update it in
the URL. For details, see "Web Server" on page 30.

l If you are using a default http port, the port can remain empty.
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The ADMIN tab is configured by default with Lightweight Single Sign-On (LW-SSO). LW-SSO enables
you to log on and automatically have access to LW HP applications, without needing to log on to those
applications. For details, see "LW-SSO " on page 22.

Change the default session timeout of the
automatic Log out
Executive Scorecard automatically performs a security log out of the XS session. When the application
is idle for a set amount of time the session times out, an automatic log out occurs, and the logon screen
is displayed within the XS application. The timeout is set by default to 30minutes and can be
configured using:

<Installation directory>\agora\glassfish\glassfish\domains\BTOA\applications\fndwar\WEB-
INF\web.xml

<session-config>
<session-timeout>

30
</session-timeout>

</session-config>

Note: The automatic log out works in conjunction with the Executive Scorecard ping interval,
configured in "Website" on page 196. Youmust select theEnable Keepalive Session check box
to enable the automatic session timeout. An automatic log out occurs only after the session
timeout has been attained and only on a ping request. If the pingmechanism has been turned off,
then no automatic log out occurs. If a user-initiated request comes in between the time of the
timeout and the ping, then the session idle time will be reset and the timer will start over again.

Configure the default lockout on log on
Executive Scorecard logon allows you, by default, 5 consecutive logon attempts before a 15minute
lockout. You can configure the lockout parameters using the following properties file.

To configure the lockout parameters:

1. Access the following file:
\<HPXS>\agora\glassfish\glassfish\domains\BTOA\config\conf\bsf.properties.

2. Search for the following parameters: 
l accountLockoutMaxAttempts=5

l accountLockoutLockoutPeriod=15

3. Change the default logon attempts and lockout period. 0means that there is no lockout time
configured.

4. Save and restart the Glassfish service.
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Access the logon page and all tabs
1. In aWeb browser, enter the http://<server_name>.<domain_name>/XS URL for the fully

qualifiedmachine where XS is installed.
2. Enter the username and password, and click Log On. After a successful logon, the user name

appears at the top right of the page of the application.
3. Close the original logon window once the application has loaded.
4. Click the ADMIN tab to navigate the admin pages. Only users with the required permissions can

view the ADMIN tab.

Note: To log on for the first time, use your administrator password created during installation.

User Authentication
User authentication depends on your configuration. For details, see "Users and authentication when
working with SAP BusinessObjects and LDAP or without" on page 91.

User Passwords
Passwords can be changed in theUser Details pane of the User Management page. Click Edit
Details to change a user's password. For details, see "User Management" on page 79.

Note: Depending on your configuration (working with or without SAP BusinessObjects and with or
without LDAP), the handling of the password can be different. For details, see "Users and
authentication when working with SAP BusinessObjects and LDAP or without" on page 91.

A passwordmust contain the following:

l At least 6 characters.
l Characters in upper and lower case or numbers.
l Must be different from username.
For example: the user name "Jhon" cannot have a "Jhon11" or "11Jhon" password.

Note:

l Logon parameters are case-sensitive.
l If a password does not follow the correct conventions then the user is still created in SAP
BusinessObjects Enterprise, however the password is not valid andmust be changed.
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Working with Secure Sockets Layer (SSL) in a
Production Environment
When you log on to the IT Executive Scorecard application using the http or https format in a
Production environment, the following scenarios can occur:

1. http.
a. When you use the http format to access directly the Executive Scorecard application, the

authentication transfers you to the DataWarehouse application. A message states that a
security certificate is issued. Click theContinue to this website link. In the DataWarehouse
page, click the Certificate Error button in the browser toolbar. In the Certificate dialog box that
opens, click theView Certificate link. In the wizard that opens, select thePlace all
certificates in the following store, select the Trusted Root Certification Authorities
location, and click OK. Once you have installed the certificate, and entered your user and
password, the DataWarehouse application transfers you back to the Executive Scorecard
application.

b. When you use the http format to access directly the DataWarehouse application, amessage
states that a security certificate is issued. Click theContinue to this website link. In the
DataWarehouse page, click the Certificate Error button in the browser toolbar. In the
Certificate dialog box that opens, click theView Certificate link. In the wizard that opens,
select thePlace all certificates in the following store, select the Trusted Root
Certification Authorities location, and click OK. Once you have installed the certificate, and
entered your user and password, the DataWarehouse application opens.

2. https.When you use the https format:
l IE and Chrome.

i. When you use the https format to access the Executive Scorecard application, the
security certificate issue is displayed. Click the security certificate. In the Certificate
dialog box that opens, click theView Certificate link. In the wizard that opens, select the
Place all certificates in the following store, select the Trusted Root Certification
Authorities location, and click OK. Continue running the wizard. This warningmessage
is not displayed again. The DataWarehouse application opens in SSL mode. After
performing the logon operation, you can add the Executive Scorecard certificate in the
successfully launched Executive Scorecard application page, not in the application page
itself. When the Java security warning contains the correct publisher (Hewlett-Packard
Company) you should accept the Java security warning by marking theAlways trust
content from this publisher check box in order for this popup not to be displayed again.

ii. When you use the https format to access directly the DataWarehouse application, a
message states that a security certificate is issued. In the Certificate dialog box that
opens, click theView Certificate link. In the wizard that opens, select thePlace all
certificates in the following store, select the Trusted Root Certification Authorities
location, and click OK. This warningmessage is not displayed again. The Data
Warehouse application opens in SSL mode. When the Java security warning contains
the correct publisher (Hewlett-Packard Company) you should accept the Java security
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warning by marking theAlways trust content from this publisher check box in order
for this popup not to be displayed again.

l Firefox.
When you use the https format to access directly the Executive Scorecard application or the
DataWarehouse application, and you work with Firefox, youmust perform the following
procedure:
i. Open each of the servers using https. The following screen opens:

ii. Click I Understand the Risks. The following page opens:

Administrator Guide
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iii. Click Add Exception. The following screen opens:

Administrator Guide
Logon

HP IT Executive Scorecard (9.50) Page 18 of 342



iv. Click Confirm Security Exception.

Note:When you use the https format and you want to access SAP BusinessObjects Enterprise
reports, the reports are displayed using the http format.

Log out
To log out:

You can log out by clicking Logout (in the top right corner of the application). The session closes. To
log on again, youmust provide the user and password.

Shared Secret Key
Executive Scorecard functionality requires a connection to SAP BusinessObjects Enterprise through a
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trusted authentication. In order to configure the trusted authentication policy youmust define the shared
secret key.

The shared secret key, created in the post-install process, is used by the client and the CMS to create
the trusted authentication password. This password is used to establish trust.

Note: To change the shared secret key youmust change the key in SAP BusinessObjects
Enterprise, run the post-install wizard and enter the new shared secret key. For details, see the IT
Executive Scorecard Installation Guide for a Development/Test/Proof-of-Concept (POC)
 Environment or IT Executive Scorecard Installation Guide for a Production Environment.
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Security Recommendations
Immediately following installation or upgrade procedures, perform the following steps.

For MSSQL Database improved security:

l Disable xs_cmdshell. For details, see http://technet.microsoft.com/en-us/library/ms175046.aspx.
l Revoke the public permissions from xp_instance_regread and xp_regread . For details, see
http://technet.microsoft.com/en-us/library/ms187719.aspx.

For Database Stored Procedures:

The database contains extended stored procedures that allow read and write capabilities for sensitive
data from theWindows registry.

In order to remove an extended stored procedure, use: sp_dropextendedproc @functname='{name
of extended stored procedure}.

Note: Some applications may not work properly without these stored procedures. Make sure to
verify that they are not in use by a production application before removal.

l xp_instance_regaddmultistring
l xp_instance_regdeletekey
l xp_instance_regdeletevalue
l xp_instance_regenumkeys
l xp_instance_regenumvalues
l xp_instance_regread
l xp_instance_regremovemultistring
l xp_instance_regwrite
l xp_regaddmultistring
l xp_regdeletekey
l xp_regdeletevalue
l xp_regenumkeys
l xp_regenumvalues
l xp_regread
l xp_regremovemultistring
l xp_regwrite
For User Management:

l To improve password policy, use LDAP. For details, see "LDAP Management" on page 91.
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LW-SSO
HP Lightweight Single Sign-On is amethod of access control that enables you to navigate to other HP
products that implement LW-SSOwithout supplying credentials again. A user can log on once and gain
access to the resources of HP software systems without being prompted to log on again. The
applications inside the configured group of software systems trust the authentication, and there is no
need for further authentication whenmoving from one application to another.
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Logs and the LogTool
IT Executive Scorecard records the procedures and actions performed by the various components in
log files. The log files are usually designed to serve HP Software Support when Executive Scorecard
does not perform as expected. The default severity threshold level for log files differs per log, but is
generally set to eitherWarning or Error.

You can view log files with any text editor.

The LogTool enables you to view, manage, and analyze your logs.

The URL of the LogPortal where you can use the LogTool is:
https://<xs_server_fqdn>:10003/LogPortal.

To access:

The URL of the LogPortal where you can use the LogTool is:
https://<xs_server_fqdn>:10003/LogPortal.

Learn More
Common Component Log Files and Their Location

Log Filename Description
Location: 
<Installationdirectory>\agora

access.log Records all requests processed
by the web server.

\webserver\logs

error.log The web server error.log is the
most important log file.

This is the place where Apache
httpd sends diagnostic
information and records any
errors that it encounters when
processing requests.
It is the first place to look when
a problem occurs with starting or
operating theWeb Server.

\webserver\logs

install.log Installation log \webserver\logs

jk.log Contains information about
communications between the
Web Server and the application

\webserver\logs
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Log Filename Description
Location: 
<Installationdirectory>\agora

server (Glassfish).

ssl_request.log Logs records of all secured
requests processed by theWeb
Server.

\webserver\logs

ConfigWizard.log Logs the post-install flow. Is
useful when the post-install
configuration wizard fails.

\confwizard\log

FileParser.log Logs file parsing tasks during
post-install configuration wizard.

\confwizard\log

applicationfw.log Logs application loading and
permission enforcement related
to the application framework.

\glassfish\glassfish\domains\BTOA\logs

athN.log Logs requests for authentication
and population of user roles and
permissions.

\glassfish\glassfish\domains\BTOA\logs

aui.log Logs user management user
interface details.

\glassfish\glassfish\domains\BTOA\logs

bo-services.log Logs the usage of SAP
BusinessObjects services,
including issues locating the
SAP BusinessObjects CMS.

\glassfish\glassfish\domains\BTOA\logs

bsf.log The BTOSecurity Framework
(BSF) server-side log records
authentication information about
authn, LW-SSO, and user mng.

\glassfish\glassfish\domains\BTOA\logs

btoe-services.log Logs the usage of foundation
services.

\glassfish\glassfish\domains\BTOA\logs

datalayer.log Logs SAP BusinessObjects
datalayer transactions such as
problems with SAP
BusinessObject Universes or
queries.

\glassfish\glassfish\domains\BTOA\logs

foundation.log Foundation core components
log.

\glassfish\glassfish\domains\BTOA\logs

hibernate.log Hibernate log. \glassfish\glassfish\domains\BTOA\logs

jvm.log JVM general log. \glassfish\glassfish\domains\BTOA\logs
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Log Filename Description
Location: 
<Installationdirectory>\agora

license-
services.log

Licensing logs. \glassfish\glassfish\domains\BTOA\logs

properties.log Properties table logs. \glassfish\glassfish\domains\BTOA\logs

server.log General GlassFish log. \glassfish\glassfish\domains\BTOA\logs

settings.log Settings management logs \glassfish\glassfish\domains\BTOA\logs

sso.log Logs authentication details
related to IDM and LW SSO.

\glassfish\glassfish\domains\BTOA\logs

uim.log User Interfacemash-up logs. \glassfish\glassfish\domains\BTOA\logs

userMng.log UserManagement actions log,
including problems with
communication to SAP
BusinessObjects.

\glassfish\glassfish\domains\BTOA\logs

log.txt MQBroker service log. \glassfish\glassfish\domains\domain1
\imq\instances\imqbroker_host1\log

Executive Scorecard Log Files and Their Location

Log filename Description
Location: 
<Installationdirectory>\agora

dashboard.log Logs all the dashboard’s server side
logs.

\glassfish\glassfish\domains\BTOA\logs

studio.log Logs general information for
Executive Scorecard Studio, the
client module used for tailoring
Executive Scorecard.

\glassfish\glassfish\domains\BTOA\logs

engine.log Logs general information about the
engine, KPIs, and business context
calculation details.

\glassfish\glassfish\domains\BTOA\logs

engine_
statistics.log

Provides a summary of calculation
cycles, and statistics about KPI
engine performance.

\glassfish\glassfish\domains\BTOA\logs

Data Warehouse Log Files and Their Location

Log files can be accessed under:

Log Description Location

fbi.log Logs the source extraction information. <HPXS>\agora\DataWarehouse\logs
directory

Administrator Guide
Logs and the LogTool

HP IT Executive Scorecard (9.50) Page 25 of 342



Log Description Location

dwh.log Logs the DWH management activities. <HPXS>\agora\DataWarehouse\logs
directory

dsm.ui.log Logs DatasourceManagement UI
management activities.

<HPXS>\agora\DataWarehouse\logs
directory

Tasks
This section includes:

• Access the LogTool in the LogPortal 26
• Downloading the log files 26
• Access DataWarehouse log information 27

Access the LogTool in the LogPortal
1. Access the LogPortal at: https://<xs_server_fqdn>:10003/LogPortal. In a Production

environment, you should checks the logs in each server.
2. Enter your user/password:

l If the installation was successful, the username/password for LogPortal is same as the
glassfish admin console (locahost:10001) user/password that you entered during the post-
install procedure.

l If an error occurred during installation:
o Option 1: Try try to access the LogPortal (for credentials, use admin for the username, and

an empty password). If it is not accessible, then useOption 2.
o Option 2:Use a text editor to analyze the logs in the file system.

3. You can now select the product area, the time range, to include the log history or not, select the
relevant log to display it in the detail area, and then select the filters to display only the lines that
include the filter string.

4. You can also set up, in theRefresh Rate field, how often you want the log list and the log viewer
to check for updates on the server side .

Downloading the log files
l Option 1: Click in the relevant log list row to download the corresponding log file.
l Option 1: Click here inClick here to download all files, creates a zip file with all the logs in the
selected product area.
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Access Data Warehouse log information
1. In theWindows taskbar, click Start > Administrative Tasks > Event Viewer.
2. ExpandWindows Logs, right-click Application, and then click Filter Current Log.
3. Select the relevant Event Levels, select the relevant Event Sources, and then click OK.

All the DataWarehouse Event Sources begin with the DWH string.

UI Description
LogTool page

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Product area Filter the logs by their product area:

l App Server Logs
l CAP
l ConfigWizard Logs
l DWH Logs
l DWH UI, FBI
l Dashboard
l Engine
l Foundation, BOE
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l Server
l Studio
l Supervisor Logs
l User Mgmt
l Webserver Logs

Note: You can edit the product area in the
<HPXS>\agora\conf\logGroupsConfig.xml file.

Time range Filter the logs that were created in the selected time range: All, 1min, 5 min, Last
15 min, Last 30 min, Last hour, or Last day.

Include the
log history

Select to include the log history (the log files that were rotated; for example: <log_
name>.log.1, <log_name>.log.2).

Log Level
filter

You can filter the log entries to display only the entries that start with the following
strings: ERROR,WARN, INFO, DEBUG, or your own string.

Note: The ERROR filter also includes the stack trace of the error.

Refresh rate
(in seconds)

The rate of refresh of the log list and the update check interval of the currently
opened log file, in seconds.

Default: 15

<Message> Showing <nn> files. Themessage displays the number of logs.

Click here to download all files. Creates a .ZIP file of all the listed logs.

Log File
Name

The log files filtered for the product area and the time range.

Click the log name to display its details.

indicates that the log includes errors within the selected time range.

Click the arrow in the column header to sort the list.

Last Updated The date and time when the log was last updated.

Click the arrow in the column header to sort the list.

By default, the table is sorted by the Last Updated in descending order.

Click to download the selected log file (not in ZIP format).

<Log details
area>

The contents of the selected log.

Select the relevant Log Level filter to display only the log entries that start with the
string.

Example: When you select ERROR, the log details area displays:
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Web Server
IT Executive Scorecard uses the Apache web server for securing the application and caching static
content in order to improve client performance. The web server is installed and configured in the
deployment procedure and does not require any changes or maintenance.

The default ports are listed in the IT Executive Scorecard Support Matrix. If you use a non default port
for the URL, youmust enter the application using http://<host>:<port number>/xs or
http://<host>:<port number>/dwh.

Note: These ports can be configured to any other ports in the deployment procedure.
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Cryptography
The encryption properties files are located in <Installationdirectory>\agora\conf. The path can be
determined by setting the crypt.conf.dir.path system property to the relevant path. Themanagement
database credentials encrypted locally on each server. Youmust also store all the relevant
configuration for decrypting locally.

The following encryption keys are available:

l Encryption Key:Single shared key for all servers shared through the database. Stored on each
machine locally in the encryption properties files as part of the post-install procedure.

l Seed Key:Key that is generated after each post-install procedure. Themain encryption key is
stored in the seed key.
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IT Executive Scorecard Supervisor
The HP IT Executive Scorecard Supervisor monitors whether the Executive Scorecard server
processes are up and running.

The Supervisor consists of two elements:

l Themanagement element manages (starts/stops/monitors) theWeb Server, MQ Broker, and
Glassfish components that are services. The Supervisor manages them in the following order:
a. Web Server
b. MQ Broker
c. Glassfish

l The watchdog element monitors processes. If a process is down, the SupervisorWatchdog tries to
start it automatically.

The Supervisor is a service that works onWindows.

Contact HP Software Support Online web site (http://www.hp.com/go/hpsoftwaresupport) if the
monitor cannot start the Supervisor process.
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Xcelsius
You can use Xcelsius to display Flash reports or dashboards over Executive Scorecard target
schemas.

You can create Xcelsius reports based on SAP BusinessObjects EnterpriseWebi reports. For details
on the pre-definedWebi reports provided with Executive Scorecard, see Xcelsius Reports in the IT
Executive Scorecard Reports ReferenceGuide.

You can then add these reports to Dashboard page using the Xcelsius components. For details, see
The SWF Report Viewer Component or The Xcelsius Reports Viewer (Flash) Component in the
IT Executive Scorecard Business Analyst Guide.

The InstallationMedia for Xcelsius as well as the Xcelsius Installation Guide are provided on a
separate installation disc that you can download (TB812-15009.ISO). The disc also includes non-core
utilities and 3rd party application that enhance Executive Scorecard.
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Glassfish Authentication
TheGlassfish Admin Console includes a configuration wizard.

Tasks

Change the admin password for securing the
Glassfish admin console
To change the admin password for securing the Glassfish admin console:

1. Execute the following script:
<HP_XS>\bin\admin-password-change.bat

2. In the prompt:
l Enter the user name: admin.

l Enter the current password. It is empty (click Enter).

l Enter the new password: enter the admin password, then the new admin password, and then
the new admin password oncemore.

3. Check if the password works:
a. Copy the link below and paste it in a browser: http://<localhost>:10001
b. Enter the user name and password as set in the above step.
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Set Up Java
This section describes how to set up Java so Executive Scorecard displays properly in Internet
Explorer or Chrome.

Tasks

Set Up Java
To set up Java:

1. Click Start > All Programs > Java > Configure Java.
2. In the Java Control Panel, click theSecurity tab.
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3. Make sure that theEnable Java content in the browser option is selected.
4. Set up the security level toHigh.
5. Enter the http://<FQDN>:8080 site in theException Site List.
6. Click OK.
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Start Menu
During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed.

You can use the Start menu to perform the following tasks:

• Launch Executive Scorecard Using the Start Menu 38
• Launch Executive Scorecard 38

• Start the Post-Install Wizard Using the Start Menu 38
• Start the Post-Install wizard 38

• Renew your License Using the Start Menu 38
• Enable or Disable the GlassfishWeb Server using the Start Menu 39
• Enable the GlassfishWeb server using the Start menu 39
• Disable the GlassfishWeb server using the Start menu 39

• Uninstall HP IT Executive Scorecard Using the Start Menu 39
• Uninstall HP IT Executive Scorecard using the Start menu 40

• Access the Documentation Library and the Installation and Configuration documents using the
Start Menu 40
• Access the HP Executive Scorecard Deployment Guide using the Start menu 40
• Access the Online Documentation Library using the Start menu 41
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Launch Executive Scorecard Using the Start
Menu
During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can lainch Executive Scorecard using the Start menu.

Tasks

Launch Executive Scorecard
1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start >

Programs > HP Executive Scorecard.

2. Select HP Executive Scorecard.
This launches IT Executive Scorecard.

Start the Post-Install Wizard Using the Start
Menu
During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can start the post-install wizard using the Start menu.

Tasks

Start the Post-Install wizard
1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start >

Programs > HP Executive Scorecard.
2. Select Configuration Wizard.

Follow the steps in the ConfigurationWizard that opens.

Renew your License Using the Start Menu
During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can renew your license using the Start menu. For details, see "Licenses"
on page 46.
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Enable or Disable the Glassfish Web Server
using the Start Menu
During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can enable or disable the GlassfishWeb Server using the Start menu.

Tasks

• Enable the GlassfishWeb server using the Start menu 39
• Disable the GlassfishWeb server using the Start menu 39

Enable the Glassfish Web server using the Start menu
1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start >

Programs > HP Executive Scorecard.
2. Select Enable HP Executive Scorecard.

This enables the GlassfishWeb server. Users can access IT Executive Scorecard.

Disable the Glassfish Web server using the Start menu
1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start >

Programs > HP Executive Scorecard.
2. Select Disable HP Executive Scorecard.

This disables the GlassfishWeb server. Users cannot access IT Executive Scorecard.

Uninstall HP IT Executive Scorecard Using the
Start Menu
During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can use the Start menu to uninstall IT Executive Scorecard.
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Tasks

Uninstall HP IT Executive Scorecard using the Start
menu
1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start >

Programs > HP Executive Scorecard.
2. Select Uninstall HP Executive Scorecard.

This uninstalls the IT Executive Scorecard on the server.
IT Executive Scorecard is first uninstalled in silent mode and then the uninstall wizard appears.

Access the Documentation Library and the
Installation and Configuration documents using
the Start Menu
During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can use the Start menu to access the IT Executive Scorecard Installation
Guide for a Development/Test/Proof-of-Concept (POC) Environment or IT Executive Scorecard
Installation Guide for a Production Environment and theOnline Documentation Library Help Center.

Tasks

• Access the HP Executive Scorecard Deployment Guide using the Start menu 40
• Access the Online Documentation Library using the Start menu 41

Access the HP Executive Scorecard Deployment Guide
using the Start menu
1. To access the IT Executive Scorecard Start menu that is added to eachmachine, select Start >

Programs > HP Executive Scorecard.
2. Select HP Executive Scorecard Deployment Guide.

This opens the IT Executive Scorecard Installation Guide for a Development/Test/Proof-of-
Concept (POC) Environment or IT Executive Scorecard Installation Guide for a Production
Environment.
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Access the Online Documentation Library using the
Start menu
1. To access the IT Executive Scorecard Start menu that is added to eachmachine, select Start >

Programs > HP Executive Scorecard.
2. Select HP Executive Scorecard Documentation Library.

This opens the HP Executive Scorecard Documentation Library Help Center in yourWeb browser.
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Restart the XS Application
You can restart the XS application using the Start Menu shortcut. For details, see "Launch Executive
Scorecard Using the Start Menu" on page 38.

You can also restart the XS application using the Glassfish Admin console. For details, see below.

Tasks

Restart XS using the Glassfish Admin console
1. Open the JMXWeb console.
2. On the XS Application Server open Internet Explorer and navigate to http://localhost:11021/

The user name and password are admin and admin.
The following page opens:

Administrator Guide
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3. Navigate to Foundations: type= SupervisorManager.
4. Invoke show ServiceInfoAsHTML.
5. Invoke java.lang.String show ServiceInfoAsHTML.
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6. Restart the service by clickingRestart for the line of the Executive Scorecard service.

7. Observe the restart progress by navigating back toServer View > “Foundations: type=
SupervisorManager > java.lang.String show ServiceInfoAsHTML.
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Licenses
This section explains about the types of licenses, how to renew a license using the Start menu and how
to check if all your user licenses are valid.

To access:

Click Help > About in the upper right corner of the application.

Learn More
License Types

Two types of licenses are available:

l Power Named User License. This license is for every type of user with no limitation on the
permissions.

l Casual Named User/Viewer License. This license is for users with a very limited set of
permissions.

You cannot purchase a standaloneCasual Named User/Viewer License. With theCasual Named
User/Viewer License youmust also purchase at least onePower Named User License (youmust
apply 2 License Keys).

Example

l If you want 50 Viewer users, youmust purchase at least 1Power Named User License
(Advanced user) and 50Casual Named User/Viewer Licenses (for the Viewer users).

l If you want 10 Advanced users and 15 Viewer users, youmust purchase 10Power Named
User Licenses (for the Advanced users) and 15Casual Named User/Viewer Licenses (for
the Viewer users).

Who is Counted as Power Named Registered Users

In addition to Advanced users (assigned the Power NamedUser License), users with a set of
permissions that is larger than and includes the following permissions: View Page, Cascade
Scorecard, Explorer Access, Forecast, View Scorecards,Manage Annotation are also considered
Advanced users and are counted accordingly. For details, see "RoleManagement" on page 63.

Tasks
This section includes:
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• Renew your license using the Start menu 47
• Check users licenses 50

Renew your license using the Start menu
1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start >

Programs > HP Executive Scorecard.
2. In the Administration directory, select License Renewal.

The Introduction page opens.

3. Click Next. The License Management - Load a Power Named User License page opens. If a
valid Power NamedUser License was found, themessageA valid Power Named User License
was found is issued.

Administrator Guide
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4. Click Next. The License Management - Load a Viewer License page opens.
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a. If you have a Casual NamedUser/Viewer License, click Load to load it. When the operation
performs successfully, themessageA valid Casual Named User/Viewer License was
found is issued. Click Next to complete the renewal.
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b. If you do not want a Casual NamedUser/Viewer License, click Next to complete the renewal.

Movie: To display the relevant movie, open the XS application, click Help in the top right corner of
the applicationmain page and select theMovies option. Select the relevant movie. For details, see
Access Movies.

Check users licenses
You can check if all the users of the application have valid licenses.

1. Prerequisites:
If you are working with LDAP users, make sure you have performed the appropriate procedures.
For details, see "LDAP Management" on page 91.

2. Get the user license information:
a. Use an authorized HP user to log on to the customer’s Executive Scorecard installation.
b. Click Help > About in the top right-hand corner of the application display.

The type of license (temporary or permanent), the number of registered users and the number
of licensed seats (the number of purchased licenses) are displayed.
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c. Click the number of users to view the details of the users. A list of the users is displayed.

When users do not have a valid license, a red icon is added to the left of the Registered
users indication.
For details about who is counted as Power NamedRegistered Users, see "Who is Counted
as Power NamedRegistered Users" on page 46

Note: An error image to the left of Registered Users and a tooltip indicate if there has
been a breach of contract. User that are not part of the Viewer Users Group are
considered Advanced Users and are counted accordingly.
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Chrome and BOE Reports
If you are using the Chrome browser and your Dashboard pages include SAP BusinessObjects
Enterprise (BOE) reports, you are presented with a shield icon in the browser address bar each time
you start the application. This creates an extra step to tell the browser to run the content.

Tasks
You can decide to allow the running of insecure content per session or by default.

This section includes:

• Allow the running of insecure content per session 53
• Allow the running of insecure content by default 53

Allow the running of insecure content per
session
When you open Executive Scorecard in Chrome and the shield icon appears in the top right corner of
your application:

1. Click the shield.

2. In the dialog box that opens, click Load unsafe script:

You can now view BOE reports in Dashboard pages.

Allow the running of insecure content by
default
To run BOE reports in Dashboard pages in Chrome, youmust set Chrome to allow the running of
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insecure content by default by adding the --allow-running-insecure-content parameter to the start up
of the shortcut.

1. Create a Chrome shortcut on the desktop by right-clicking and dragging the Chrome browser from
theWindows> Startmenu to the desktop, and select Create shortcuts here.
You now have a Chrome shortcut on the desktop.

2. Right-click the shortcut and select Properties.
3. In the Target field, add --allow-running-insecure-content at the very end of the string that is

already there.
4. Click Change Icon.
5. In the Change Icon dialog box, in the Look for Icons in this file field, replace the current

directory string with:%SystemDrive%\HPXS\installation\misc\launcher.ico. Click OK. Click
OK again to change the icon to the XS launcher icon. Then click Apply to apply all of the changes.

6. In the your desktop, double-click the shortcut icon to start the Chrome browser. Then click
and select Settings.

7. In theOn Startup section, select Open a specific page or set of pages and click Set pages.
8. In the URL box enter the URL for Executive Scorecard, for example: https://systemFQDN/xs.

Then click OK to save the changes.
9. Close the Browser and then restart it to test the changes. You should be presented with an

Executive Scorecard logon screen.
10. Log in and test to make sure that the BOE reports are displayed without the security icon.
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Users, Roles, Resources, and Permissions
You use users, roles, resources, and permissions to configure who can do what and who can see what
data in XS.

Learn More
Resources

A resource is a logical group of one or more XS application data items (for example Dashboard pages,
Scorecards, Budgets, or Budget Cost Centers). Once you define resources, you can attach the
resource to a permission.

Roles and Permissions

Each role is a set of permissions. Permissions define which actions the user can perform and on which
resources. For example, you can create a role that enables its users to create Dashboard pages.

Users and Groups

Each user has a list of roles that define their permissions. When you assign a role, that user only has
access to specific portions of the application and specific resources that are relevant to their role. You
can also define groups of users with the same roles or access rights. When you attach a user or group
to a group, the user or group inherits all of the group’s roles.

Typical users are:

Term Description

Viewer Users Users that have limited permissions and inmost cases can only view content in the
Dashboard and Explorer without any option tomodify it. They will not have access
to the STUDIO, FINANCE, and ADMIN tabs. In some cases we refer to them as
Viewer users

Advanced
Users

All users that are not Viewer users (including users under the Administrator group,
Scorecard Administrator Group and users that are not under any group).

Scorecard
Administrator

Type of Advanced user with permissions to create Scorecards and Dashboard
pages

Super-Admin Super user, a subset of the Advanced User – normally this user deals with the
installation, foundation and permission issues. This user is the Admin user that
was created during installation.
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Diagram

The following diagram illustrates the relationship between users, groups, roles, permissions, and
resources in the ADMIN tab.

Tasks
The Administrator uses the ADMIN tab to define users that have roles, which contain a set of
permissions that may contain resources. It is recommended to create resources and attach them to
permissions first in the user management process.

1. "ResourceManagement" on the next page
2. "RoleManagement" on page 63
3. "User Management" on page 79
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Resource Management
The ResourceManagement page enables you to view resource and resource types, as well as create a
resource. You can also select instances or application data or components that comprise a resource.

To access:

Select Admin > Users and Roles > Resource Management.

Learn More
Resources, Instances, and Scorecard Resources

Actions users can perform depend on their roles and permissions. Resources are the basis for user and
role management. For each user or group, you assign a set of permissions called 'Role' that allow to
perform specific actions on specific resources.

l Resources. A resource is a logical group of one or more application data sets or components. Once
you define resources, you attach the resource to a permission.

l Instances. An instance is an application data or components that can bemanaged by a user
according to the user's permissions.
Instances are the available application data or components defined in the system.

Note: Users that are created in the ADMIN tab and require permissions to view reports pages
must be assigned those permissions in SAP BusinessObjects Enterprise.

l Scorecard Resources. XS enables you assign specific Scorecard resources to a user.
Additionally, you can restrict user permissions and only allow then to view Scorecards, Dashboard
pages and data that they have been assigned by the Administrator.

Tasks
This section includes:

"Create a resource" below

"Manage instances" on the next page

• Create a resource 57
• Manage instances 58

Create a resource
1. Select Admin > Users and Roles > Resource Management.

HP IT Executive Scorecard (9.50) Page 57 of 342



2. In theResources area, select the type of resource (Budget Cost Centers, Budgets, Pages, or
Scorecards) in the tree, and click Create resource to create a new resource.

3. Enter the name of the resource inResource and a description inDetails.
4. Click OK to save your new resource.

Manage instances
1. Select Admin > Users and Roles > Resource Management.
2. Select a resource in theResources area.

3. In the Instances area of theResource Details pane click Add instances to open theManage
Instances dialog box. Instances are the available application data or components defined in the
system that are attached to resources.

4. Select the instance from theAvailable Instances list and use the arrows tomove the instance to
theSelected Instances list.

5. Click OK to save your changes.

UI Description
Resource Management Page

Click to refresh the page.
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Resources Pane

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Select a resource and click Create resource to open theCreate new resource
dialog box and create a new resource of that type.

After you create the new resource, the Resource Details pane opens. For details, see
"Resource Details Pane" on the next page.

Delete Resource. Deletes the selected resource.

If the resource is the only resource attached to a permission and that permission is
attached to any roles, deleting the resource detaches the corresponding permissions
from these roles.

Refresh. Refreshes the displayed information.

<Resources
Tree>

Contains the resource types and the resources defined for each type.

By default, the tree includes the following resource types:

l Budget Cost Centers
l Budgets
l Scorecards
l Pages

<Right pane>

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Resource type name The name of the selected resource type.

Resource type description The description of the selected resource type.
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Resource Details Pane

When you select a resource in theResources pane, the details appear in this pane.

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Resource
type name

The name of the selected resource type. This information is displayed when you set
the cursor on one of the resource types in the Resources pane.

Resource
type
description

The description of the selected resource type. This information is displayed when you
set the cursor on one of the resource types in the Resources pane.

Add Instances. Adds instances to the selected resource. Opens theManage
Instances dialog box.

Each resource can have one or more assigned application data or component
instances.

In theManage Instances dialog box, select a page from theAvailable Instances list
and use the arrows tomove the instance to theSelected Instances list. For details,
see "Manage Instances Dialog Box" on the next page.

These instances are the available pages defined in the system.

Remove Instances. Removes the selected instance from the resource.

Description The description of the selected resource.
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UI Element Description

Resource The name of the selected resource.

Edit Details Edits the selected resource name and description.

Resource
Description

The description of the selected resource.

Resource
Name

The name of the selected resource.

Instances List of page instances for the selected resource.

Manage Instances Dialog Box

This dialog box enables you to attach pages to a resource.

Select the resource and click the button.
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Select an instance from theAvailable Instances list and use the arrows to
move the instance to theSelected Instances list.

Available and
Selected Instances

Each resource can have one or more assigned instances.
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Role Management
You can define user roles and application permissions in the ADMIN tab. You can also assign
resources to specific permissions.

To access:

Select Admin > Users and Roles > Role Management.

Learn More
Roles and Permissions

Each role contains set of permissions. Permissions define which actions can be performed by the user.
For example, you can create a role that enables its users to create pages or view specific ones. In
some cases, actions can be performed according to the resource attached to a permission.

Note: Users that are created in the ADMIN tab and require permissions to view reports pages,
must be assigned those permissions in SAP BusinessObjects Enterprise.

Resources

A resource is a logical group of one or more XS application data items (for example pages or budgets).
Once you define resources, you attach the resources to a permission. For example, you can specify
that the CIO has View permissions for CIO resources, while the Administrator has View permissions
for all resources.

Tip: It is recommended to define resources prior to defining roles. For details, see"Resource
Management" on page 57.

Pre-Defined Roles

Note: Every out-of-the-box Scorecard has its own dedicated resource and role.

Executive Scorecard and IT Financial Management roles can be assigned any permissions. Executive
Scorecard and IT Financial Management roles are available with the following out-of-the-box
permissions:

Pre-Defined Role
(from A-Z) Description Permissions Module

Administrator The application
administrator.

When a user with the
Administrator role

All Permissions IT Executive
Scorecard
and IT
Financial
Management
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Pre-Defined Role
(from A-Z) Description Permissions Module

activates a CAP, everyone
get permissions to view,
edit, delete all the
Scorecards in the CAP.

BUDGET_
COORDINATOR

Defines the budget
configuration. Notifies the
cost center managers to
populate the budget line
items, follow up with cost
center managers for timely
update of budgets, and
review the input from all
included cost centers.
Publishes the budget to use
in allocation scenarios.
This role is related to IT
Financial Management.

l Finance
l Budget
l View consolidated
budget

l Manage cost center
budget

l Manage consolidated
budget

IT Financial
Management

DWH administrator N/A

FINANCIAL
ANALYST

Uses published budgets in
allocation scenarios. This
role is related to IT
Financial Management.
A FINANCIAL_
ANALYST has the
following permissions:

l Budget
l Finance
l Manage Allocation
Scenarios

l Manage Consolidated
Budget

l Manage Cost Center
Budget

l View Consolidated
Budget

IT Financial
Management

Scorecard
Administrator

Creates andmanages
specific Scorecards and
Pages. Only a user with the
Scorecard Administrator
role can view the created
Scorecard. Once a
Scorecard is created, the
system automatically
generates a resource for
the Scorecard and a role
called GEN_<Scorecard
name>. This Scorecard can
then only bemanaged by
the Scorecard creator and

Studio

Manage Page

Administer Pages

Select KPI

Explorer Access

IT Executive
Scorecard
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Pre-Defined Role
(from A-Z) Description Permissions Module

users with the relevant
GEN_<Scorecard name>
role.

In Dashboard, a user can
only see a Scorecard when
he has the relevant
permission. If a component
is configured with a specific
Scorecard, Perspective,
Objective, KPI, or KPI
Breakdown, the user
cannot see it, and the
followingmessage
appears:
Data is not displayed
because you do not have
the correct viewing
permissions.
Contact your
administrator.

When a user with the
Scorecard Administrator
role activates a CAP, only
the user gets permissions
to view, edit, delete all the
Scorecards in the CAP.

When a user with the
Scorecard Administrator
role drags a KPI from the
Public Metrics and KPIs
directory into a Scorecard
in the Studio, a clone of the
KPI is added to the
Scorecard and the original
KPI remains in thePublic
Metrics and KPIs
directory to be available for
other Scorecard
Administrators. If a user
with theAdministrator role
drags a KPI from the
Public Metrics and KPIs
directory into a Scorecard
in the Studio, the KPI is
added to the Scorecard and
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Pre-Defined Role
(from A-Z) Description Permissions Module

is removed from thePublic
Metrics and KPIs
directory.

Viewer User Note: The Viewer user
list of permissions
cannot bemodified (by
any user).

Permission

Viewer user
allowed
access

Users and
roles

N

Administer
pages

N

Edit settings N

Data Source
management

N

Admin
access

N

Select KPI N

Manage
Allocation
scenarios

N

View
Settings

N

Manage
page

N

View
Scorecard

Y

The Super
Administrator
can assign
the specific
Scorecards
the Viewer
user can
view.

View Page Y

The Super
Administrator
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Pre-Defined Role
(from A-Z) Description Permissions Module

Permission

Viewer user
allowed
access

can assign
the specific
Dashboard
pages the
Viewer user
can view.

View
Consolidated
budget

N

Manage
annotations

Y

Manage
consolidated
budget

N

context
management

N

Cascade
Scorecard

Y

ABC
Management

N

Explorer
access

Y

Budget N

Studio N

Content
acceleration
packs

N

Manage cost
center
budget

N

Finance N

Pre-Defined Permissions
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XS Application
Elements Create and Edit View

Studio l To enter the STUDIO tab you
need theStudio permission

l To create Scorecards in the
Studio, you need theStudio
permission.

Note: TheView Scorecard
permission enables customer
with different departments to
use XS. Each department
can have its own Scorecards
that cannot be viewed or
used by other departments.
This removes the need for
each department to install its
own XS instance.

l To edit relevant Scorecards, you
need theView Scorecard
permission for the relevant
Scorecard.

l To view the STUDIO tab you
need theStudio permission.

l To view specific Scorecards
(their Perspectives, Objectives,
and KPIs) you need theView
Scorecard permission for the
relevant Scorecard.

l To view all the standalone KPIs
in the Studio, you need the
Select KPI permission.

Explorer N/A l To view the EXPLORER tab you
need theExplorer Access
permission

l To view the relevant Scorecards
(their Perspectives, Objectives,
and KPIs) in Explorer, you need
theView Scorecard permission.

l To view all the standalone KPIs
in the Studio, you need the
Select KPI permission.

l To view the prediction analysis,
you need the Forecast
permission.

Finance l To view the FINANCE tab you
need the Finance permission.

l To view the FINANCE tab you
need the Finance permission.

l Budget l To view the FINANCE tab you
need the Finance permission.

l To create and edit the life cycle of
consolidated budgets, you need
the Manage Consolidated
Budget permission.

l To view the FINANCE tab you
need the Finance permission.

l To view budgets, you need the
Budget permission.

l To view existing consolidated
budgets you need the View
Consolidated Budget
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XS Application
Elements Create and Edit View

l To create and edit a specific cost
center budget, you need the
Manage Cost Center Budget
permission for the specific cost
center instance.

permission.

l Allocation l To view the FINANCE tab you need the Finance permission.
l To create, edit, and view allocation scenarios you need theManage
Allocation Scenarios permission.

l To view allocation scenarios using Cost Explorer, you need theManage
Allocation Scenarios permission.

l Cost N/A l To view the FINANCE tab you
need the Finance permission.

l To view Cost Explorer, you nee
theManage Allocation
Scenarios permission.

Admin l To access the ADMIN tab but not
the tabs in the ADMIN tab, you
need theAdmin Access
permission.

l To access the ADMIN tab but
not the tabs in the ADMIN tab,
you need theAdmin Access
permission.

l Users and Roles
l User
Management

l Role
Management

l Resource
Management

l To view the ADMIN tab you need
theAdmin Access permission.

l Tomodify the contents of the
Users and Roles accordion tab
you need theEdit Settings
permission.

l To view the ADMIN tab you need
theAdmin Access permission.

l To view the Users and Roles
accordion tab you need the
Users and Roles permission.

l Data Source
Management

l To view the ADMIN tab you need theAdmin Access permission.
l To access the Data SourceManagement page and to activate the
content packs you need theData Source Management permission.

l ETL Management l To view the ADMIN tab you need theAdmin Access permission.
l Tomonitor andmanage the ETL process for DataWarehouse you need
theABC Management permission.

l Foundation
l Foundation

l Single Sign-On

l Pages

l To view the ADMIN tab you need
theAdmin Access permission.

l To edit the contents of the
Scorecard settings, Foundation
settings, and Data

l To view the ADMIN tab you need
theAdmin Access permission.

l To view the Scorecard settings,
Foundation settings, and Data
Warehouse settings accordion
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XS Application
Elements Create and Edit View

l Website Warehouse settings accordion
tabs you need theEdit Settings
permission.

tabs you need theView Settings
permission.

l DataWarehouse

l Scorecard
l Dashboard
Settings

l Engine Settings

l Score
Thresholds

l XS Settings

l ITFM l To view the ITFM tab in the
ADMIN tab , you need theAdmin
Access permission.

l To view the ITFM tab in the
ADMIN tab , you need the
Admin Access permission.

l Semantic Layer l To view the ADMIN tab you need
theAdmin Access permission.

l To view the ADMIN tab you need
theAdmin Access permission.

l To use the Context Designer
feature you need the Context
Management permission.

l Content
Acceleration Pack

l To view the ADMIN tab you need theAdmin Access permission.
l To view, edit, delete Content Acceleration Packs, you need theContent
Acceleration Pack permissions.

Dashboard l To add pages, view andmodify all
the pages in the Dashboard (add
components, delete components,
and even delete components) you
need theAdminister Pages
permission.

l To add pages, view andmodify
all the pages in the Dashboard
(add components, delete
components, and even delete
components) you need the
Administer Pages permission.

l To configure components on the
page you need theSelect KPI
permission

l Specific page in
Dashboard

l To view andmodify (add
components, delete components,
and even delete) the relevant page
in the Dashboard you need the
Manage Page permission.

l To create a new page in
Dashboard you need the
Administer Pages permission.

l To view a specific page in
Dashboard you need theView
Page permission for that page.

Administrator Guide
Users, Roles, Resources, and Permissions

HP IT Executive Scorecard (9.50) Page 70 of 342



XS Application
Elements Create and Edit View

Once the page is created and
assigned to a user, a user with the
Manage Page permission can
add components to the page, and
modify it.

l Components on a
page

l To view Scorecards you need the
View Scorecard permission.

l To view the contents of the Active
KPIs area in all the components
filters and to be able tomove KPIs
from the Active KPIs area to the
Selected KPIs area in the filter
you need theSelect KPI
permission.

l If you do not have this permission,
you can, in all the component
filters, view the contents of the
Selected KPIs area, you cannot
modify the selection, and cannot
view the contents of the Active
KPIs area as the contents are
grayed out.

l To view the small black arrow
(near the Scorecard title) that
indicates that the Scorecard has
Cascading Scorecards and to be
able to click the arrow to display
the Cascading Scorecards for
which you has permission you
need theCascade Scorecard
permission.

l If you do not have this
permission, the small arrow is
not displayed and you do not
know that Cascading
Scorecards are available.

l To view specific Scorecards and
data you need the View
Scorecard permission.

Annotations (in
Dashboard and
Explorer)

l To edit or delete an existing
annotation you need the Manage
Annotation permission.

l If you do not have this
permission, you can only view
the annotation and theEdit and
Delete buttons of the annotation
are hidden.

Tasks
This section includes:

• Create a role 71
• Edit role details 72
• Attach permissions 72
• Add a resource to a permission 72
• UseCase - Permissions 72

Create a role
1. Select Admin > Users and Roles > Role Management.
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2. In the Roles area, click to create a new role.
3. Enter the name and description for the role.
4. Click OK to save your role.
After creating a role, follow the procedure for attaching permissions and resources.

Edit role details
1. Select Admin > Users and Roles > Role Management.
2. In the Roles area, select a role.
3. In the Role Details area, click Edit Details.
4. Edit the role as required and click OK.

Attach permissions
1. Select Admin > Users and Roles > Role Management.
2. In the Roles area, select a role.

3. In the Role Details area, click . The Assign Permission to Role wizard opens.
4. Select a permission from the list.
5. Attach a resource to the selected permission, if required.
6. Complete the wizard procedure to save your assignments.
7. Log off from Executive Scorecard and log on again to complete the permission assignments.

Add a resource to a permission
1. Select Admin > Users and Roles > Role Management.
2. In the Roles area, select a role.
3. In the Permissions list select a permission.

4. Click to open the Assign Resources to Permissions page in the Assign Permission to Role
wizard.

5. Select a permission and use the arrows tomove the required resources from the Available
Resources list to the Selected Resources list.

Use Case - Permissions
For details, see Use Case - Permissions in theGetting Started with IT Executive Scorecard.

UI Description
Role Management Page
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Click to refresh the page.

Roles Area

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI
Element Description

Create Role. Creates a new role.

Enter theRole Name andRole Description and click OK.

Delete Role. Deletes the selected role.

Click Refresh to refresh the display.

When in Executive Scorecard, when you navigate to another tab and then return to
Admin > Users and Roles, the display is not automatically refreshed. To refresh the

display, click in the toolbar.
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UI
Element Description

<Role
List>

A list of roles currently defined in theADMIN tab. When you select a role, the details
appear in theRole Details area andPermissions list.

For a list of pre-defined roles, see "Pre-Defined Roles" on page 63.

Role Details Area

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Role Name The name of the selected role.

Role
Description

The description of the selected role.

Edit Details Edits the selected role name and description.

Attach permission. Assigns selected permissions to roles. You select permissions
using the Assign Permission to Role wizard. For user interface details, see "Assign
Permission to RoleWizard" on the next page.

Manage permission.Modifies the selected permission. Opens the Assign
Resources to Permissions page in the Assign Permission to Role wizard. For user
interface details, see "Assign resources to permissions page" on page 76.

Detach permission. Removes the selected permission from the role.

Permissions
List

The list of permissions and resources for the selected role.

Permission The permission sets and permissions attached to the selected role.

Resources The list of resources for each permission.

Not Applicable. None of the available resources apply to this permission. For
details, see "ResourceManagement" on page 57.

<Resource Name>. The permission is attached to a specific resource.

Administrator Guide
Users, Roles, Resources, and Permissions

HP IT Executive Scorecard (9.50) Page 74 of 342



UI Element Description

All. The permission is applicable to all resources.

Assign Permission to Role Wizard

This wizard enables you to assign permissions to the selected role, as well as assign resources to the
permissions. Click to access the wizard.

Wizard
Map

The Assign Permission to Role wizard contains:

Select Permission Page > Assign Resources to Permissions Page > Confirmation
Page.

Select Permission Page

This pagemay lead directly to the Confirmation page depending on whether the selected permission
has resources attached.
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

<Permissions
tree>

Select a permission from the tree.

Displays the pre-defined permissions. For details, see "Pre-Defined
Permissions" on page 67.

Assign resources to permissions page

This page only appears if the permissions are applicable for a resource.

Note: Click to access this page directly.
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Permission A tree containing the permissions.

Select a permission and use the arrows tomove the required resources from
theAvailable Resources list to theSelected Resources list.

Available and
Selected
Resources

Each permission can be applicable for specific resources, for all resources, or
not applicable to a resource.

Confirmation Page
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Permission The permissions assigned to this role.

Resource The list of resources associated with the each permission.

Add
another

Click to commit the current permission and continue in the wizard to add another
permission. The "Select Permission Page" on page 75 opens.

Finish Click to commit the assigned permissions and finish wizard functions.

Cancel Click to cancel the current assignment. All previous actions in the wizard are still
valid.
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User Management
The User Management page enables you to add and edit users and groups, as well as add and edit their
details.

To access:

Select Admin > Users and Roles > User Management to access the User Management page.

Learn More
Resources, Roles, Permissions, Users, and Groups

l Resources. A resource is a logical group of one or more XS application data items (for example
application data or components or budgets). Once you define resources, you attach the resource to a
permission.

l Roles and Permissions. Each role is a set of permissions. Permissions define which actions the
user can perform and on which resources. For example, you can create a role that enables its users
to create Dashboard pages.

l Users and Groups. Each user has a list of roles that define their permissions. When you assign a
role, that user only has access to specific portions of the program and specific resources that are
relevant to their role. You can also define groups of users with the same roles or access rights.
When you attach a user or group to a group, the user or group inherits all of the group’s roles.

Managing Users

Users can bemanaged using either of the following, but not both:

l Enterprise Users:Users are created andmanaged in Executive Scorecard.
l LDAP Users: Users are created andmanaged on your LDAP server which is connected to
Executive Scorecard. For details, see "LDAP Management" on page 91.

The Administrator uses the Admin tab to define users that have roles, roles that contain a set of
permissions that may contain resources. It is recommended to create resources and attach them to
permissions first in the user management process. For details, see "RoleManagement" on page 63.

Tasks
This section includes:

• Search for a user 80
• Add a user 80
• Add a new group under the root 80
• View permissions and resources for specific users 80
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• Assign roles to users or groups 81
• Unassign a role from a group 81
• Connect XS Executive Scorecard to an LDAP server 81
• Add Additional Pages to Dashboard andGrant Permissions 82
• Configure User Permissions in Dashboard 82

 Search for a user
1. Select Admin > Users and Roles > User Management.
2. In theSearch Users tab, enter the search criteria.
3. Click Search. The relevant users are displayed.

Add a user
When using LDAP for user management, you cannot add LDAP users in Executive Scorecard directly.
Youmust first create them in the LDAP server and then populate them into Executive Scorecard
manually. You can remove LDAP users from Executive Scorecard, but they will still exist in the
LDAP server.

1. Select Admin > Users and Roles > User Management.
2. In theUsers & Groups tab, select the group under which you want to add a user and click Add

User . The Add user dialog box opens.
3. Enter the relevant details.

Add a new group under the root
1. Select Admin > Users and Roles > User Management.

2. In theUsers & Groups tab, click Add group under the root .
3. Enter theGroup Name andGroup Description and click OK. The group is added under the root.

View permissions and resources for specific users
1. Select Admin > Users and Roles > User Management.
2. Select a user from theUsers & Groups tab.
3. In theRoles and Permissions area, select a role to view the permissions and resources

associated with the role.
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Assign roles to users or groups
1. Select Admin > Users and Roles > User Management.
2. Select a user or group from theUsers & Groups tab.

3. In theRoles and Permissions area, click Assign role . The Assign Roles dialog box opens.
4. Select a role from theAvailable Roles list and use the arrows tomove the role to theSelected

Roles list.
5. Click OK to save your selections.

Unassign a role from a group
1. Select Admin > Users and Roles > User Management.
2. Select and expand theEveryone group.
3. Delete the role related to your specific Scorecard from theEveryone group. This Scorecard can

now only be viewed by the Admin.
4. Assign theManage Scorecards role to the specific users you want to view andmanage the

Scorecard.

Connect XS Executive Scorecard to an LDAP server

Note: The format of the LDAP folder must be either Microsoft Active Directory or SunONE
Directory. It cannot be an arbitrary folder structure.

1. In theManagement database, in the SETTINGS_MANAGEMENT table, create a new record with
the following information:
l context: foundation

l name: fnd.uum.type

l value: ldap

2. Configure the LDAP connection properties and the structure of the LDAP folder using the
properties file located at <installation
folder>agora\glassfish\glassfish\domains\BTOA\config\conf\external-ldap.properties.

Note:

l Only connection properties (such as host, port, LDAP version, user, and password) and
user/group base dn can bemodified.

l In a Production environment, after you have configured the file external-ldap.properties,
youmust synchronize the properties file in the XS server and in the DWH server and then
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restart both servers.

3. If SSL is used to access LDAP, certificates must be imported.

Add Additional Pages to Dashboard and Grant
Permissions
Users can be granted permissions to perform the following operations on user-defined pages and
components: View page,Manage Page (change and delete specific page) andAdministrate pages
(add pages and full control on all pages in the system).

To create a new page in the Dashboard , contact your administrator. The administrator should:

1. Create the relevant page in HP IT Executive Scorecard.
2. Define the page Instance and Resource. For details, see "ResourceManagement" on page 57.
3. Give you (the Business Analyst - Dashboard Designer) the needed permissions to update the

page. For details, see "RoleManagement" on page 63.
4. Give the relevant user (executive) the needed permissions to view the page. For details, see"Role

Management" on page 63.

Configure User Permissions in Dashboard
Permissions to work with Dashboard components and pages are defined inAdmin > Users and
Roles > User Management.

The operations that can be defined for a user are dependent on the area within Dashboard, as follows:

l Predefined Pages. These pages are defined out-of-the-box. They have a pre-defined layout but
entities are not selected. Users with the relevant permissions can select the relevant entities using
the component filters. Depending on their permissions, users can change the component layout in
the page and the selections in the component filters. Note that out-of-the-box pages cannot be
deleted. More information about the permissions is available in "RoleManagement" on page 63.

l User Pages and User Components. Users can be granted permissions to perform the following
operations on user-defined pages and components: View page,Manage Page (change and delete
specific page) andAdministrate pages ( add pages and full control on all pages in the system).

UI Description
User Management Page

Click to refresh the page.
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Users & Groups Tab

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Users and
Groups tree

A tree containing all of the existing groups and users attached to those groups.

To find users that are not attached to a specific group, but are under the group
Everyone, use theSearch Users tab. For details, see "Search Users Tab" on
page 86.

When a user is added to LDAP, it is displayed in the Users andGroups tree
after you log on to HP IT Executive Scorecard."Search Users Tab" on page 86

Create User. Adds a new user under the selected group. The user inherits the
group’s roles.
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UI Element Description

Enter the user's Login Name, Display Name, Email, andNew Password
and click OK.

When using LDAP for user management, you cannot add LDAP users in
Executive Scorecard directly. Youmust first create them in the LDAP server
and then populate them into Executive Scorecardmanually. You can remove
LDAP users from Executive Scorecard, but they will still exist in the
LDAP server.

Create group. Creates a new group under a selected existing group. The group
inherits the existing group’s hierarchy.

Enter theGroup Name andGroup Description and click OK.

Available Groups

l Administrators. Users who can administer the system.
l Scorecard Administrators. Users who canmanage specific Scorecards
and Pages according to the assigned roles and permissions.

l Everyone. All users of the system.
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UI Element Description

Note: The following groups are the default groups available in SAP
BusinessObjects Enterprise and exported to the ADMIN tab. They are not
applicable to the Executive Scorecard application.

l QaaWS Group Designer
l Report Conversion Group Users
l Test Root
l Translators
l Universe Design Users

Add group under the root. Creates a new group under the root.

Enter theGroup Name andGroup Description and click OK.

Attach to group. Attaches the selected user or group to a group. The users or
groups inherit all of the group’s roles.
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UI Element Description

Select the group and click OK.

Detach from group. Detaches the selected user or group from a group. When
you detach a user/group from a group, they no longer have the roles that they
inherited from the group.

When you detach a group from a group, it moves to the "root" of the groups and
users tree.

Delete. Deletes the selected user or group. When a group is deleted, its users
still exist under a system group called Everyone.

Refresh. Refreshes the displayed information.

Search Users Tab

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Search
Users

The search criteria.
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UI Element Description

To search for users, enter some or all of the user details: Login Name, Display
Name, Email.

Search Search. Click to search for users that match the criteria entered in theSearch Users
tab.

User Name A list of all users that match the search criteria.

User Details Pane

Select a user and click User Details.

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Login Name/
Group Name

The name of the selected user or group.

Display Name/
Group
Description

The description of the selected user or group.

Edit Details Edits the selected user or group details. Enables you to change a user
password.
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UI Element Description

Roles and
Permissions

The assigned roles and corresponding permissions and resources for the
selected user or group.

Assign role. Opens the Assign Roles dialog box that enables you to assign a
role to the selected user or group.

Remove role. Removes the selected role from the user or group.

Role name The role assigned to the selected user or group.

Permission List of permission names contained in the selected role.

Resource The resource attached to the permission of the selected role.

N/A. Not Applicable. None of the available resources apply to this permission.

<Resource Name>. The permission is attached to a specific resource.

All. The permission is applicable to all resources.

For details, see "ResourceManagement" on page 57.

Assign Roles Dialog Box

Select a role in Roles and Permissions, and click .
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Select a role from theAvailable Roles list and use the arrows tomove the
role to theSelected Roles list.

Available and
Selected Roles

Each user or group can have one or more assigned roles.

Permission details The read-only details about the permissions and corresponding resources
for the selected role.

Resource The list of resources for each permission:

l Not Applicable. Used for permissions that do not require a specific
resource setting.
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UI Element Description

l <Resource Name>. The permission refers to a specific resource.
l All. The permission is applicable to all resources.
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LDAP Management
The LDAP Management page enables you to add and edit users and groups, as well as add and edit
their details.

Users can bemanaged using either of the following, but not both:

l Enterprise Users:Users are created andmanaged in Executive Scorecard.
l LDAP Users: Users are created andmanaged on your LDAP server which is connected to
Executive Scorecard. For details, see "LDAP Management" above.

The Administrator uses the Admin tab to define users that have roles, roles that contain a set of
permissions that may contain resources. It is recommended to create resources and attach them to
permissions first in the user management process. For details, see "RoleManagement" on page 63.

To access:

Select Admin > Users and Roles > LDAP Management to access the LDAP Management page.

Learn More
Users and authentication when working with SAP BusinessObjects and LDAP or without

The users and authentication when working with or without SAP BusinessObjects and LDAP is as
follows:

Operation

Working
without
SAP BusinessObjects
and without LDAP

Working
with
SAP BusinessObjects
and
without LDAP

Working
with
SAP BusinessObjects
and
with LDAP

Manage
users
(create,
remove,
update)

In Executive Scorecard, in
Admin > Users and
Roles.

Users are created in
Executive Scorecard, in
Admin > Users and Roles

Users created in Executive
Scorecard are automatically
transferred to SAP
BusinessObjects.

If a user is created in SAP
BusinessObjects, it does
not appear in the list of
users in Executive
Scorecard.

Users are created in
LDAP.

If LDAP configures
successfully, XS loads
all the user information
from LDAP
automatically .

Passwords Passwords can be changed Passwords can be changed Passwords are created
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Operation

Working
without
SAP BusinessObjects
and without LDAP

Working
with
SAP BusinessObjects
and
without LDAP

Working
with
SAP BusinessObjects
and
with LDAP

in theUser Details pane of
the User Management page
in Executive Scorecard.
Click Edit Details to
change a user's password.

in theUser Details pane of
the User Management page
in Executive Scorecard.
Click Edit Details to
change a user's password.

A password created in
Executive Scorecard is
automatically transferred to
SAP BusinessObjects for
the relevant user.

and stored in LDAP.

Roles,
permissions,
and groups

In Executive Scorecard, in
Admin > Users and
Roles.

In Executive Scorecard, in
Admin > Users and
Roles.

In Executive
Scorecard, inAdmin
> Users and Roles.

Note:

l The format of the LDAP directory must be either Microsoft Active Directory or SunONE
Directory. It cannot be an arbitrary directory structure.

l Active Directory provides two password options:
l Option 1 - Youmust change the password at the next log on.

l Option 2 - Password never expires.

HP IT Executive Scorecard only supports the second option.If you want to use the first option,
youmust log on to another system (not HP IT Executive Scorecard) the first time to change the
password, and then use the new password to log on HP IT Executive Scorecard.

l When a user is added to LDAP, it is displayed in the Users andGroups tree after you log on to
HP IT Executive Scorecard.

l Whenworking with LDAP, youmust make sure that LDAP is connected to Executive
Scorecard and to SAP BusinessObjects. For details, see "Create a connection" on page 94.

l Executive Scorecard only supports the LDAP tab with Active Directory as a server type on that
tab. Active Directory authentication via the active directory tab is not supported. For details, see
"Manage users using LDAP -Manual Procedure" on page 98.

l We recommend to use LDAP for secure passwords and better password validation.

Searches for LDAP user groups

The root group filter specifies the groups that will be listed as the root group in XS.The group filter
specifies the child groups that will be listed under the root groups.

The group scope should include the root groups and some of the child groups listed under the root
group.
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If, for example,you have the following configuration in the LDAP server:

And you want to display the below group in XS:

l If you click Test for theRoot Group Filter, you only need to specify theRoot Group Search DN
and theRoot Group Filter values.
TheRoot Group Search DN is the starting search node and dc=hpxs,dc=com points to the root
node. The Root Group Filter is used to locate the specific node: GroupTest1.

l If you click Test for theGroup Filter, youmust specify theRoot Group Search DN, theRoot
Group Filter, theGroup Search DN, theGroup Filtervalues. In such a casemake sure that the
Group scope includes the Root Group scope.
TheRoot Group Search DN is the starting search node and dc=hpxs,dc=com points to the root
node. The Root Group Filter is used to locate the specific node: GroupTest1.

Then theGroup Search DN must include the root group value specified in theRoot Group Search
DN and the relevant child groups under the root group.
In our example, theGroup Filter should contain the root group: GroupTest1 and the child groups:
testGroup1 and testGroup2.

LDAP and the Licenses

Administrator Guide
Users, Roles, Resources, and Permissions

HP IT Executive Scorecard (9.50) Page 93 of 342



LDAP support the XS license set up. For details, see "Licenses" on page 46.

You create andmanage users on your LDAP server which is connected to Executive Scorecard. The
XS Administrator uses the ADMIN tab to define users that have roles, roles that contain a set of
permissions that may contain resources. It is recommended to create resources and attach them to
permissions first in the user management process. For details, see "RoleManagement" on page 63.

Tasks
This section includes:

• Check if LDAP mode is enabled 94
• Create a connection 94
• Test the input fields 95
• Save and disable an LDAP configuration 96
• Configure LDAP 96
• Configure BOE to work with LDAP 96
• Set up so XS users can use and view BOE reports in the XS application 97
• Manage users using LDAP -Manual Procedure 98
• Configure XS to work with LDAP - Advanced LDAP Configuration 99

Check if LDAP mode is enabled
1. In the XS application, click Admin > Users and Roles > LDAP Management.
2. If the LDAP configuration has already been updated, aWarningmessage: You have updated the

LDAP configuration. Restart the server. is displayed. Restart the server.
If the configuration is not complete, enter the relevant values in the fields, and click Save. Then
restart the server.

Create a connection

Note:

If you work in a Development/Test/POC environment, configure LDAP to connect separately with:

l the Executive Scorecard server.
l the SAP BusinessObjects Enterprise server.
If you work in a Production environment, configure LDAP to connect separately with:

l the Executive Scorecard server.
l the DataWarehouse server.
l the SAP BusinessObjects Enterprise server.

You create a connection and verify that the server information is correct.

Administrator Guide
Users, Roles, Resources, and Permissions

HP IT Executive Scorecard (9.50) Page 94 of 342



1. After you enter the server information in the LDAP Management page, click Connect.
2. If the connection is created successfully, the server information fields are locked. You can then:

a. Enter the information in the remaining fields
b. Click Disconnect to input different information in the server information fields.

3. When you check theSSL mode, the XS server attempts to connect with the LDAP server.
If the server cannot perform the connection, the following error message is issued:
The XS server cannot connect to the LDAP server.
Make sure all the relevant certificates are imported.
After the relevant certificates are imported, restart the XS server.
In such a case, make sure that the relevant certificates are imported. After the import of the
relevant certificates completes, restart the server.

4. If you need to import a certificate from a third-party Certificate Authority (CA) or if you need to
generate a self-certificate:
a. Make sure the certificate is supported by the LDAP server.
b. Import the certificate using the following command:

<HPXS>\agora\jdk\bin\keytool -import -trustcacerts -alias hpxsldap-ssl -file
<Certificate File Path> -keystore <HPXS>\agora\jdk\jre\lib\security\ cacerts

c. At theEnter keystore password: prompt, enter changeit.
d. Enter yes to continue.
e. ExpandHP Executive Scorecard > Administration, click Disable HP Executive

Scorecard, and then click Enable HP Executive Scorecard.

Test the input fields
After verifying that the server information is correct and enables the connection to the server, test users
with the Admin role.

1. After you enter the base and filter values for the root group, group, or user, click the relevant Test
button to see whether there are results or not.
l Root group info should only show the root group.

l Group info should only show the group tree.

l User info should show all users.
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For additional information, see "Searches for LDAP user groups" on page 92.
2. You can also select some of the LDAP users. These users will be assigned the Admin role, in the

XS application, to these users.

Save and disable an LDAP configuration

After you have saved the LDAP configuration, the status of the LDAP changes toEnabled and
displays a warningmessage: You have updated the LDAP configuration. Restart the server.

After the LDAP Admin disables the LDAP mode:

l The users and groups used by XS are loaded from the XS local database and not from the LDAP
server anymore.

l The LDAP Adminmust create a new XS Admin user.
If the XS Administrator name is the same as the BOE Administrator name (BOE Administrator was
created during the installation of XS), then the BOE Administrator password is the same as the
XS Admin password.

Configure LDAP
1. In the XS application, click Admin > Users and Roles > LDAP Management.
2. In the LDAP Management page, enter the server information. Click Connect.
3. Enter all the DN and filter fields, and click Test in turn for the Test Root Group, the Test group, the

Test Users, and then click ... to select the users.
4. Click Save. A warning to restart the server is issued. Click OK to do so.

Configure BOE to work with LDAP
Make sure you use the LDAP Authentication option:

1. From theWindows Start menu, click Programs > BusinessObjects XI 3.1 > BusinessObject
Enterprise > BusinessObjects Enterprise Central Management Console.

2. Log on to the Central Management Console as an administrator.
3. Click Authentication, then click the LDAP tab.
4. Click Start LDAP Configuration Wizard.
5. In theAdd LDAP Host (hostname: port) field, type your host and port information.
6. Click Add.
7. Click Next.
8. In the LDAP Server Type drop-down list, select your LDAP server, and click Next. This is where

you select the type of server you are using: Sun One orActive Directory.
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a. If you select Active Directory, click Show Attribute Mappings.
b. Then, in theDefault User Search Attribute field, change the value from cn to

sAMAccountName.
c. Then, in theUser Name field, change the value from cn to sAMAccountName.

9. In theBase LDAP Distinguished Name field, type the distinguished name, and click Next.
10. Type the LDAP host credentials:

a. LDAP Server Administration Credentials:Enter the name and password for a user
account that has rights to administer your LDAP server.

b. LDAP Referral Credentials:Enter the same name and password you entered for LDAP
Server Administration Credentials.

11. In theMaximum Referral Hops field, type the number of referral hops to limit forwarding the
credential request. If you set this field to zero, no referral hops are allowed.

12. Click Next.
13. In the Type of SSL authentication drop-down list, select Basic (no SSL) and click Next.
14. In theAuthentication drop-down list, select Basic (no SSO) and click Next.
15. Select the following LDAP options:

a. Create a new account for every added LDAP alias
b. Create new aliases when Alias Update occurs
c. New users are created as named users

16. Click Next.
17. Click Finish.

Set up so XS users can use and view BOE reports in the
XS application
To set up so XS users can use and view BOE reports in the XS application, the Adminmust join a
LDAP group to the group in the BOE that has permission to see the Reports. Then all the users in this
LDAP group will have permission to use and see the BOE reports.

1. a. From theWindows Start menu, click Programs > BusinessObjects XI 3.1 >
BusinessObject Enterprise > BusinessObjects Enterprise Central Management
Console.

b. Log on to the Central Management Console as an administrator.
c. Click Authentication, then click the LDAP tab.

2. Locate theAdd LDAP group (by cn or dn) field in the LDAP screen. Enter the Group Name
configured in the LDAP Server, and click Add. Scroll downwards and click Update.

3. Navigate toHome > Group List, right-click the group added in the previous and selectMember
Of. TheMember Of dialog box opens.

4. Click Join Group.
5. Navigate toGroup List, select a group that has authority to view the BO reports, and then click
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the right arrow (>) to add it to theDestination Group.
6. Click OK.

Manage users using LDAP - Manual Procedure
1. To assign roles and permissions to LDAP users:

a. To add users with the ADMIN role, run the following script:
<HPXS ROOT>\agora\glassfish\glassfish\domains\BTOA\config\population\populate-
admin-detail.bat
<user_ID><password> <firstname> <lastname> <e-mail>

b. To add users with the EVERYONE role, run the following script:
<HPXS ROOT>\agora\glassfish\glassfish\domains\BTOA\config\population\populate-
user-detail.bat
<user_ID><password> <firstname> <lastname> <e-mail>

c. To add users as ADMIN role without password, run the following script:
<HPXS ROOT>\agora\glassfish\glassfish\domains\BTOA\config\population\populate-
admin-detail-noPwd.bat <user_ID <firstname> <lastname> <e-mail>

d. To add users as EVERYONE role without password, run the following script:
<HPXS ROOT>\agora\glassfish\glassfish\domains\BTOA\config\population\populate-
user-detail-noPwd.bat
<user_ID><firstname> <lastname> <e-mail>
Where:
o <user_ID> and <password> are the LDAP user name and password.
o <firstname>, <lastname> are the user names displayed in XS. You can assign

permissions, or delete the users in theAdmin > Users and Roles > Role Management.
For details, see "RoleManagement" on page 63.

o <email> is the email of the user.

Tip:

l It is recommended to create the users without password as such users can only log on
under LDAP mode. Users defined with passwords can log on using the password even
when LDAP is off.

l At least one administrator user should be created to be used to perform the administration
work.

2. If SSL is used to access LDAP, youmust import the relevant certificates.
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Configure XS to work with LDAP - Advanced
LDAP Configuration

Note: Use this advanced procedure only if the wizard described in the UI Description section is
not sufficient for your purposes. For details, see " UI Description" on page 117.

To configure XS to work with LDAP:

1. Database changes. In theManagement database, in the SETTINGS_MANAGEMENT table
create a new record with:
l context=foundation

l name=fnd.uum.type

l value=ldap

2. external-ldap.properties. Define groups and users in LDAP. In the
<HPXS>\agora\glassfish\glassfish\domains\BTOA\config\conf\external-ldap.properties
file, enter the relevant parameter values or use the provided default:

Parameter Description

ldapversion 3 - LDAP V3.
2 - LDAP V2.
Default: 3

Example: ldapVersion = 3

ldapHost The name of themachine running the LDAP server.
Default: localhost

Example: ldapHost = ldap.hp.com

ldapPort The port number of themachine running the LDAP server.
Default: 389

Example: ldapPort = 636

useAdministrator true.The LDAPConnection is created with the provided
Administrator username and password.
false. The LDAPConnection is created without
username/password.
Default: false
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Parameter Description

Note: If you work with LDAP V2, the LDAP connection
must be created with the administrator username and
password, so youmust set useAdministrator = true.

Example: useAdministrator = true

ldapAdministrator The Administrator logon name used for creating the initial
LDAP connection. The parameter is ignored if
useAdministrator=false.
Default:CN=Administrator

Example: ldapAdministrator = CN=Administrator

ldapAdministrator
Password

The Administrator logon password used for creating initial
LDAPConnection. The parameter is ignored if
useAdministrator=false.
Default: <empty_value>

enableSSL true - If the customer requires the SSL connection to LDAP.
The SSL connection to the port defined in ldapPort property is
attempted.
false - Default.
Default: false

Example: enableSSL = false

baseDistinguish
NameDelimiter

The regular expression used to separate names in
parameters that accept a number of different names, like
usersBase, groupsBase, andmore.
Default: \\s*;\\s*

Example: baseDistinguishNameDelimiter = \\s*;\\s*

scopeDelimiter The regular expression used to separate search scope string
(SCOPE_SUB, SCOPE_ONE, SCOPE_BASE) in
parameters that accept a number of different search scopes,
like usersScope, groupsScope, andmore.
Default: \\s*,\\s*

Example: scopeDelimiter = \\s*,\\s*

usersBase The base DN (distinguished name) for users search.
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Parameter Description

Default: dc=example, dc=com

Example: usersBase = ou=People,dc=hp, dc=com

usersScope SCOPE_SUB - The user search is a recursive search in the
tree defined in usersBase property.  
SCOPE_ONE - The user search is performed across one
level (direct children only) in the tree defined in usersBase
property.
SCOPE_BASE - The user search returns one entry
maximum, as indicated in the usersBase property.
Default:SCOPE_SUB

Example: usersScope = SCOPE_SUB, SCOPE_SUB

usersFilter The search filter, indicating what instances should be
returned from the LDAP search.
Default: (&(uid=*)(objectclass=inetOrgPerson))

Example: usersFilter = (&(uid=*)
(objectclass=inetOrgPerson))

enableNestedGroups true - The users and groups search works recursively and
looks for all users in subgroups returned by the groups search
filter.
false - The users and groups search looks for users in the
results by the groups search filter (it does not include
subgroups.
Default: true

Example: enableNestedGroups = true

maximalAllowedGroups
HierarchyDepth

Themaximum allowed groups hierarchy depth.
This parameter is relevant only if
enableNestedGroups=true.
A negative value allows unlimited depth.
Default: 10

Example:maximalAllowedGroupsHierarchyDepth = 10

enableDynamicGroups true- The search executes a URL query to bring all users for
dynamic groups.
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Parameter Description

false - The dynamic groups URLs are ignored by the
URL query.
Default: false

Example: enableDynamicGroups = true

groupsBase. The base dn (distinguished name) for groups search.
Default: <userBase value>

Example: groupsBase = ou=Groups,dc=hp, dc=com

groupsScope SCOPE_SUB - The group search is a recursive search in the
tree defined in groupsBase property.  
SCOPE_ONE - The group search is performed across one
level (direct children only) in the tree defined in groupsBase
property.
SCOPE_BASE - The group search returns one entry
maximum, as indicated in the groupsBase property.
Default:SCOPE_SUB

Example: groupsScope = SCOPE_SUB

groupsFilter The search filter, indicating what instances should be
returned from the LDAP search.
Default:
(|(objectclass=groupOfNames)
(objecclass=groupOfUniqueNames)
(objectclass=groupOfUrls)(objectclass=accessGroup)
(objectclass=accessRole))

Example: groupsFilter =
(|(objectclass=groupOfNames)
(objectclass=groupOfUniqueNames)
(objectclass=groupOfUrls)\ (objectclass=accessGroup)
(objectclass=accessRole))

rootGroupsBase The base dn (distinguished name) for root groups search.
Default:<usersBase value>

Example: rootGroupsBase = ou=People,dc=hp,
dc=com
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Parameter Description

groupsScope SCOPE_SUB - The root group search is a recursive search
in the tree defined in groupsBase property.  
SCOPE_ONE - The root group search is performed across
one level (direct children only) in the tree defined in
groupsBase property.
SCOPE_BASE - The root group search returns one entry
maximum, as indicated in the groupsBase property.
Default:SCOPE_SUB

Example: rootGroupsScope = SCOPE_SUB

rootGroupsFilter The search filter, indicating what instances should be
returned from the LDAP search.
Default:
(|(objectclass=groupOfNames)
(objecclass=groupOfUniqueNames)
(objectclass=groupOfUrls)(objectclass=accessGroup)
(objectclass=accessRole))

Example: rootGroupsFilter =
(|(objectclass=groupOfNames)
(objectclass=groupOfUniqueNames)
(objectclass=groupOfUrls)\(objectclass=accessGroup)
(objectclass=accessRole))

rolesBase The base dn (distinguished name) for roles search.
Default: <usersBase value>

Example: rolesBase = ou=People,dc=hp, dc=com

rolesScope SCOPE_SUB - Theroles search is a recursive search in the
tree defined in rolesBase property.  
SCOPE_ONE - The roles search is performed across one
level (direct children only) in the tree defined in rolesBase
property.
SCOPE_BASE - The roles search returns one entry
maximum, as indicated in the rolesBase property.
Default:SCOPE_SUB

Example: rolesScope = SCOPE_SUB

rolesFilter The search filter, indicating what instances should be
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Parameter Description

returned from the LDAP search.
Default:
(|(objectclass=groupOfNames)
(objecclass=groupOfUniqueNames)
(objectclass=groupOfUrls)(objectclass=accessGroup)
(objectclass=accessRole))

Example: rolesFilter =
(|(objectclass=groupOfNames)
(objectclass=groupOfUniqueNames)
(objectclass=groupOfUrls)\(objectclass=accessGroup)
(objectclass=accessRole))

rootRolesBase The base dn (distinguished name) for root roles search.
Default:<usersBase value>

Example: rootRolesBase = ou=People,dc=hp, dc=com

rootRolesScope SCOPE_SUB - The root groups search is a recursive search
in the tree defined in groupsBase property.  
SCOPE_ONE - The root groups search is performed across
one level (direct children only) in the tree defined in
groupsBase property.
SCOPE_BASE - The root groups search returns one entry
maximum, as indicated in the groupsBase property.
Default:SCOPE_SUB

Example: rootRolesScope = SCOPE_SUB

rootRolesFilter The search filter, indicating what instances should be
returned from the LDAP search.
Default:
(|(objectclass=groupOfNames)
(objecclass=groupOfUniqueNames)
(objectclass=groupOfUrls)(objectclass=accessGroup)
(objectclass=accessRole))

Example: rootRolesFilter =
(|(objectclass=groupOfNames)
(objectclass=groupOfUniqueNames)
(objectclass=groupOfUrls)\(objectclass=accessGroup)
(objectclass=accessRole))
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Parameter Description

enableDynamicRoles true- The search executes a URL query to bring all users for
dynamic groups.
false - The dynamic groups URLs are ignored by the
URL query.
Default: false

Example: enableDynamicRoles = true

enableNestedRoles true- The users and groups search are recursive and looks for
all users in subgroups returned by the group search filter.
false - The users and groups search looks for users in the
results by the group search filter (it does not include
subgroups.
Default: true

Example: enableNestedRoles = true

maximalAllowedRoles
HierarchyDepth

Themaximum allowed groups hierarchy depth.
This parameter is relevant only if
enableNestedGroups=true.
A negative value allows unlimited depth.
Default: 10

Example:
maximalAllowedRolesHierarchyDepth = 10

SIZELIMIT This variable limits the total number of results, returned from
LDAP by one search.
0 - no limit.
LDAP may be (and usually is) configured to limit this number
for non-administrators. In this case, the applicationmay
receive less results then expected. The usual limit is 1000.
Default: 0

Example: SIZELIMIT = 0

TIMELIMIT This variable limits the total number of times spent by LDAP
on one search.
0 - no limit.
LDAP may be (and usually is) configured to limit this number
for non-administrators. In this case, the applicationmay
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receive less results then expected.
Default: 0

Example: TIMELIMIT = 0

REFERRALS Some objects in LDAP may be just referrals to another LDAP
that contains the required information.
true - The search follows the references automatically, till the
number indicated by theREFERRALS_HOP_LIMIT
property.
false - The searchmay not return all required results. This
also happens when the number of HOPs is exceeded.
Default: true

Example: REFERRALS = false

REFERRALS_HOP_LIMIT The number of times the referrals are followed, until the
exception is thrown terminating the search.
Default: 10

Example: REFERRALS_HOP_LIMIT = 10

ldapReferralHost Referrals credentials (if needed).
If ldapHost is defined as:
l An IP, set ldapReferralHost as an IP.

l A DNS name, set ldapReferralHost as a DNS name.

l A string, for example LDAP host = ldap://test.net,
port=389, set "ldapReferralHost = test.net", and set
"ldapReferralPort = 389".

Example: ldapReferralHost = test.net

ldapReferralPort LDAP connections are to port 389, or 636 for secure
connections. This searches the Active Directory (AD)
Domain.
For Active Directory: Use an LDAP search port and not a
Global Catalog search port.
Default: 389 (636 for secure connections)

Tip: It is not recommended to use the Global Catalog
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LDAP connections: 3268 and 3269 (secure) that perform
Forest wide searches (multiple domain searches).

Example: ldapReferralPort = 389

ldapReferralUser The username (used for creating referral LDAP Connection).
Default: cn=Directory Manager

Example: ldapReferralUser cn=Directory Manager

ldapReferralPassword The password (used for creating referral LDAPConnection).
Default: <empty password>

Example: ldapReferralPassword = mercurypw

baseReferralDelimiter The regular expression used to separate values in above
referral parameters.

Example: baseReferralDelimiter = \\s*;\\s*

ldapAuthNUsers
ReferralBase

The base for authentication with users from referral.
Specify only if you want to authenticate with users from the
referred LDAP.

Example: ldapAuthNUsersReferralBase =
dc=test,dc=net

BATCHSIZE Theminimal size of chunks that must be received before the
result may be processed.
This parameter influences only the efficiency of lazy reading
of the search results.
Default: 1

Example: BATCHSIZE = 1

MAXBACKLOG The size of queue, waiting for BATCH results, if
BATCHSIZE is not 0.
This parameter influences only the efficiency of lazy reading
of the search results.
Default: 1000
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Example: MAXBACKLOG = 1000

attributeValuesDelimiter The regular expression used to separate attribute names in
parameters that accept a number of different attribute names,
as usersObjectClass, usersUniqueIDAttribute, andmore.
Default: \\s*;\\s*

Example: attributeValuesDelimiter = \\s*;\\s*

usersObjectClass The object class used for storing the users information.
inetOrgPerson - for SunOneDirectory.
user - for Microsoft Active Directory.
Default: inetOrgPerson

Example: usersObjectClass = inetOrgPerson

usersUniqueIDAttribute The unique ID attribute. This attribute should store the actual
login name of the user. The dn search and authentication
functions suppose that this attribute is unique.
uid - for SunOneDirectory.
sAMAccountName - for Microsoft Active Directory.
Default: uid

Example: usersObjectClass = inetOrgPerson

usersDisplayName
Attribute

The attribute used to store the user's display name. The
uniqueness of this attribute is not required.
cn - for SunOneDirectory.
cn - for Microsoft Active Directory.
Default: cn

Example: usersDisplayNameAttribute = cn

usersLoginNameAttribute
usersFirstNameAttribute
usersLastNameAttribute
usersEmailAttribute
usersPreferredLanguage
Attribute

The default attributes that are supported ad hoc in the
BSFPrincipal object.
Default:Defaults are given for the SunOne directory server.
usersLoginNameAttribute = uid
usersFirstNameAttribute = givenName
usersLastNameAttribute = sn
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usersPreferredLocation
Attribute
usersTimeZoneAttribute
usersDateFormatAttribute
usersNumberFormatAttribute
usersWorkWeekAttribute
usersTenantIDAttribute

usersEmailAttribute =mail
usersPreferredLanguageAttribute = preferredLanguage
usersPreferredLocationAttribute = l
usersTimeZoneAttribute = undefinedAttribute
usersDateFormatAttribute = undefinedAttribute
usersNumberFormatAttribute = undefinedAttribute
usersWorkWeekAttribute = undefinedAttribute
usersTenantIDAttribute = undefinedAttribute

groupsObjectClass The object class used for storing the static group information.
groupOfUniqueNames - for SunOneDirectory.
group - for Microsoft Active Directory.
Default: groupOfUniqueNames

Example: groupsObjectClass = groupOfUniqueNames

groupsMembersAttribute Attribute used to store the group's member information.
uniqueMember - for SunOneDirectory.
member - for Microsoft Active Directory.
Default: uniqueMember

Example:
groupsMembersAttribute = uniqueMember, member

groupsNameAttribute Attribute used to store the group name. The uniqueness of
this attribute is not required.
cn - for SunOneDirectory.
cn - for Microsoft Active Directory.
Default: cn

Example: groupsNameAttribute = cn

groupsDisplayName
Attribute

Attribute used to store the group's display name. The
uniqueness of this attribute is not required.
cn - for SunOneDirectory.
cn - for Microsoft Active Directory.
Default: cn

Example: groupsDisplayNameAttribute = cn
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groupsDescription
Attribute

Attribute used to store the group's description. The
uniqueness of this attribute is not required.
description - for SunOneDirectory.
description - for Microsoft Active Directory.
Default: description

Example: groupsDescriptionAttribute = description

dynamicGroupsClass The object class used for storing the dynamic groups
information.
groupOfUrls - for SunOneDirectory.
Microsoft Active Directory is not supported.
Default: groupOfUrls

Example: dynamicGroupsClass = groupOfUrls

dynamicGroupsMember
Attribute

Attribute used to store the search URL, defining themembers
of the dynamic group.
memberUrl - for SunOneDirectory.
Microsoft Active Directory is not supported.
Default:memberUrl

Example:
dynamicGroupsMemberAttribute = memberUrl

dynamicGroupsName
Attribute

Attribute used to store the dynamic group name. The
uniqueness of this attribute is not required.
cn - for SunOneDirectory.
Microsoft Active Directory is not supported.
Default: cn

Example: dynamicGroupsNameAttribute = cn

dynamicGroupsDisplay
NameAttribute

Attribute used to store the dynamic group's display name.
The uniqueness of this attribute is not required.
cn - for SunOneDirectory.
Microsoft Active Directory is not supported.
Default: cn

Example: dynamicGroupsDisplayNameAttribute = cn
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dynamicGroups
DescriptionAttribute

Parameter used to store the dynamic group's description.
The uniqueness of this attribute is not required.
description - for SunOneDirectory.
Microsoft Active Directory is not supported.
Default: description

Example:
dynamicGroupsDescriptionAttribute = description

useBottomUpAlgorithm
ForFindParent
GroupsOfUserPlain

This parameter is used for optimization of function
FindParentGroupsOfUserPlain.
true - The algorithm should be the false, but for some LDAP
Configurations it is possible that value false will be better.
false - Change to false only if you experience performance
issues with this specific function.
Default:true

Example:
useBottomUpAlgorithmForFindParent
GroupsOfUserPlain = true

notAGroupAttribute When the search group is from LDAP, if the DN
(distinguished name) includes these values, it is filtered and
not treated as a group type.
Default:uid, samaccountname

Example: notAGroupAttribute = uid, samaccountname

rolesObjectClass Object class used for storing the static role information.
Default:groupOfUniqueNames

Example: rolesObjectClass = groupOfUniqueNames,
groupOfNames

rolesMembersAttribute Attribute used to store the role's member information.
uniqueMember - for SunOneDirectory.
member - for Microsoft Active Directory.
Default:uniqueMember

Example: rolesMembersAttribute = uniqueMember,
member
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rolesNameAttribute Attribute used to store the role name. The uniqueness of this
attribute is not required.
cn - for SunOneDirectory.
cn - for Microsoft Active Directory.
Default: cn

Example: rolesNameAttribute = cn

rolesDisplayName
Attribute

Attribute used to store the role display name. The uniqueness
of this attribute is not required.
cn - for SunOneDirectory.
cn - for Microsoft Active Directory.
Default: cn

Example: rolesDisplayNameAttribute = cn

rolesDescriptionAttribute Attribute used to store the role description. The uniqueness of
this attribute is not required.
description - for SunOneDirectory.
description - for Microsoft Active Directory.
Default: description

Example: rolesDescriptionAttribute = description

dynamicRolesClass Object class used for storing the dynamic roles information.
groupOfUrls - for SunOneDirectory.
Microsoft Active Directory is not supported.
Default: groupOfUrls

Example: dynamicRolesClass = groupOfUrls

dynamicRolesMember
Attribute

Attribute used to store the search URL, defining themembers
of the dynamic role.
memberUrl - for SunOneDirectory.
Microsoft Active Directory is not supported.
Default:memberUrl

Example: dynamicRolesMemberAttribute = memberUrl

dynamicRolesName Attribute used to store the dynamic role name. The
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Attribute uniqueness of this attribute is not required.
cn - for SunOneDirectory.
Microsoft Active Directory is not supported.
Default:cn

Example: dynamicRolesNameAttribute = cn

dynamicRolesDisplay
NameAttribute

Attribute used to store the dynamic role display name. The
uniqueness of this attribute is not required.
cn - for SunOneDirectory.
Microsoft Active Directory is not supported.
Default:cn

Example: dynamicRolesDisplayNameAttribute = cn

dynamicRoles
DescriptionAttribute

Parameter used to store the dynamic role description. The
uniqueness of this attribute is not required.
description - for SunOneDirectory.
Microsoft Active Directory is not supported.
Default:description

Example: dynamicRolesDescriptionAttribute =
description

notARoleAttribute When the search group is from LDAP, if the DN
(distinguished name) includes these values, it is filtered and
not treated as a role type.
Default: uid, samaccountname

Example: notARoleAttribute = uid, samaccountname

vlvUsersBase Base dn (distinguished name) for users search for Virtual List
View (VLV) API.
Default:dc=example, dc=com

Example: vlvUsersBase = ou=People,dc=hp, dc=com

vlvUsersScope SCOPE_SUB - The users search for Virtual List View (VLV)
API is a recursive search in the tree defined in usersBase
property.  
SCOPE_ONE - The users search for Virtual List View (VLV)
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API is performed across one level (direct children only) in the
tree defined in usersBase property.
SCOPE_BASE - The users search for Virtual List View
(VLV) API returns one entry maximum, as indicated in the
usersBase property.
Default:SCOPE_SUB

Example: vlvUsersScope = SCOPE_SUB

vlvUsersFilter Search filter, indicating what instances should be returned
from the LDAP search for Virtual List View (VLV) API.
Default:(&(uid=*)(objectclass=inetOrgPerson))

Example: vlvUsersFilter = (&(uid=*)
(objectclass=inetOrgPerson))

vlvGroupsBase Base dn (distinguished name) for groups search for Virtual
List View (VLV) API.
Default:dc=example, dc=com

Example: vlvGroupsBase = ou=Groups, dc=hp,
dc=com

vlvGroupsScope SCOPE_SUB - The groups search for Virtual List View (VLV)
API is a recursive search in the tree defined in
vlvGroupsBase property.  
SCOPE_ONE - The groups search for Virtual List View (VLV)
API is performed across one level (direct children only) in the
tree defined in vlvGroupsBase property.
SCOPE_BASE - The groups search for Virtual List View
(VLV) API returns one entry maximum, as indicated in the
vlvGroupsBase property.
Default:SCOPE_SUB

Example: vlvGroupsScope = SCOPE_SUB

vlvGroupsFilter Search filter, indicating what instances should be returned
from the LDAP search for Virtual List View (VLV) API.
Default:(&(uid=*)(objectclass=inetOrgPerson))

Example:
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vlvGroupsFilter = (|(objectclass=groupOfNames)
(objectclass=groupOfUniqueNames)
(objectclass=groupOfUrls)\ (objectclass=accessGroup)
(objectclass=accessRole))

vlvRolesBase Base dn (distinguished name) for users search.
Default:dc=example, dc=com

Example: vlvRolesBase = ou=People,dc=hp, dc=com

vlvRolesScope SCOPE_SUB - The roles search for Virtual List View (VLV)
API is a recursive search in the tree defined in usersBase
property.  
SCOPE_ONE - The roles search for Virtual List View (VLV)
API is performed across one level (direct children only) in the
tree defined in usersBase property.
SCOPE_BASE - The roles search for Virtual List View (VLV)
API returns one entry maximum, as indicated in the
usersBase property.
Default:SCOPE_SUB

Example: vlvGroupsScope = SCOPE_SUB

vlvRolesFilter Search filter, indicating what instances should be returned
from the LDAP search for Virtual List View (VLV) API.
Default: (&(uid=*)(objectclass=inetOrgPerson))

Example:

vlvRolesFilter = (|(objectclass=groupOfNames)
(objectclass=groupOfUniqueNames)
(objectclass=groupOfUrls)\(objectclass=accessGroup)
(objectclass=accessRole))
usersCreationBase = ou=People,dc=hp, dc=com
groupsCreationBase = ou=Groups, dc=hp, dc=com
rolesCreationBase = ou=People,dc=hp, dc=com

uumUserCreationAnd
DeletionAllowed
uumUserEditingAllowed
uumGroupCreationAnd
DeletionAllowed

UUM Metadata
Default: 
uumUserCreationAndDeletionAllowed = true
uumUserEditingAllowed = true
uumGroupCreationAndDletionAllowed = true
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uumGroupEditingAllowed
uumRoleCreationAnd
DeletionAllowed
uumRoleEditingAllowed

uumGroupEditingAllowed = true
uumRoleCreationAndDeletionAllowed = true
uumRoleEditingAllowed = true

usersPasswordAttribute The user password attribute.

Example: usersPasswordAttribute = userPassword

ldapUseCache true - LDAP must use a cache.
false - LDAP should not use a cache.
Default: true

Example: ldapUseCache=true

ldapCacheSize The LDAP connection cache size in bytes. It represents an
in-memory cache that can be used to reduce the number of
search requests sent to the LDAP server.
Default: 1000000

Example: ldapCacheSize=1000000

ldapCacheTTL The LDAP connection cache life-time in seconds.
Default: 3600

Example: ldapCacheTTL=3600

3. bsf.properties.In the <HP_XS>\
agora\glassfish\glassfish\domains\BTOA\config\conf\bsf.properties file, change:

From: To:

personalization.provider=EXTERNAL personalization.provider=SHARED

users.provider=EXTERNAL users.provider=SHARED

groups.provider=EXTERNAL groups.provider=SHARED

4. User synchronization. To improve the synchronization of users, perform the following:
a. The synchronization of LDAP users, and Executive Scorecard and SAP BusinessObjects

users is performed by default every 60 minutes (this is the recommended value).
To change the periodicity, click Admin > Scorecard > XS Settings, and enter a new value in
theUsers Info Reload Rate (minutes) in the Studio update area. Because each
synchronization lasts a few minutes, it is recommended to set the default synchronization
period so there is no overlap with the synchronization itself. For details, see "XS Settings" on
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page 206.
b. Tomake sure that the synchronization is only performed on the relevant users (for

performance purposes). Make sure to add to the external-ldap.properties file located at
<HPXS>\agora\glassfish\glassfish\domains\BTOA\config\conf, the (groupfilter=(&
(objectClass=group)(cn=g-s-rbap-t-hpxs*)) so that only the users needed for Executive
Scorecard are synchronized.

c. Synchronize the LDAP users with SAP BusinessObjects, using one of the options below:
i. Option 1:

A. Log on to SAP ‘BusinessObjects BI platform Central Management Console’, and
select Authentication> LDAP.

B. Check Update LDAP user groups and aliases now.
C. Click theUpdate button.

ii. Option2: create a schedule to schedule regular updates of LDAP groups for users:
A. Log on to SAP ‘BusinessObjects BI platform Central Management Console’’, and

select Authentication> LDAP.
B. Click theSchedule… button.
C. Input the schedule information.

D. Click theSchedule… button.

UI Description
LDAP Management Page

Note: You can combine using the LDAP Management user interface and the external-
ldap.properties file to specify the parameters you need in order to work with LDAP.

Click to refresh the page.
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Status
The configuration is Enabled.

The configuration is Disabled.

Host Address The name of themachine running the LDAP server.

Default: localhost

Example: ldap.hp.com

Port The port number of themachine running the LDAP server.

Default: 389

Example: 636

LDAP Account The Administrator logon name used for creating the initial LDAP connection.
If the field is left empty, LDAP is access by anonymous user. There is no
default Administrator user.

Defaut: CN=Administrator

Example: CN=Administrator
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LDAP Password The Administrator logon password used for creating initial
LDAPConnection. If the field is left empty, LDAP is access without a
password. There is no default Administrator user password.

Default: <empty_value>

SSL Select if the customer requires the SSL connection to LDAP. The
SSL connection to the port defined in ldapPort property is attempted.

If the server cannot perform the connection, the following error
message is issued:
The XS server cannot connect to the LDAP server.
Make sure all the relevant certificates are imported.
After the relevant certificates are imported, restart the XS server.

In such a case, make sure that the relevant certificates are imported. After
the import of the relevant certificates completes, restart the server.

Defaut: unselected

Connect/Disconnect Click to enable the Filter field test buttons as well as the Save button in the
lower area of the page.

Vendor Select the relevant vendor:

l OpenLDAP Directory
l Microsoft Active Directory
l SunOneDirectory
l Netscape
l Novell
l Other
Only the above vendors are supported.

Root Group Search
DN

The base dn (distinguished name) for root groups search. For details on how
to set this parameter, see "Searches for LDAP user groups" on page 92.

Default: <usersBasevalue>

Example: rootGroupsBase = ou=People,dc=hp, dc=com

Root Group Filter The search filter, indicating what instances should be returned from the
LDAP search. For details on how to set this parameter, see "Searches for
LDAP user groups" on page 92.

Default: (|(objectclass=groupOfNames)(objecclass=groupOfUniqueNames)
(objectclass=groupOfUrls)(objectclass=accessGroup)
(objectclass=accessRole))

Example: rootGroupsFilter =
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(|(objectclass=groupOfNames)(objectclass=groupOfUniqueNames)
(objectclass=groupOfUrls)\(objectclass=accessGroup)
(objectclass=accessRole))

Click Test to search for groups using the values you entered in theRoot
Group Filter andRoot Group Search DN fields.

Group Search DN The base dn (distinguished name) for groups search. For details on how to
set this parameter, see "Searches for LDAP user groups" on page 92.

Default: <userBase value>

Example: groupsBase = ou=Groups,dc=hp, dc=com

Group Filter The search filter, indicating what instances should be returned from the
LDAP search. For details on how to set this parameter, see "Searches for
LDAP user groups" on page 92.

Default: (|(objectclass=groupOfNames)
(objecclass=groupOfUniqueNames)(objectclass=groupOfUrls)
(objectclass=accessGroup)(objectclass=accessRole))
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Example: groupsFilter =
(|(objectclass=groupOfNames)(objectclass=groupOfUniqueNames)
(objectclass=groupOfUrls)\ (objectclass=accessGroup)
(objectclass=accessRole))

Click Test to search for groups using the values you entered in theGroup
Filter andGroup Search DN fields.

User Search DN The base DN (distinguished name) for users search.

Default: dc=example, dc=com

Example: usersBase = ou=People,dc=hp, dc=com

User Filter The search filter, indicating what instances should be returned from the
LDAP search.

Default: (&(uid=*)(objectclass=inetOrgPerson))

Example: usersFilter = (&(uid=*)(objectclass=inetOrgPerson))

Click Test to search for users using the values you entered in theUser
Filter andUser Search DN fields.
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Administrator List After you transfer XS transfer to LDAP mode by clicking theSave button, ,
XS fetches user information from the LDAP server. The first time, none of
the LDAP users have XS Administrator permissions. So youmust select at
least one LDAP user to become the XS Administrator and to be able to
manage users in XS.

Click ... to select the users you want to be assigned XS Administrator
permissions:
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You can select more than one user. Their names are separated by semi-
colons (;):

Save Click Save to save your selection. The following warning is issued: Once
the changes to the LDAP configuration are saved, restart the server.

Disable Click Disable to disable the LDAP configuration. Enter information about
the XS Administrator in the dialog box that opens:
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After the LDAP Admin disables the LDAP mode:

l The users and groups used by XS are loaded from the XS local database
and not from the LDAP server anymore.

l The LDAP Adminmust create a new XS Admin user.
If the XS Administrator name is the same as the BOE Administrator
name (BOE Administrator was created during the installation of XS), then
the BOE Administrator password is the same as the XS Admin
password.

LDAP in BusinessObjects
This section describes how to configure SAP BusinessObjects Enterprise internal LDAP.

Tasks

Setting Up LDAP Authentication in BusinessObjects
To configure the LDAP Server settings in BusinessObjects:

1. Log on to BusinessObjects Central Management Console using the administrator name and
password.
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2. Click Authentication to access the authentication options in BusinessObjects.
3. Double-click LDAP.

4. Click Start LDAP Configuration Wizard. The system displays the following screen:
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5. Add the IP address and port number for the LDAP server. Click Next. The system displays the
following screen:

6. Click Next.
7. Enter a name for the base LDAP and click Next. The system displays the following screen:

8. Click Next.
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9. Click Next.

10. Click Next.

11. Select the relevant New User Options:
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l New users are created as named users

l New users are created as concurrent users

12. Click Next. The wizard reports when it has collected all the required information.

13. Click Finish.
14. Wait until the system displays the LDAP screen.
15. Locate theAdd LDAP group (by cn or dn) field in the LDAP screen. Type theGroup Name

configured in LDAP Server, and click Add.

16. Scroll downwards and click Update.
17. Map the LDAP member group whose users you want to authenticate through LDAP.

For example, PR Group is themember group whose users are part of Argus Insight and use LDAP
authentication for access to BusinessObjects.

18. Select Create a new account for every added LDAP alias under the New Alias Options on the
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LDAP window.
19. Close the window.
20. Navigate toHome, Group List, and then right-click PR Group (LDAP) and selectMember Of.

TheMember Of dialog box opens.

21. Click Join Group.
22. Navigate toGroup List, select PRGroup, and then click the right arrow (>) to add the PRGroup

into the Destination Group.

23. Click OK. Note that PR Group (LDAP) is now amember of the PRGroup.
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Data Source Management
The DataWarehouse can connect to other products (data sources) and gather data about these
products. An integration is available for each product (data source). The connection from the data
source to the DWH is called a content pack. FBI extracts the data from the specific data source.
Content packs contain all the artifacts needed to connect to the relevant data source and gather data
from that data source.

Data SourceManagement enables you tomanage the integration of data into the data warehouse
through the activation of data sources. The available data source content packs are registered in the
deployment process and can then be activated in the Data SourceManagement page.

To access:

Select Admin > Data Source Management then click Add data source.

Note: For details on activating Content Packs created in the IDE, see Activate New Content in the
IT Executive Scorecard Content Extension Guide.

Learn More
Content Packs

The DataWarehouse can connect to other products (data sources) and gather data about these
products. An integration is available for each product (data source). A Content Pack is a set a files
which defines the execution of an ETL along with all its parameters.

The connection from the data source to the DWH is called an integration content pack (i-CP). Each
content pack uses an extractor in order to extract the data from the specific data source and contains
all the artifacts needed to connect to the relevant data source and to gather data from that data source.
Content packs include:

l The definition of the datamodel used for the connection.
l The type of data gathered from the data source.
l The ETL definitions.
l The definition files.
l The configuration files.
l The scripts that help build and define the DataWarehouse.
Themapping between the raw data from the data source and the target database in the Data
Warehouse is included in the ETL. The Executive Scorecard runs the KPI engine that reads the data
from the target database, creates the relevant KPIs from that data, calculates the value, and status of
the KPI and displays the relevant information in the Dashboard.
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Youmust run the Data SourceManagement wizard to configure and activate the content packs,
depending on the products you want to integrate with.

The out-of-the-box content packs are:

l CORE content pack. This is the central content pack that is automatically installed during the post-
installation process. It takes consolidated data to the target schema. It includes all the dimensions,
and entities of the DataWarehouse. It also provides the organization of definitions and hierarchies.
All the other integrations depend on the CORE content pack.

l ALM
l AM
l AWS
l AWSCW
l BSM
l CSA
l DP
l FPA
l HPV
l IC
l NA
l NNM
l OO
l PPM
l SA
l SE
l SM
l UCMDB
l VCM
Context

A context is the result of a semantic layer of metadata that creates a business oriented view of the
data. The context contains a schema of the tables that make up the dimension andmeasurement
objects. The context is an interface between the data warehouse and the analytics that display the
data. It then corresponds to the business contexts used in HP IT Executive Scorecard.

Multiple Integration Content Pack Instances

Multiple Integration Content Packs (M-iCP) providemultiple instances of the same data source or
product type. This allows for data source configuration per instance, as opposed to a single activation
for the data source. Each instance has its own version and product type. TheM-iCP source extraction
is based on the FBI extractor technology, and consolidation is enabled between instances.

You can add an instance using the Data SourceManagement page or using the Automation tool. For
back-end tool details, see "The Automation Tool" on page 319.

File Based Integration (FBI)

File Based Integration (FBI) enables you to extract data from a specific data source according to a set
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of instructions. It consists of a plug-able extractor framework for each data source. The extractor
gathers data according to the specific instructions it receives, placing it into a relevant txt file. Each
supported data source has a corresponding extractor (or multiple extractors) capable of extracting data
out of it according to specified instructions. All available Content Packs use FBI.

l Extraction Mechanism. The extraction is based on a set of parameters kept in the
dwabc.INSTRUCTION table in the staging database. The instruction parameters are set by the
BODS workflow during the Source Extract.

l Extraction Methodology. The extraction is done using Enterprise JavaBeans (EJBs) running on
the application container of the DataWarehouse. The EJBs use various technologies (for example,
JDBC, Web Services, Remote EJB objects, data files, and other kinds of http requests) to extract
the data from the data source.

l ETL Source Extract. The first stage of the ETL is the Source Extract. In this phase, the BODS
workflow inserts an instruction to the INSTRUCTION table and then invokes a batch file with the
instruction ID as a parameter. The batch file calls a JAVA program which performs an http request
that activates the relevant extractor. Using the instruction ID, the extractor fetches the relevant
parameters from the INSTRUCTION table.
The FBI extractor extracts the data from the data source into BODS data stores. All Content Packs
integrate using FBI, where data is extracted from the data source into txt files with well defined
standard structure.
The following extractors are available for each source product:

Product Extractor

ALM ALM11, ALM11.5/12

AM MSSQL, Oracle

AWS aws_s3

AWSCW AWSCW

BSM BSM, GDE, UCMDB

CSA CSA

DP DP

FPA FPA

IC MSSQL, Oracle, PostgreSQL

NA MSSQL, Oracle, MySQL

NNM NNM

OO MSSQL, Oracle, MySQL

PPM Oracle

SA SA
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Product Extractor

SE Oracle

SM MSSQL, Oracle

UCMDB UCMDB

VCM script(groovy)

l Troubleshooting Logs.
l <agora>\glassfish\glassfish\domains\BTOA\logs\fbi.log: This log describes all of the current
activity of the file based framework as well as the activity of the extractors themselves.

l <HP_XS>\agora\DataWarehouse\log\dw_fbi_client.log: This log describes the activity of
calling the FBI url from a batch file (which is invoked by a BODS workflow during the ETL source
extract).

Learn more about each data source integration

XS integrates with the following data sources:

l ALM Data Source - Integration, Associated Contexts, KPIs, Metrics, Data Lineage, and Reports in
the IT Executive Scorecard Content ReferenceGuide for the Integration of HP Application
Lifecycle Management

l AWS Data Source - Integration, Associated Context, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of AmazonWeb Services

l AWSCW Data Source - Integration, Associated Context, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of AmazonWeb Service
CloudWatch

l CSA Data Source - Integration, Associated Context, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of HP Cloud Service Automation

l PPM Data Source - Integration, Associated Contexts, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of HP Project and Portfolio
Management

l SMData Source - Associated Contexts, KPIs, Metrics, Data Lineage, and Reports in the IT
Executive Scorecard Content ReferenceGuide for the Integration of HP ServiceManager

l Alternate Source Integration in the IT Executive Scorecard Content ReferenceGuide for the
Integration of Alternate Data Sources

Tasks
This section includes:

• Add and activate a new data source instance 135
• Reactivate an existing data source instance 135
• Deactivate a data source instance 135
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• View data source configuration settings 136
• Edit data source settings and test the connection 136
• Add a new data source to the integrationmechanism 136
• Configure admin tasks using the command line 136
• Use the FBI Verification Extractor 136
• Configure FBI Properties 137

Add and activate a new data source instance
The process of integrating a data source into the DataWarehouse is done through activation of the
source instance.

1. Select Admin > Data Source Management.
2. Click theAdd data source to open the Data source wizard. The Add Data Source page opens.
3. Select the data source type and click Next.

The relevant data source page opens.
4. Enter and select the configuration parameters.
5. Complete the wizard.

The data source instance is activated.

Note: If the first time activation of a data source instance fails, the instance is displayed in
the source list with anError status. You can then activate the data source by clickingEdit
Settings and completing the configuration and activation.

Reactivate an existing data source instance
1. Select Admin > Data Source Management.

2. Click next to the specific source and the source is activated.

Note: Before reactivating the BSM data source, click Edit Settings and enter theRTSM
Username andRTSM Password.

Before reactivating the UCMDB data source, click Edit Settings and enter theUsername
andPassword.

Deactivate a data source instance
You can deactivate the source and stop the integration process, in order to change configuration
details.
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1. Select Admin > Data Source Management.

2. Click and the deactivation warning opens.
3. Click OK.

View data source configuration settings
1. Select Admin > Data Source Management.
2. Click View Settings and the relevant data source page opens.

Edit data source settings and test the
connection
1. Select Admin > Data Source Management.

2. If necessary, deactivate the data source by clicking .
3. Click Edit Settings and edit the configuration parameters.
4. Click Next to validate your changes and test the connection to the data source.

Add a new data source to the integration
mechanism
For details, see "Add Additional Data Sources" on page 292.

Configure admin tasks using the command line
For details, see "DataWarehouse CommandReference" on page 302

Use the FBI Verification Extractor
FBI also supplies an extractor within the FBI framework that can verify and validate the flat file output
you have.

To utilize the extractor:

1. Place the Flat File (FF) in a specific directory with a specific name in theRESULT_FILE_NAME
column in the Instruction table. The name and directory are defined by the ETL developer.
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2. The delimiters in FF should be the same as the ones defined in the delimiters columns (FIELD_
DELIMITER andROW_DELIMITER).The FF must contain the list of fields in the first line with all
the relevant delimiters.

3. Make sure the order and the name of the fields in the FF are the same as the ones defined in the
SourceModelMetadata.

To activate the extractor:

1. Define the productType attribute in the datasource.xml as file (productType="file").
2. You can also override the defined extractor by adding a new entry into the connection detail (in the

datasource.xml), as follows:
<dw:GenericProperty propertyName="overrideextractor" propertyValue="file"
propertyType="string"/>

Configure FBI Properties
In data source activation, each source that is extracted with FBI must have the following properties
configured.

1. Navigate to: <HP_XS>\DataWarehouse\conf\fbi.properties.
2. If multiple extractors are running simultaneously, youmay need to configure the following:

fbi.max.number.of.threads =5
3. If you experience problems with languages that do not work with UTF 16 you can change the

following:
fbi.flat.file.encoding =UTF-16.

Example

l Sample Integration Activation Using the UI
Activate the Integration (Sample)

a. Prerequisites: Make sure all of the required prerequisites have beenmet.
b. Select Admin > Data Source Management then click Add data source.
c. Select the data source type.
d. Select or enter the configuration parameters.
e. Click Next to proceed to the validation page.

l Sample Integration Activation Using the Automation Tool
If you experience errors or problems with the Data SourceManagement UI, you can activate the
sources using DWH back-end tools.
Activate the Integration (Sample-AM Oracle server)

a. Prerequisites: Make sure all of the required prerequisites have beenmet.
b. Enter the product name, product version, time zone, and product type of the data source,

and the configuration parameters in the datasource.xml file as follows:
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l server. The data source server.
l user. The user required for authenticating to the data source server.
l password. The password required for authenticating to the data source server.
l host. The remote server on which the data source server resides.
l port. The port in the data server. By default, the port number is 1521 for Oracle
database and 1433 for SQL Server database.

l sid. The unique name of the database.
l servicename. The alias used when connecting.
l initial load period. The number of months from which you want the data loaded.

Note: Each Content Pack contains a sample xml file for
<Installation directory>\agora\ContentPacks\SA\conf\dataSources.xml.

Sample xml configuration (Advanced configuration)

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<dw:DataSourceConnections version="1.0"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://schemas.hp.com/bto/dwh/v1/dw_

dataSources ..\xmlSchemas\dw_dataSources.xsd"
xmlns:dw="http://schemas.hp.com/bto/dwh/v1/dw_dataSources">

<dw:DataSourceConnection productName="AM" productVersion="5.2"
timeZone="Asia/Shanghai" productType="oracle">

<dw:GenericProperty propertyName="server" propertyValue=""
propertyType="string"/>

<dw:GenericProperty propertyName="user" propertyValue=""
propertyType="string"/>

<dw:GenericProperty propertyName="password" propertyValue=""
propertyType="password"/>

<dw:GenericProperty propertyName="port" propertyValue="1521"
propertyType="string"/>

<dw:GenericProperty propertyName="sid" propertyValue=""
propertyType="string"/>

<dw:GenericProperty propertyName="servicename" propertyValue=""
propertyType="string"/>

<dw:GenericProperty propertyName="dwh.etl.initialloadmonths"
propertyValue="6" propertyType="string"/>
</dw:DataSourceConnection>
</dw:DataSourceConnections>

Note: In order to verify that the connection details added in the datasources.xml file
are correct, it is recommended to test the connection to the data source before
running the configuration. For details, see "The Automation Tool" on page 319.

c. Register Instance:
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To add an additional data source instance enter: dw_cp_register.bat -addInstance –name
<CP_NAME>
The DataWarehouse then looks for the CP in the Content Packs Folder. The instance ID is
displayed in the output.“Instance ID: XX has been added to Content Pack: <CP_NAME>”
It is also added to the CONTENT_PACK table.

d. Configuration:
For first time activation, enter the following: dw_ds_automation.bat -task
ConfigureInitial -cp <content pack name> -instance <INSTANCE_ID> -xmlFilePath
[Path to datasources.xml file].
For all subsequent activations, enter the following: dw_ds_automation.bat -task
Configure -cp <content pack name>-instance <INSTANCE_ID> -xmlFilePath [Path to
datasources.xml file].

Note: After you have configured dw_ds_automation.bat -task ConfigureInitial or dw_
ds_automation.bat -task Configure, delete the value in the propertyValue field of the
password from the dataSources.xml file, as follows:
<dw:GenericProperty propertyName="password" propertyValue=""
propertyType="password" />

For details, see "The Automation Tool" on page 319.

e. Deployment:
Enter the following: dw_ds_automation.bat -task Deploy -cp <content pack name>-
instance <INSTANCE_ID>.The content pack is initialized.

f. Activate the data source:
Enter the following: dw_ds_automation.bat -task Activate -cp <content pack name> -
instance <INSTANCE_ID>.

UI Description
Data Source Management Page

The Data SourceManagement page enables you to select from a list of Integration Content Packs
recognized by the data warehouse. Additionally, it enables you to activate the integration of the data
sources, as well as deactivate andmake configuration changes.
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI
Element Description

Add data
source

Click to open the Data Source wizard. For details, see "Data SourceWizard" on the
next page.

<Data
Sources>

A list of sources, by Name (instance name) andProduct (data source product), that
have been added to the data warehouse. The current status of the data source is
displayed next to the instance name:

l Activated
l Deactivated
l Error
l Initializing: Data source is currently being activated. Relevant only for first time
activation.

View
Settings

Available when the data source has been activated. Displays the read-only
configuration of all connection parameters.

Note: All connection settings are run-time related. Youmust deactivate the
connection to the data source in order to change the settings.
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UI
Element Description

Edit
Settings

Available when the data source has been deactivated. Displays the configuration of all
connection parameters and enables you to test the connection to the data source. The
parameters can be edited.

If the first time activation of a data source instance fails, the instance is displayed in the
source list with anError status. You can then activate the data source by clickingEdit
Settings and completing the configuration and activation.

Activates the relevant data source.

l Once the content pack is activated, the ETL is ready to run. For details on how to
monitor andmanage the ETL, see " ETLManagement " on page 159.

l Do not activate a content pack while the ETL is running.

Deactivates the relevant data source.

Do not deactivate a content pack while ETL is running.

Data Source Wizard

The Data Source wizard enables you to add and activate a selected data source instance.

To access Select Admin > Data Source Management and then click Add data source.

Select the data source type to activate the integration processes.

Important
Information

The UI elements of the wizard differ according to the selected data source.

You can also add additional data sources. For details see "Add Additional Data
Sources" on page 292.

For configuration parameter details, see:
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l ALM Data Source - Integration, Associated Contexts, KPIs, Metrics, Data
Lineage, and Reports in the IT Executive Scorecard Content ReferenceGuide for
the Integration of HP Application Lifecycle Management

l AWS Data Source - Integration, Associated Context, KPIs, Metrics, and Data
Lineage in the IT Executive Scorecard Content ReferenceGuide for the Integration
of AmazonWeb Services

l AWSCW Data Source - Integration, Associated Context, KPIs, Metrics, and Data
Lineage in the IT Executive Scorecard Content ReferenceGuide for the Integration
of AmazonWeb Service CloudWatch

l CSA Data Source - Integration, Associated Context, KPIs, Metrics, and Data
Lineage in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Cloud Service Automation

l PPM Data Source - Integration, Associated Contexts, KPIs, Metrics, and Data
Lineage in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Project and Portfolio Management

l SMData Source - Associated Contexts, KPIs, Metrics, Data Lineage, and
Reports in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP ServiceManager

l Alternate Source Integration in the IT Executive Scorecard Content Reference
Guide for the Integration of Alternate Data Sources

For each source, enter the relevant information and click Next to proceed to the
validation page.

Note: If the activation process is takingmore than one hour, you can change the
status of the CP in the CONTENT_PACK table to “ERROR” and then activate
the CP again.

Wizard
Map

The Data Source wizard contains:

Add Data Source Page > Configuration Parameters Page > Validation Page
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Add Data Source Page

Click Next to move to the next page of the wizard..

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Data source type Select the data source type you want to activate.

Configuration Parameters Page

Each Configuration Parameters page displays parameters specific for the data source. For details, see
the IT Executive Scorecard Content ReferenceGuide relevant to your data source.

Validation Page

This validation page displays activation status information pertaining to the selected data source.
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A message displays the data source status information.

Click Finish to complete the wizard activation process.
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Consolidation Management (On-Demand
Consolidation)
The ConsolidationManagement feature enables you to consolidate an entity that appears in different
data sources, to prioritize the data sources, to select the relevant entity dimensions (columns) and their
priorities, and to select when to use the consolidation.

• Manage your Consolidations 146
• Activate/Deactivate a Consolidation Entity 147

• Configure your Consolidations 148
• Add an entity as a consolidated entity 149

• Edit your Consolidations 154
• Edit a consolidated entity 154

Manage your Consolidations
The ConsolidationManagement feature enables you to consolidate an entity that appears in different
data sources, to prioritize the data sources, to select the relevant entity dimensions (columns) and their
priorities, and to select when to use the consolidation.

To access:

Click Admin > Data Consolidation Management > Data Consolidation Management.

Learn More
About consolidation

When XS integrates with several data sources, overlapping informationmight appear, for the same
entity (for example: Customer,) in different data sources (S1, S2, and S3). If the information is not
consolidated, this might cause the import of additional and confusing data for the entity. For example
youmight get for the sameCustomer: the Customer Name, Customer ID, Address, ZIP code, and
Country provided by S1, the Customer Name, Customer ID, and Domain provided by S2, and the
Customer Name, Customer ID, and the Billing information from S3.

To consolidate the information, you first select the entity that you want to consolidate (for example
Customer) and you then select the priority order of the data sources (S1, S3, and then S2) in theEntity
and Priorities page of the Consolidation wizard. This means that XS checks if the entity (Customer) in
the first data source (S1) includes data. If there is data, it is imported into XS. If there is no data, XS
checks the entity for data in the second data source (S3). If there is data, it is imported into XS. If not,
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the procedure continues until data is found in one of the data sources in the priority order list or no data
has been found at all.

Each entity has dimensions (table columns). To construct a unique key for the consolidation you select
the dimensions that will be used as keys (for example Customer ID), in theConsolidation Rule page
in the Consolidation wizard.

For details on the Consolidation wizard, see "Configure your Consolidations" on the next page.

Tasks

Activate/Deactivate a Consolidation Entity
1. Click Admin > Data Consolidation Management > Data Consolidation Management.
2. Select the relevant entity, and click theActivate/Deactivate toggle button. The entity

consolidation is activated/deactivated.

UI Description
Data Consolidation Management Page
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Consolidated Entities

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Add new configuration entity. Click to open the Consolidation wizard. For details,
see "Configure your Consolidations" below.

Refresh. Click to refresh the list of consolidation entities.

Last Update
<timestamp>

Displays the date and time when the last update to the list of consolidation entities
was performed.

Name The name of the entity with a consolidation configuration.

Status Activated. The consolidation entity is activated. This means that the consolidation
occurs when the conditions are fulfilled.

Deactivated. The consolidation entity is deactivated. This means that the
consolidation does not occur.

Edit Settings. The button is enabled only when the consolidation of the entity is
deactivated. Click to open the Consolidation wizard. For details, see "Edit your
Consolidations" on page 154.

<entity_name> area

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Activation Click ON orOFF to activate or deactivate the consolidation of the
selected entity.

Data Sources (in priority
order)

The list of data sources for the consolidated entity in the selected
priority order.

Rules Sources (in priority
order)

The list of selected columns for the consolidated entity in the
selected priority order.

Configure your Consolidations
The ConsolidationManagement feature enables you to consolidate an entity that appears in different
data sources, to prioritize the data sources, to select the relevant entity dimensions (columns) and their
priorities, and to select when to use the consolidation.

To access:

Click Admin > Data Consolidation Management > Data Consolidation Management and click
(Add new configuration entity).
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Learn More
About consolidation

When XS integrates with several data sources, overlapping informationmight appear, for the same
entity (for example: Customer,) in different data sources (S1, S2, and S3). If the information is not
consolidated, this might cause the import of additional and confusing data for the entity. For example
youmight get for the sameCustomer: the Customer Name, Customer ID, Address, ZIP code, and
Country provided by S1, the Customer Name, Customer ID, and Domain provided by S2, and the
Customer Name, Customer ID, and the Billing information from S3.

To consolidate the information, you first select the entity that you want to consolidate (for example
Customer) and you then select the priority order of the data sources (S1, S3, and then S2) in theEntity
and Priorities page of the Consolidation wizard. This means that XS checks if the entity (Customer) in
the first data source (S1) includes data. If there is data, it is imported into XS. If there is no data, XS
checks the entity for data in the second data source (S3). If there is data, it is imported into XS. If not,
the procedure continues until data is found in one of the data sources in the priority order list or no data
has been found at all.

Each entity has dimensions (table columns). To construct a unique key for the consolidation you select
the dimensions that will be used as keys (for example Customer ID), in theConsolidation Rule page
in the Consolidation wizard.

For details on the Consolidation wizard, see "Configure your Consolidations" on the previous page.

Tasks

Add an entity as a consolidated entity
1. Click Admin > Data Consolidation Management > Data Consolidation Management and

click (Add new configuration entity).
2. In theConfigure a new Consolidation Entity wizard:

a. In theEntity Name list, select the entity you want to consolidate.
b. In theData Sources page, prioritize the data sources.
c. In theConsolidation Rules page, select the relevant dimensions (columns) and prioritize

them.
d. In theSummary page, check that the consolidation is configured properly and click Create.

The consolidated entity is created, added to the list in the ConsolidationManagement page,
and its status is set toDeactivate. You can now activate the consolidated entity.

See also Use Case – Add Service Entity as a Consolidation Entity in theGetting Started with
IT Executive Scorecard.
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UI Description
Configure a new Consolidated Entity

The wizard pages are as follows:

"Welcome Page" below > "Data Sources Page" on the next page > "Consolidation Rule page" on
page 152 > "Summary page" on page 153

Welcome Page
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Data Sources Page

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Entity Name Click V to select the entity that you want to consolidate and select the relevant
entity in the list that opens.

Data
Sources
(in priority
order)

Move the data sources in the relevant priority order using the arrows.

You can also drag and drop the data sources to set their priority order.
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Consolidation Rule page

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Entity Name The name of the entity you are currently consolidating.

Available
Columns

The list of columns of the entity you are currently consolidating.

<Search> Enter a string and click the icon to search for entities with names that

include the string.

Selected
Columns
(in priority
order)

The list of columns you have selected to be included in the consolidation.

Use the arrows to order the columns.

You can also drag and drop the columns to set their priority order.
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Summary page

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Entity Name The name of the entity you are currently consolidating.

Data Sources
(in priority
order)

The list of data sources in the relevant priority order.

Rules (in
priority
order)

The list of rules (entity columns) in the relevant priority order.

Create Click to create the entity consolidation. The consolidated entity is then placed in the
list of entities in the ConfigurationManagement page and the entity status is set to
Deactivated.
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Edit your Consolidations
You can edit your consolidated entities by changing their data sources, the priority of their data
sources, or the columns you want to use in the consolidation rules.

To access:

Click Admin > Data Consolidation Management > Data Consolidation Management, select an

entity, and click .

Learn More
About consolidation

When XS integrates with several data sources, overlapping informationmight appear, for the same
entity (for example: Customer,) in different data sources (S1, S2, and S3). If the information is not
consolidated, this might cause the import of additional and confusing data for the entity. For example
youmight get for the sameCustomer: the Customer Name, Customer ID, Address, ZIP code, and
Country provided by S1, the Customer Name, Customer ID, and Domain provided by S2, and the
Customer Name, Customer ID, and the Billing information from S3.

To consolidate the information, you first select the entity that you want to consolidate (for example
Customer) and you then select the priority order of the data sources (S1, S3, and then S2) in theEntity
and Priorities page of the Consolidation wizard. This means that XS checks if the entity (Customer) in
the first data source (S1) includes data. If there is data, it is imported into XS. If there is no data, XS
checks the entity for data in the second data source (S3). If there is data, it is imported into XS. If not,
the procedure continues until data is found in one of the data sources in the priority order list or no data
has been found at all.

Each entity has dimensions (table columns). To construct a unique key for the consolidation you select
the dimensions that will be used as keys (for example Customer ID), in theConsolidation Rule page
in the Consolidation wizard.

For details on the Consolidation wizard, see "Configure your Consolidations" on page 148.

Tasks

Edit a consolidated entity
To edit a consolidated entity:

1. Click Admin > Data Consolidation Management > Data Consolidation Management, select

an entity, and click .
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The Edit Consolidated Entity wizard opens.
2. Edit the data sources and their priority in theData Sources page, and click Next.
3. Edit the entity columns and their priority in theConsolidation Rule page, and click Next.
4. Click Next.

The entity is updated and listed in the ConsolidationManagement page. Its status is Deactivated.
See also Use Case – Add Service Entity as a Consolidation Entity in theGetting Started with
IT Executive Scorecard.

UI Description
Edit consolidated entities

The wizard pages are as follows:

"Data Sources Page" below > "Consolidation Rule Page" on the next page > "Summary page" on
page 157

Data Sources Page
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Data Sources (in priority
order)

Move the data sources into the relevant priority order using the

arrows.

You can also drag and drop the data sources to set their priority order.

Consolidation Rule Page

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Entity Name The name of the entity you are currently editing.

Available Columns The list of columns (dimensions) of the entity.
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Select or unselect the columns using the horizontal arrows.

Selected Columns
(in priority order)

The list of columns you have selected in the relevant priority order.

Select or unselect the columns using the horizontal arrows.

Change the priority order using the vertical arrows.

You can also drag and drop the columns to change their priority order.

Summary page

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Entity Name The name of the entity you are currently consolidating.

Data Sources
(in priority
order)

The list of data sources in the relevant priority order.
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Rules (in
priority order)

The list of rules (entity columns) in the relevant priority order.

Save Click to save the changes. The consolidated entity is then placed in the list of
entities in the ConfigurationManagement page and the entity status is set to
Deactivated.
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ETL Management
The ETLManagement tab displays the DW ABC Streams Management UI which enables you to
perform the essential tasks related to ETL and stream functionality. It displays the state of active
streams, and enables you to schedule and control stream activity. It also allows you to view the
historical data and the archived stream definitions. All ETLmanagement and functionality is accessed
and performed through this UI.

To access:

Select Admin > ETL Management.

Learn More
ETL

The Extract, Transform, and Load (ETL) process is an end-to-end transfer of external source data
through several staging layers and into the target layer of the data warehouse. The source data can
reside in a single database or multiple databases. The data warehouse uses the ETL process to
extract, consolidate, and transform the source data into ameaningful target model that populates
relevant business analytics.

The ETL process comprises eight primary stages. The stages of this process depend onmetadata and
the nature of the sources.

The ETL is monitored andmanaged through the DW ABC Streams Management User Interface.

ETL Stream Management and Monitoring

The Audit Balance and Control Management user interface performs all of the back-end configuration
and supports full ABC functionality in the ETL. The UI enables you to view the active stream and all of
the nodes containing the stream steps. This allows you to pinpoint exactly which steps have failed
when the stream has been stopped. You can also view the history of the stream as well as inactive
streams.

l Stream. A stream represents the definition of what should run in the ETL, for example, Upstream. It
is a set of a flow of ETL steps. The DW ABC Streams Management UI displays any stream that is
defined, along with the historical data and archived stream information for that stream.

l Batch. A batch is a particular run-time instance of the stream. There is a new batch ID for each run
of the batch. Each time you load a batch, you are creating a run-time instance of the current stream
definition.

l Step. Any type of execution that you want to run in the ETL. The step is defined in a stream.
l Node. A group of steps that run in parallel and are independent of each other. A node is meant to
simplify the display of the stream and to indicate whether a stream is blocked. The node indicates
whether the batch can progress to the next node. If one step has failed, even if all other steps in the

HP IT Executive Scorecard (9.50) Page 159 of 342



node are successful, the execution of the ETLwill not progress to the next node.
The DW ABC Streams Management UI provides visibility andmanagement of:
l Multiple streams

l Stream progress

l Stream execution history

l Archiving

l Batch scheduling

Audit, Balance, and Control

Audit, Balance, and Control (ABC) is a set of functions based on data warehousing best practices.
Although SAP BusinessObjects Data Services manages the ETLworkflow, ABC ensures work flow
integrity. It controls the overall ETL execution, provides error handling, and collects job progress
statistics. ABC's ETL streams and functions can be viewed andmanaged through the DW ABC
Streams Management User Interface, as well as the CLI. Other ABC features are:

l Job streammanagement
l Command line administration tools
l Generated ABC operational system reports
l Generated ABC historical system reports
For report details, see ABC Operational Reports and DataModel Reports.

Tasks
This section includes:

• View active streams 161
• Display hidden streams 161
• Verify or schedule the run_steps command 161
• View stream attributes 162
• Schedule a batch job 162
• Load or resume a batch job 162
• Suspend a stream 162
• Abort a stream 162
• View node information 162
• View step attributes 163
• Refresh stream data 163
• View historical data 163
• View archived data 163
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• Automatically retry steps 163
• Manually retry steps 164

View active streams
1. Select Admin > ETL Management.
2. In the DW ABC Streams Management UI page the stream information is displayed.

Display hidden streams
The DW ABC Streams Management UI enables you to view streams that are hidden and used only for
back-endmaintenance.

1. Select Admin > ETL Management and select Show Hidden Streams.
2. The hidden ETL streams are displayed.
3. You can then schedule the run-steps command and load the batches, as needed.

4. Click to load and run the batch.

5. Click to refresh and check the running status of the ETL.
For details, see "Enterprise Readiness (ER) Tools" on page 237.

Verify or schedule the run_steps command
Run_steps is automatically scheduled after deployment in the post-install. It schedules steps for each
defined stream. The run_steps Scheduler dialog box enables you to verify or change the settings. The
ABC Web Services server automatically creates a schedule for each active stream (Upstream). Run_
steps executes every fiveminutes, or whatever interval you have set in the DWH settings for the value
run_steps scheduler interval. For details see "DataWarehouse" on page 177. The stream will only run
once you have loaded a batch.

Note: If you add a new stream definition, youmust manually define a run_steps schedule.

1. Select Admin > ETL Management and click in the Stream Information area.
2. The Stream Scheduler dialog box opens.
3. Select theRun-Steps Scheduler tab.
4. Click Add New to create a new schedule for a specific stream.
5. Click Save.
6. Click Delete to delete a displayed schedule. You can then add a new one to replace it.
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View stream attributes
1. Select Admin > ETL Management and click More Info in the Stream Information area.
2. The Stream Attributes dialog box opens, displaying the various read-only stream details.

Schedule a batch job

1. Select Admin > ETL Management and click in the Stream Information area.
2. The Stream Scheduler dialog box opens.
3. Select the Load -Batch Scheduler tab.
4. Select the relevant Schedule Type and times and click Save.

Load or resume a batch job
1. Select Admin > ETL Management .
2. When there is no running batch (stream state is None) or the running batch is in a suspended state

(stream state is Suspended), click to load or resume a batch.

Suspend a stream
When the stream is running and the state is Active, you can suspend the stream to allow no action to
happen.

l Select Admin > ETL Management and click in the Stream Information area.

Abort a stream
When you abort, the batch cannot be run again, when you load, it will start a new batch.

l Select Admin > ETL Management and click in the Stream Information area.

View node information
1. Select Admin > ETL Management and click a node in the Stream Information area.
2. The Node Step list opens with the step information displayed.
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View step attributes
1. Select Admin > ETL Management and click More Info in a specific node.
2. The Step Attributes dialog box opens, displaying the various read-only step details.

Refresh stream data
l Select Admin > ETL Management and click in the Stream Information area.

View historical data
Themost recent batch history of the stream is displayed first. You can navigate through the pages of
the various batches. You can view up to five batches at a time.

1. Select Admin > ETL Management and click Historical Data in the Stream Information area.
2. The Historical Data page opens.
3. Select Next to view the other batches in the stream's history. All fields are read only.

View archived data
You can view previous stream definitions and the historical data for each. The historical data is the
batch history for that particular definition. When you add a data source it changes the stream definition.
The new definition has no historical data, you can only view the archived stream and see the historical
data of the previous definitions. All fields are read only.

1. Select Admin > ETL Management and click Archived Streams in the Stream Information area.
2. The Archived Stream Definition page opens.

Automatically retry steps
There is an automatic retry for attempting to fix step errors. A step that has an error it will not
necessarily remain and can resolve itself.

There is a configurable automatic retry mechanism which is set by default to four times. For details on
changing the amount of automatic retries, see "Change the Number of Retries for a Failed ETL Step"
on page 326.
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Manually retry steps
The retry image appears when there has been a failure on a step.

1. Select Admin > ETL Management and click an error node in the Stream Information area.
2. The Node Step list opens with the step information displayed.

3. If all of the retries have been exhausted, and the Retry icon appears.

4. Click in the Stream Information area to suspend the stream.

5. Fix the problem, andmanually retry by clicking .

6. Once the error is resolved, click to resume the stream.

UI Description
DW ABC Streams Management Page

You can view andmanage ETL stream functions and run-time information through the DW ABC
Streams Management UI. The active stream and details are displayed as well as the node and step
details.
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<Stream Display>

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

<Stream
Informatio
n>

Displays the following stream details:

l Stream Name
l Status: Active or Suspended or None
l Duration
l Date

Show
Hidden
Streams

Click to display the hidden ETL streams.

Refreshes the stream information. There is an automatic refresh of the stream
information every twominutes.

More Info Opens the Stream Attributes dialog box. For details, see "Stream Attributes Dialog
Box" on the next page.

Load Batch/Resume. Starts or resumes the running of the specific batch of ETL
stream.

Opens the Stream Scheduler dialog box. Enables you to schedule the load batch and
run_steps commands. For details, see "Stream Scheduler Dialog Box" on page 169.

Suspend Stream. Temporarily suspends the stream.

Abort Stream. Stops the stream that is running.

<Node
Display>

Displays the nodes representing the groups of steps within one level of execution of
an ETL run, the steps that can run in parallel. A node is a collection of steps that all
run in parallel. The icon for each node represents the worst status of all of the steps in
the node.

Indicates that the particular step or all steps in the node have finished
successfully in the execution.

Indicates that a step or a step in the node is currently running

Indicates an error in one of the steps. The step is automatically retried four times
by default. Click the Error node to display the Node Step List in order to retry steps.

Click to retry the step.

Indicates a warning in one of the steps.
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UI Element Description

Click a node to open the Node Step list.

If a step is in error and its maximum number of automatic retries has been exhausted,
then the stream is blocked and will not advance to the next node. All of the steps
contained in the node will run to completion or maximum retries. The errors must be
resolved before the stream will advance to the next node.

Click More Info to display the Step Details dialog box pertaining to the particular
step. For details, see "Step Attributes Dialog Box" on page 168.

Historical
Data

Opens the Historical Data page where you can view stream history, including the
active stream.

For details, see "Historical Data Page" on page 171

Archived
Streams

Opens the Archive Data page where you can view streams that were previously
active with a different definition. for details, see "" on page 173.

Stream Attributes Dialog Box

This dialog box enables you to view the attributes of the displayed stream.
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

All fields are read-only.

UI Element Description

Name Stream name.

Batch ID The ID of the specific batch job of the stream.

Status
Information

Provides details about the status of the stream.

Status Displays the status of the batch:

l OK
l Warning
l Error

State Displays the state of the batch:

l Active
l Suspended
l Finished
l Aborted

Start Time The date and time of the start of the batch job.

End Time The date and time of the end of the stream batch job.

Recovery
Action

Displays any information about recovery actions if the stream was suspended or
stopped.
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UI Element Description

Last Suspended The date and time the stream was suspended.

Last Resumed The date and time the stream was resumed.

Aborted The date and time the stream was aborted.

Step Attributes Dialog Box

This dialog box enables you to view the attributes of the displayed step.

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

All fields are read-only.
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UI Element Description

Name Step name.

Process ID The ID of the specific run of the step.

Batch ID The ID of the specific batch job of the stream.

Status
Information

Provides details about the status of the step.

Status Displays the status of the step:

l NA
l SUCCESS
l WARNING
l ERROR
l MAX_EXECUTION_TIME_EXCEEDED

State Displays the state of the step:

l WAITING
l RUNNING
l STARTING
l FINISHED

Start Time The date and time of the start of the run.

End Time The date and time of the end of the run.

Job Name The BODS job name.

Retry
Sequence

The number of automatic retries.

Recovery
Action

Displays any information about recovery actions if the step failed.

Schedule
Time

The date and time the batch was loaded.

WS Call Time The date and time that ABC makes the call to execute. Indicates if there is a
problem in the execution.

Step Details BODS Jobs: The workflows for the BODS jobs associated with each step.

Other executables: Sub-processes of the step.

Stream Scheduler Dialog Box
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This dialog box enables you to schedule a specific batch job and schedule a run_steps command.

Load Batch Scheduler Tab

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI
Element Description

Schedule
Type

Select either:

l Interval: Timeframe inminutes.
l Time of day: Time according to 24 hour clock.
Enter the required schedule time in the relevant row.

Delete. Deletes the adjacent schedule time.

Add New Creates a new schedule. The new schedule is displayed in blue. When the schedule is
saved to the server, the schedule is displayed in black.

Save Saves all changes to the server.

Discard Discards all changes without saving them to the server.

Close Closes the Load Batch Scheduler dialog box.
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Run_Steps Scheduler Tab

This sets the frequency that the ETLManagement runs all of the executables for the stream.This
includes steps that are loaded as well as the batches created.

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI
Element Description

Interval
(mins)

Enter the interval at which you want to schedule the run_steps command.

The default run_steps interval is initially set at 5minutes in the DataWarehouse page of
the ADMIN tab, but it is recommended to only make changes to the run_steps interval in
this scheduler.

Add
New

Enables you to add a new schedule for the run_steps command.

Save Saves all changes to the server.

Discard Discards all changes without saving them to the server.

Close Closes the run-steps Scheduler dialog box.

Historical Data Page
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You can view a stream's job history on the Historical Data page..

<Stream Display>

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Back to Active
Streams

Opens the DW ABC Streams Management UI main page.

<Stream
Information>

Displays the following stream details:

l Batch ID Number
l Status: Active, Suspended or Aborted
l Duration
l Date

More Info Opens the Stream Details dialog box. For details, see "Stream Attributes
Dialog Box" on page 166.
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UI Element Description

<Node Display> Displays the nodes representing the groups of steps within the execution of an
ETL run. A node is a collection of steps that all run in parallel.

Indicates that all steps have finished successfully.

Indicates an error in at least one of the steps.

Indicates that the worst status of all contained steps is a warning.

Click a node to open the Node Step list.

Previous Navigates to the previous job history data for the stream.

Next Navigates to the next job history data for the stream.

<< Navigates to the earliest job history data for the stream.

Archived Streams Page
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This page enables you to view stream definitions that have been changed and archived..

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

All fields are read-only.

UI Element Description

Back to
Active
Streams

Opens the DW ABC Streams Management UI main page.

<Stream
Information>

Displays the following stream details:

l Stream Name
l Status: Active or Suspended
l Duration
l Date

More Info Opens the Stream Attributes dialog box. For details, see "Stream Attributes Dialog
Box" on page 166.

Historical
Data

Opens the Historical Data Page where you can view the archived stream history.
For details, see "Historical Data Page" on page 171.

Back to
Active

Opens the DW ABC Streams Management UI main page.
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UI Element Description

Streams

<Node
Display>

Displays the nodes representing the groups of steps within the execution of an ETL
run. A node is a collection of steps that all run in parallel.
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Perform Administration Tasks for
Foundation
Foundation settings enables you to define various system settings for the administration of the product.
The Foundations Settings includes the following:

• DataWarehouse 177
• Define the settings 181

• Foundation 189
• Configure the Foundation settings 189

• Single Sign-On 191
• Add or change SSO values 191

• Pages 194
• Configure the page settings 194
• Modify themaximum number of open pages 194
• Modify themaximum number of active pages 195

• Website 196
• Set the ping interval 196

• ITFM 198
• Configure the ITFM settings 198
• Configure ITFM Users, Roles, and Permissions 198
• Change the currency of the ITFM 198

• Dashboard Settings 200
• Configure the Dashboard Settings 200

• Engine Settings 202
• Configure the Engine Settings 202

• Score Thresholds 204
• Configure the Score Thresholds 204

• XS Settings 206
• Configure the XS settings 206
• Show or hide the Debug Properties 206
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Data Warehouse
DataWarehouse Settings enables you to define settings for various parts of the data warehouse
structure.

To access:

Select Admin > Data Warehouse.

Learn More
Model

The data warehousemodel is an end-to-end solution for extracting source data and consolidating
disparate source datamodels into a consolidated datamodel. The data organized to reflect this model
resides in target tables that become the source for Executive Scorecard.

The data warehouse relies on an external RDBMS to provide daily maintenance and backup support,
SAP BusinessObjects Data Services to assist with ETL, an ABC infrastructure of utilities and
processes to govern regularly scheduled ETL jobs, and internal data warehouse utilities to create the
data warehouse andmaintain data integrity.

The figure below shows the principal data warehouse components and how they interact. Read the
following sections for more information about each component, its role, and responsibilities.
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Source data models

Source data originates in external application repositories. Data generated by an external application
can be rich in business information, but unless you can integrate it with equally important business
information generated by other applications, it is difficult to get a complete view of operational
information.

The source datamodels describe the source and extraction format so that the data warehouse can
consume this data and integrate it into a common view that you can use to populate comprehensive
business intelligence reports and dashboards.

Data Integration Interface

The data integration interface (DII) is the access layer that stands between the source database
models and the extractionmodels in the staging database. The DII uses amappingmodel that
transforms the source data to fit into extraction work tables. The DII can accommodateminor
variations in the sourcemodel schemas from one version to another.
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Note: This interface requires access to the source systems.

SAP BusinessObjects Data Services

SAP BusinessObjects Data Services is the access mechanism that performs the physical data
extraction from the source repository to the staging database. Each stage of the ETL is embodied in a
Data Services job, from the extraction of source data to the target database.

Audit, Balance, and Control

Audit, Balance, and Control (ABC) processes ensure that source data is not corrupted in the extraction
process, and that the integrity of the extracted data is maintained as it progresses from the initial
source extraction through the logical and physical transformation into target tables. SAP
BusinessObjects Data Services canmove the data but does not evaluate whether the final result is
correct. ABC establishes checkpoints and provides feedback on each step to guarantee that each step
is valid before the next step begins.

The Audit component ensures consistency during ETL processing. It measures the number of records
in and the number of records out for each step and displays these runtime statistics in a collection of
audit reports.

Balance verifies that data in the data warehousematches data in the source system.

Example If the data warehouse stores project dollar amounts then the balance process verifies
that the aggregate project dollars in the data warehousematches the aggregate project dollars in
the source application data.

Control governs the order of execution of ETL processes. Control makes sure that there is a proper
restart and recovery when a system error occurs. Control alsomanages job dependencies at runtime.

ABC utilities are applications that you can invoke automatically or manually to run ETL, solve
problems, and perform ETL-related tasks.

Staging database

The staging database contains tables and snapshots that are critical to the ETL process. Metadata
describes these tables. Executive Scorecard processes data in the staging database before loading it
into the final target tables in the target database.

l Extraction (EXT) tables contain the initial version of source data. EXT tables are used during the
stage of ETL when Executive Scorecard loads data from the extract flat files into the staging
database.

l Validation failure (VALF) tables are used during the data validation process that ensures all of the
data is usable. VALF tables store source data that is rejected by the ETL process due to validation
failure. Data validation is part of the process to load the EXT tables.

l Identification (SSI and MSI) tables restructure the diverse source system data into a conformed
structure. Executive Scorecard uses SSI andMSI tables to standardize the data and add an
enterprise key.

l Consolidation (MSC) tables integrate disparate source data into a consolidated entity. TheMSC
tables contain the uniform structure that Executive Scorecard uses to load the data into the target
tables.

l Transformation (XFR) tables are load-ready tables that match the internal structure of the target
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tables. Executive Scorecard uses XFR tables while preparing the data to be loaded into the target
tables in the target database.

l Lookup (LOOKUP) tables store durable keys and surrogate keys. Executive Scorecard uses these
tables to establish dimension-to-dimension references in dimension tables and foreign key
references in fact tables.

l Snapshot (TSNP, SSNP, and CSNP) tables are the persistent storage for ETL staging data.
These snapshot tables capture the changed data and support the data warehouse recovery process.
The data warehouse uses TSNP tables for source extraction staging, SSNP tables for single source
integration staging, and CSNP tables for multiple source consolidation staging. The final ETL stage
captures the snapshot data.

l Cross Reference (XREF) tables support the data integration processes that combine records from
multiple sources into a single record in the consolidationmodel.

l Cross Reference Generator (XREFGEN) tables support datamatching and cross reference inputs
for the consolidationmodels.

l Metadata tables contain a logical model and describe how to translate that model into the physical
implementation of tables and views.

l ABC tables support the ETLworkflow and enable job control and sequencing. They also host audit
information to ensure data quality.

Target database

The target datamodels describe the format of the data that produces business intelligence analytics.
The instantiated datamodels are dimension, fact, and hierarchy tables populated with data obtained
through ETL processes.

Dimension tables contain the datamodel to be queried and presented by Executive Scorecard in a
variety of reports and analytics.
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Fact tables contain data that describes events, transactions, or other granular information.

Fact snapshots tables are fact tables that describe the state of things in a particular instance of time,
and usually includes more semi-additive and non-additive facts.

l Semi-Additive:Semi-additive facts are facts that can be summed up for some of the dimensions in
the fact table, but not the others.

l Non-Additive:Non-additive facts are facts that cannot be summed up for any of the dimensions
present in the fact table.

Hierarchy tables capture hierarchical relationships among levels of data.

Queries

You can use structured query language (SQL) to create a primary abstraction layer of data from the
target tables and use that data to populate reports, dashboards, or resolve business questions. The
SAP BusinessObjects Enterprise XI 3.1 suite of business tools simplify accessing this information and
storing it in business-oriented views.

Presentation

SAP BusinessObjects Enterprise XI 3.1 uses a universe abstraction layer to organize data for
presentation in out-of-box or user-designed analytics. The universe provides a business oriented view
of the data that resides in the data warehouse target tables.

Tasks

Define the settings
1. Select Admin > Data Warehouse.
2. Click the relevant field in theValue column and enter the value.
3. Click Save to save your settings.

UI Description
Data Warehouse Page

This page enables you to configure the DataWarehouse settings.

Data Warehouse Table
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Name The name of the DataWarehouse field.

Description The description of the DataWarehouse field.

Value The current DataWarehouse field value.

Click the relevant row and enter a value.

General Table

UI Element Description

BODS
Cleanup
Days of
Week

The days of the week when you want to perform the cleanup of the BODS dump.
Select: 0 or 7 for Sunday is, 1 for Monday, 2 for Tuesday, 3 forWednesday, 4 for
Thursday, 5 for Friday, and 6 for Saturday, or use the first three letters of the day
name.

SAP BusinessObjects Data Services creates dump files whenever it runs into a
problem. These dumps are usually large and are not removed automatically , causing
the file system to eventually run out of disk space.

When the scheduled cleanup of the dump files is executed, it first cleans up the dump
files, and then it examines the schedule settings and update its schedule if needed.
So, if you’ve scheduled the cleanup for once a day Sunday – Thursday, and you want
to change it to once a week, simply change the days of week value and the next time
the cleanup is triggered, the new schedule will go into effect.

Example

If you want to schedule the cleanup every Sunday, you can enter any of the
following in the BODS Cleanup Days of Week setting value:

l “Sun”
l 0
l 7
If you want to schedule the cleanup every Monday – Friday, you can enter any of
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UI Element Description

the following in the BODS Cleanup Days of Week setting value:

l “Mon” – “Fri”
l 1-5
l 1,2,3,4,5
l “Mon”, “Tues”, Wed”, “Thurs”, “Fri”

The value is simply used to set the dayOfWeek field in the
javax.ejb.ScheduleExpression and the ScheduleExpression performs the validation of
the value.

BODS
Cleanup
Time of
Day

The time (hours andminutes) when you want to perform the cleanup of the BODS
dump. The format is: HH:MM for a 24 hour clock (for example: 16:00). The hour is
according to the server time zone, not to the client time zone.

Data
Warehouse
Port

The DataWarehouse web server port. This field is read-only.

Data
Warehouse
Server
Name

The DataWarehouse server machine hostname or IP address. This field is read-only.

External
Source
File
Location

The directory where the external source files used by the DataWarehouse are stored.

First year
handled by
DWH dates

The first available year for DataWarehouse dates. This includes period, time zones or
DST.

Fiscal
month of
year

The first month of the fiscal year. This field is read-only.

Last year
handled by
DWH dates

The last available year for DataWarehouse dates. This includes period, time zones or
DST.

Scheduler
Run-steps
Interval

The interval value in minutes that you want the run_steps command to automatically
execute. This is the default value for initial execution. All changes in interval should be
made in the DW ABC Streams Management UI. For details, see " ETLManagement "
on page 159.

A run-steps schedule configured in DataWarehouse Settings does not affect the
existing running batch schedule. It is recommended to only change the run-steps
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UI Element Description

interval schedule in the ETLManagement tab DW ABC Streams Management UI.

To enable a new run-steps schedule configured in DataWarehouse Settings on
existing defined streams you can:

l Restart the XS server.
l Reload the dw-abc-services application: Glassfish Admin Console >
Applications, and click Reload for the dw-abc-services application.

l Redeploy the application
In these cases you would now have two scheduled intervals. Delete one in the DW
ABC Streams Management UI.

SAP BusinessObjects Data Services for HP XS Table

UI Element (in
alphabetical
order) Description

BODS Database
Administrator
Username

The username to access the SAP BusinessObjects Data Services database.
Must have write permissions.

BODS Database
Administrator
Password

The user's password to access the SAP BusinessObjects Data Services
database.

BODS database
type/product

The database type: Oracle, SQL Server, DB2, MS SQL, or Sybase ASE. This
field is read-only.

Note: Currently only MS SQL is supported.

Administrator Guide
Perform Administration Tasks for Foundation

HP IT Executive Scorecard (9.50) Page 184 of 342



UI Element (in
alphabetical
order) Description

BODS
Repository
Server Name

The SAP BusinessObjects Data Services repository server machine's host
name or IP address.

Installation
Directory

The absolute path to the SAP BusinessObjects Data Services and HP XS
installation directory. This field is read-only.

Management
Console
Password

The SAP BusinessObjects Data Services management console password.

Management
Console URL

The SAP BusinessObjects Data Services management console URL. This field
is read-only.

Management
Console
Username

The SAP BusinessObjects Data Services management console username.

Repository
Database-
Server's Port

The SAP BusinessObjects Data Services repository database server's port.
This field is
read-only.

Repository
Name

The SAP BusinessObjects Data Services repository name. This field is read-
only.

Repository
Password

The SAP BusinessObjects Data Services repository password.

Repository
Username

The SAP BusinessObjects Data Services repository username. This field is
read-only.

Web Services
Timeout

The amount of time, in seconds, that DataWarehouse waits for a SAP
BusinessObjects Data Services to respond to a web services request before a
timeout.

Staging Database Table
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UI Element (in
alphabetical order) Description

ABC Database
Password

The ABC database password.

ABC Database
Username

The ABC database username. This field is read-only.

ABC DB login name ABC logon name used to access the database.

ABC DB login password ABC logon password used to access the database.

Database Password The staging database password.

Database Server Name The staging database server machine hostname or IP address.

Database Server Port The staging database server port.

Database Username The staging database username. This field is read-only.
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UI Element (in
alphabetical order) Description

Metadata Database
Password

Themetadata database password.

Metadata Database
Username

Themetadata database username. This field is read-only.

Metadata DB login name Metadata logon name used to access the database.

Metadata DB login
password

Metadata logon password used to access the database.

Password The staging database administrator password.

Staging Database Name The name of the staging database on theMS SQL server. This field is
read-only.

Staging DB login name Staging database logon name used to access the database.

Staging DB login
password

Staging database logon password used to access the database.

Staging Target DB
Database Password

The staging target database password.

Staging Target DB
Database Username

The staging target database username. This field is read-only.

Staging Target DB login
name

Staging Target database logon name used to access the database.

Staging Target DB login
password

Staging Target database logon password used to access the database.

Time Dimension
Granularity

The granularity of time, in minutes, of the time dimension. This field is
read-only.

Username The staging database administrator username. This user must have
write permissions. This field is read-only.

Target Database Table
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UI Element (in
alphabetical order) Description

Administrator
Password

The target database administrator password.

Administrator
Username

The username used to access the target database. This user must have
write privileges. This field is read-only.

Database Password The target database password.

Database Server Port The target database server port. This field is read-only.

Database Username The target database username. This user must have write permissions.
This field is read-only.

MS SQL Server
Database Name

The target databaseMS SQL server name. This field is read-only.

Server Name The target database server name. This field is read-only.

Target DB login name The logon name for the target database. May be different than the fixed
user and schema name.

Target DB login
password

The target database logon password used to access target database
metadata.
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Foundation
Enables you to configure foundation settings in Executive Scorecard.

To access:

Select Admin > Foundation > Foundation.

Tasks

Configure the Foundation settings
1. Select Admin > Foundation > Foundation.
2. Click the relevant row and enter the required setting.
3. Click Save to save your settings.

UI Description
Foundation

This page enables you to configure the Pages settings.

Click to refresh the page.
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Automatic
update of
anti virus
database

Set to true to periodically update the anti virus database. The update occurs every
Sunday at 12:00 am (midnight).

Default: false

Mail
Address
Domain List

The list of mail address domains separated by semi-colons (;).

Mail Retry
Interval

The interval of time between two retries of uploading/sendingmail in seconds.
Default: 10 seconds.

Mail Sender
Address

The email that appears as a Sender in the emails sent by the Entity Report. For
details, see "Notifications - Entity Report" on page 210.

Mail Server The name of your email server.

Mail Server
Port

The port used by your email server.

Mail User
Name

The name of the user you use to log on to theMail Server. The system uses this
user to send the notification emails.

Mail User
Password

The password of the user you use to log on to theMail Server. The system uses this
user to send the notification emails.

Query
Engine
Expired
Execution
Time

If the SQL executing time exceeds the value of the setting, the allocation of ITFM
returns an error. Youmay need to increase the value if your allocations havemany
stages or if your database includes many cost data. The unit is seconds.

Default: 600.

Virtual
Server URL

The URL of the virtual server.
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Single Sign-On
HP Lightweight Single Sign-On is amethod of access control that enables you to navigate to other HP
products that implement LW-SSOwithout supplying credentials again. A user can log on once and gain
access to the resources of HP software systems without being prompted to log on again. The
applications inside the configured group of software systems trust the authentication, and there is no
need for further authentication whenmoving from one application to another.

The Single Sign-On page enables you to configure Single Sign-On (SSO) requirements.

To access:

Select Admin > Settings > Single Sign-On.

Learn More
HP Lightweight Single Sign-On is amethod of access control that enables you to navigate to other HP
products that implement LW-SSOwithout supplying credentials again. A user can log on once and gain
access to the resources of HP software systems without being prompted to log on again. The
applications inside the configured group of software systems trust the authentication, and there is no
need for further authentication whenmoving from one application to another.

Tasks

Add or change SSO values
1. Select Admin > Foundation > Single Sign-On.
2. Click the relevant field in theValue column and enter the value.
3. Click Save to save your settings.

UI Description
Single Sign-On Page

This page enables you to configure the SSO settings to log on of all HP products.

Click to refresh the page.
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Identity Management Single Sign-On Table

UI Element Description

Identity
Management
Enabled

Select the check box and enter the name of the IDM header (the header that
contains the user logon name) in theValue field of the Identity Management
Header setting.

Identity
Management
Header

The name of the IDM header (the header that contains the user logon name).

Lightweight Single Sign-On Parameters

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

LW-SSO Cookie Secure Select to make sure that the cookie is always encrypted when
transmitting from client to server.

LW-SSO Server Domain The domain used for token creation. This value is required in cases of
multi-domains.

LW-SSO Token Creation
Key (initString)

The string used as the encryption key for token creation and
validation.

LW-SSO Trusted Hosts -
DNS Domains

The list of trusted DNS domains that allow multi-domain support
(must be separated by commas).

LW-SSO Trusted Hosts -
FQDN

The list of trusted hosts' FQDN that allow multi-domain support
(must be separated by commas).
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UI Element Description

LW-SSO Trusted Hosts -
IPs

The list of trusted hosts' IPs that allow multi-domain support (must
be separated by commas).

LW-SSO Trusted Hosts -
Net Bios Names

The list of trusted hosts' net bios names that allow multi-domain
support (must be separated by commas).
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Pages
Enables you to configure the Dashboard page settings in Executive Scorecard.

To access:

Select Admin > Foundation > Pages.

Learn More
Formore information about Executive Scorecard pages, see Page Layout and Components in the
IT Executive Scorecard Business Analyst Guide.

Tasks
This section includes:

• Configure the page settings 194
• Modify themaximum number of open pages 194
• Modify themaximum number of active pages 195

Configure the page settings
1. Select Admin > Foundation > Pages.
2. Click the relevant row and enter the required setting.
3. Click Save to save your settings.

Modify themaximumnumber of open pages
By default, an unlimited number of pages can be open at the same time. If you havemultiple pages
open, up to 5 of themost popular pages are immediately available for display when you switch to them.
The other pages are least viewed pages, meaning that are silently deactivated in the background.
When you select them, it might take a few seconds until they load and display their content.

Note that if you increase these limits, performancemay be impaired.

Tomodify themaximum number of open pages:

1. Select Admin > Foundation > Pages.
2. Modify theMaximum number of open pages entry as needed.
For details, see "Perform Administration Tasks for Foundation" on page 176.
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Note that if you increase themaximum number of pages, performancemay be impaired.

Modify themaximumnumber of active pages
By default, an unlimited number of pages can be open at the same time. If you havemultiple pages
open, up to 5 of themost popular pages are immediately available for display when you switch to them.
The other pages are least viewed pages, meaning that are silently deactivated in the background.
When you select them, it might take a few seconds until they load and display their content.

Note that if you increase these limits, performancemay be impaired.

Tomodify themaximum number of active pages:

1. Select Admin > Foundation > Pages.
2. Modify theMaximum number of loaded pages entry as needed.
For details, see "Perform Administration Tasks for Foundation" on page 176.

UI Description
Pages Settings

This page enables you to configure the Pages settings.

Click to refresh the page.

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI
Element Description

Max
loaded
Pages

Themaximum number of open pages that are currently loaded in Executive Scorecard.
The options are any valid number or 0 for unlimited.

Max open
pages

Themaximum number of open pages in Executive Scorecard. The options are any
valid number or 0 for unlimited.
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Website
TheWebsite page enables you to configure ping time intervals for refreshing the browser automatically

To access:

Select Admin > Foundation > Website.

Tasks

Set the ping interval
1. Select Admin > Foundation > Website.
2. Select the check box to enable the ping feature. De-select the check box to disable the ping

feature. The browser will then time out.
3. Click thePing time interval row and enter the required time in seconds.
4. Click Save to save your settings.

UI Description
Website Page

This page enables you to configure theWebsite settings.

Click to refresh the page.

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Enable Session
Keepalive

Select to enable the ping feature.

HP IT Executive Scorecard (9.50) Page 196 of 342



UI Element Description

Ping time interval The amount of time (in seconds) between browser refresh. This ensures that
the application does not time out.

Note: Changes will only take effect in the next logon.

Administrator Guide
Perform Administration Tasks for Foundation

HP IT Executive Scorecard (9.50) Page 197 of 342



ITFM
Enables you to configure the settings for the IT Financial Management module.

To access:

Select Admin > ITFM > ITFM.

Tasks
This section includes:

• Configure the ITFM settings 198
• Configure ITFM Users, Roles, and Permissions 198
• Change the currency of the ITFM 198

Configure the ITFM settings
1. Select Admin > ITFM > ITFM.
2. Click the row of the relevant setting and enter the value or select the option.
3. Click Save to save your settings.

Configure ITFM Users, Roles, and Permissions
Roles and permissions for users is managed through the ADMIN tab, enabling you to specify
permissions for each role. Additionally, you can attach instances to a permission, so that the user can
only access certain budgets or allocations. This model is based on:

l The permissions of each user, instead of relying on the user’s roles. The permissions are final and
cannot bemodified or deleted, allowing the flexibility to grant users access to different ITFM
features, while assigning them to different roles.

l Budget related operations according to each user’s scope (instance level permissions).
Two out-of-the-box roles are available: BUDGET_COORDINATOR and FINANCIAL_ANALYST. For
details, see "RoleManagement" on page 63.

Change the currency of the ITFM
The default currency for all IT Financial Management KPIs is $.
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During the post-installation process, if you have changed the currency in theData Warehouse -
Currency Configuration page of the post-install wizard, youmust change the currency in each one of
the KPIs tomatch your selection, as follows:

1. In the application, click Studio.
2. In the Active KPIs pane, for each KPI under the Financial Planning Analysis Scorecard, and in

theConfiguration details tab, select the relevant unit in theUnit drop down list.
3. Click Save.

UI Description
ITFM Page

This page enables you to configure specific IT Financial Management-related settings .

Click to refresh the page.

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Interval for clearing
FPA cache

How long the system should save the objects loaded from the database
during the allocation scenario calculations.

Note: Do not modify this parameter.

Polling interval for
FPA's process new
data monitor

Specifies the execution interval of the IT Financial Management procedure
that checks whether new data was loaded using ETL, and recalculates
allocation scenarios accordingly.

Note: Do not modify this parameter.
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Dashboard Settings
Enables you to set the settings for the Dashboard, where an executive can view the progress of the
required objectives.

To access:

Select Admin > Scorecard > Dashboard Settings.

Learn More
Formore Executive Scorecard dashboard information, see "Prepare the Dashboard Display".

Tasks

Configure the Dashboard Settings
1. Select Admin > Scorecard > Dashboard Settings.
2. Click the row of the relevant setting and enter the value.
3. Click Save to save your settings.

UI Description
Dashboard Settings Page

This page enables you to configure specific dashboard settings.

Click to refresh the page.
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Max search results in the filter Themaximum number of search results allowed in the filter.
The default value is 1000.

Number of days annotations are
considered new

The number of days annotations are considered new. The
default value is 7.
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Engine Settings
Enables you to configure settings for the HP IT Executive Scorecard KPI engine, which performs
discovery on data coming from contexts (data sources).

To access:

Select Admin > Scorecard > Engine Settings.

Tasks

Configure the Engine Settings
1. Select Admin > Scorecard > Engine Settings.
2. Click the row of the relevant engine function and enter the value in milliseconds.
3. Click Save to save your settings.

UI Description
Engine Settings Page

This page enables you to configure the engine settings for HP IT Executive Scorecard.

Click to refresh the page.

HP IT Executive Scorecard (9.50) Page 202 of 342



Engine Settings

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI
Element Description

Engine
Health
Timer

The amount of time inmilliseconds, after which, if the calculation result is not received
for the KPI, a new calculation attempt is started. The default value is 600,000, which
equals 10minutes.

Recalculate Settings

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Max number of days to
recalculate for Daily KPIs

Themaximum number of days used in recalculations for KPIs and
Metrics with a Calculation Period set toDaily. Default: 30.

For details, see Recalculation in the IT Executive Scorecard
Business Analyst Guide.
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Score Thresholds
Enables you to set the score thresholds for the KPIs in the HP IT Executive Scorecard.

To access:

Select Admin > Scorecard > Score Thresholds.

Learn More
Formore score threshold information, see "Learn About KPI Formula and Filter, Threshold, Value,
Trend, and Score" in the IT Executive Scorecard Business Analyst Guide.

Tasks

Configure the Score Thresholds
1. Select Admin > Scorecard > Score Thresholds.
2. Click the row of the relevant score threshold and enter the value.
3. Click Save to save your settings.

UI Description
Score Thresholds Page

This page enables you to configure the score threshold settings for the KPIs in HP IT Executive
Scorecard.

Click to refresh the page.
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

Note: EachScore Max Valuemust be greater than 0 and less than the next one ( Error Score
Max Value <Warning Score Max Value < Good Score Max Value)

UI Element Description

Critical
Score Max
Value

Themaximum value on the KPI scale, below which the value is scored as an error.
KPIs that score values equal to or below this value, receive an error score.

Example If themaximum error score is 3.3, then a score on the scale from 0 -
3.3 is an error. Default: 3.3

Good Score
Max Value

Themaximum value on the KPI scale, below which the value is scored as good.
KPIs that score values equal to or below this value, receive a good score.

Example If themaximum good score is 10, then a score on the scale from 6.6 -
10, is good. Default: 10

Warning
Score Max
Value

Themaximum value on the KPI scale, below which the value is scored as a
warning.
KPIs that score values equal to or below this value, receive a warning score.

Example If themaximum warning score is 6.6, then a score on the scale from
3.3 - 6.6, is a warning. Default: 6.6
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XS Settings
Enables you to set various scorecard settings.The HP IT Executive Scorecard is a way tomap and
translate complex business information into something that's understandable to everyone.

To access:

Select Admin > Scorecard > XS Settings.

Tasks
This section includes:

• Configure the XS settings 206
• Show or hide the Debug Properties 206

Configure the XS settings
1. Select Admin > Scorecard > XS Settings.
2. Click the row of the relevant setting and enter the value.
3. Click Save to save your settings.

Show or hide the Debug Properties
Themaintenance of HP IT Executive Scorecard is performed using the ADMIN tab.

To display or hide the debug properties (ID and Type) displayed in the Configuration details tab for all
templates or active nodes, select Admin > Scorecard > XS Settings > Debug Mode, and:

l Select theApplication Debug Mode option to display the debug information in the Configuration
details tabs.

l Clear theApplication Debug Mode option to hide the debug information in the Configuration details
tabs.

UI Description
XS Settings Page

This page enables you to configure specific XS settings.

Click to refresh the page.
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Context Designer

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Maximum size of
.CSV file (MB)

Themaximum size of a .CSV file that can be imported into the Context
Designer. The default value is 20MB.

Debug Mode

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Application Debug Mode Select to activate the debugmode.

 Studio Update

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI
Element Description

Meta
Data
reload
rate
(Days)

The number of days after which themeta data is reloaded. If you configure Executive
Scorecard to work with the SAP BusinessObjects Enterprise universes, every X days
(where X corresponds to what you specified inMeta Data reload rate (Days)),
Executive Scorecard reloads all the universes metadata from the SAP BusinessObjects
Enterprise.

The default value is 7 days.
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UI
Element Description

Users
Info
reload
rate
(Minutes)

The number of minutes after which user info is reloaded. The default value is 60minutes.
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Semantic Layer - Contexts and Universes
Executive Scorecard semantic layer includes Contexts and universes.

The Context Designer feature enables you to create andmanage Contexts (universes). The Contexts
can be based on your target schema tables or on Excel (or .CSV) files that can be uploaded to the
target schema using the Data Loader.

Context Designer can be used to upload data and create contexts based on the data, when you want to
work with the Executive Scorecard and IT Financial Management applications without using Data
Warehouse and SAP BusinessObjects Enterprise. It is a direct way to upload data into the Executive
Scorecard Studio using files without performing integrations to external sources or to other
HP products. It can be used, to integrate third party data, testing, or for Proof of Concept (POC)
sessions. It can also be used as a component of Executive Scorecard to integrate third party data.

Context Designer provides KPI results based on your real data.

For general information about the Semantic Layer (contexts and universes), see the IT Executive
Scorecard Content ReferenceGuide.

For details about the contexts, KPIs, Metrics, and integration with a specific data source, see see the
IT Executive Scorecard Content ReferenceGuide relevant to the data source.
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Notifications - Entity Report
You use the Entity Report to view the changes to the values or states of the XS entities.

You can schedule to automatically generate the Entity Report for selected Scorecards, Perspectives,
Objectives, KPIs, Metrics, KPI Breakdowns, andMetric Breakdowns and to send selected users email
notification that include the Entity Report.

To access:

Click Admin > Notifications > Entity Notification.

Learn More
The Entity report

You can configure a single report for more than one entity.

If you select to display the Scorecards, Perspectives, or Objectives entities in the report, all the
children entities under the selected entities are also displayed in the report. If you select KPIs or
Metrics, their Breakdowns are also displayed in the report.

The report displays both the current status and the change in status for the last closed period (not since
the last time the report was scheduled). For example, you create a daily scheduled report for amonthly
KPI. The report shows the KPI current value, the trend that compares the current value and the value
for the last closed period (previous month), the status, the last calculation time, and the KPI threshold.

You can schedule to send the report every day, week, month, or quarter at a specific time.

The report displays the following information:

Entity
Type

Name
of
Entity

Current
Status
of Entity

Current
Value
of Entity

Current
Score
of Entity Trend

Last
Calculation
Date

Entity
Children
Data

Scorecard V - - - - - V

Perspective V - - - - - V

Objective V V - V V V V

KPI V V V - V V By choice

KPI Breakdown V V V - V V By choice

Metric V - V - V V By choice

Metric Breakdown V - V - V V By choice
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Tasks
This section includes:

• Configure the Notification settings 211
• Create an Entity Report 211
• Add recipients to an Entity Report 211

Configure the Notification settings
Before you can create and schedule Entity Reports, youmust configure the email settings inAdmin
> Settings > Foundation. For details, see "Foundation" on page 189.

Create an Entity Report
Youwant to get a scheduled report on the current status (value, status, trend ) of specific entities.
Depending on your permissions:

1. Log into XS.
2. Click Admin > Notifications > Entity Notification.
3. Click New to create a new notification.
4. In the New Notification dialog that appears, select Entity Report, and enter the notification name,

description, select the relevant entities from the entities list, set the scheduling time when the
report is to run, select the relevant recipients, select the Active notification status, and test the
report or save.

Add recipients to an Entity Report
You have scheduled an entity report and the report is sent according to schedule to a list of specific
emails. You want to schedule the same report to be sent to other emails:

1. Click Admin > Notifications > Entity Notification.
2. Select the relevant entity report, and click Edit.
3. In the Edit Notification dialog that appears, select the Recipients, test the report, or save.

UI Description
Entity Reports page
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

New Click to create a new report. The New Entity Report dialog box opens. For details,
see "New/Edit Entity Report dialog box" below.

Edit Click to edit the selected report. The Edit Entity Report dialog box opens. For details,
see "New/Edit Entity Report dialog box" below.

Duplicate Click to duplicate the selected report. The select report opens in the Edit Entity
Report dialog box. Modify the report and save.

Delete Click to delete the selected report.

Report
Name

The name of the report.

Description The description of the report.

Recipients The recipients of the scheduled report.

Schedule The date and time when the report is scheduled to run.

Status Active if the notification is activated or Inactive if the notification is deactivated.

Test report Click to test the report.

New/Edit Entity Report dialog box
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Report Name The name of the report.

Description The description of the report.

Entities The list of selected entities.

Click Browse to select the relevant entities.
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Select the relevant entities in the tree in the left side and use the arrows to
move the entities to theSelected Entities area.

Note: If you select an Objective, and all its KPIs aremoved to the
selected panel, you can then remove some of these KPIs by selecting
them in theSelected Entities area and using the back arrow.

Recipients Select the recipients of the scheduled email. You can enter additional emails
separated by commas (,) or click Browse to select more recipients.

Select the relevant recipients in the left side area and use the arrows tomove
the recipients to theSelected Recipients area.

You can also use the search feature.

You can also deselect recipients by removing them from theSelected
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Recipients area using the back arrow.

Schedule Select to send an email to the selected recipients once aDaily,Weekly, or
Monthly, at a specific time (24 hours format).

Click Add to addmore schedules.

Notification status Select Active to activate the notification or Inactive to deactivate the
notification.

Test report Click to test the report.

l The test report is as follows for Objectives and Scorecards:

The report displays the tree of child items of the selected item. For each
item in the tree, you can see the entity type (icon), the name of the entity,
the current value, the current period, the current status, the current trend,
the last calculation period, and the value during the previous period.

l The test report is as follows for a KPI:
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The report displays:
l The entity type (icon), the name of the entity, and the current period.

l The current value.

l The threshold, the current status, the current trend, the last period, and
the value during the last period.
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About Content Acceleration Packs (CAPs)
Content Acceleration Packs (CAPs) are ready-to-import packages that include Dashboard pages that
display Scorecards and components, KPIs, Metrics, Contexts (universes), data (from data sources),
and documentation for the CAP.

CAPs describe typical stories that show how the correct implementation of Executive Scorecard drives
Performance Improvement and Cost Reduction for the IT organization.

CAPs demonstrate Executive Scorecard capabilities, and helps you add basic elements that can be
used to customize your Dashboard.

For details about the Content Acceleration Packs (CAPs), see Content Acceleration Pack (CAP)
Management in theContent Acceleration Packs Guide.
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Partitioning
Partitioning provides a performance improvement for very large tables and indexes used in daily
operations performed by the allocation engine, the KPI Engine, and other queries.

Partitioning is triggered by the ETL.

Learn More
Partitioning in XS

XS expects tables to grow to hundreds of GB ormore. Such large tables cause performance issues are
they make it difficult to load andmanipulate data, to remove old data, and tomaintain indexes.

Partitioning tables and their indexes divides the object into smaller segments, so that maintenance
operations can be done on a single segment at-a-time, rather than on the entire table. Partitioning the
table can also automatically direct queries to the appropriate partition, which reduces the amount of
records to scan and speeds up the queries.

The tables that are partitioned by default are all the FACT tables in the Target database and the
SNAPSHOT tables in the Staging database.

Benefits

The benefits of using partitioning are:

l The SQL Server automatically manages the placement of data into the correct partition.
l The partitioning of tables and indexes is transparent to the application.
l The loading is faster and easier.
l The performance of the allocation engine, KPI engine, and other queries is improved.
l The Locks, Compressions and Read-Only are controlled at partition level.
Limitations

The limitations are:

l Towork with partitioning youmust install the SQLServer 2008 Enterprise Edition.
l XS supports amaximum of 1000 partitions per table.
l Partition Operations like (Split, Merge and Switch) can be blocked by other DataManipulation
Language (DML) statements like SELECT, UPDATE, or INSERT that are ran on the table at the
same time.

l Rebuilding Indexes cannot be implemented online, themain reason for that is that the whole table
will be locked during this action

l Once the partitioning column(s) is set, it is not possible to change it.
l Changing the sliding windows scenarios can be difficult.
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l Switch Partitionmainly for Archive proposes have to reside on the same database.
l In a CLUSTERED table, the Column PartitionMUST be part of Primary Key or CLUSTERED
INDEX.

Tasks

Deactivate Partitioning
Partitioning is activated by default.

To deactivate partitioning, proceed as follows:

1. In the Staging database, locate the Configuration table (for details, see "Configuration Table" on
page 221) and change theActivation Status from True to False.

2. In the Target database, locate the Configuration table (for details, see "Configuration Table" on
page 221) and change theActivation Status from True to False.

Reference
Partitioning New Objects

l Store Procedures

The XS Store procedures that are responsible for partitioning are as follows:
l CreateTBLPartition_P – This Store Procedure is responsible for converting existing
Tables/Indexes into Partition Objects. It is executed from Init DB, or from a customization script
in Upgrade. It reads the list of tables from the configuration table, and partitions the given table
and it indexes one by one.
Format:
CREATE PARTITION FUNCTION <TABLE_NAME>_PF AS RANGE RIGHT FOR VALUES
(List of Dates, or Integer Boundary)
CREATE PARTITION SCHEME <TABLE_NAME>_PS AS PARTITION TABLE_NAME>_PF
ALL TO (<FILE GROUP>)

Example

CREATE PARTITION FUNCTION NODE_FACT AS RANGE RIGHT FOR VALUES
(…’01-feb-2012’,’01-mar-2012’….)

o Partitioning indexes:
If Primary KEY exists, the procedure will drop it and recreate new clustered unique index
using the primary key plus the new partition column.
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Format:
DROP INDEX <Constraint_Name> ON <Table_Schema>.<Table_name>
WITH (Move To <PS_Name> (<Partition_Columns>))
For every existing index, it will add this partition column, and partition the index:
CREATE INDEX <Previous_Index_Name> ON <SCHEMA>.<TABLE_NAME> (List of
Columns) ON <Partition Scheme> (Partition Column)

l Check_Configuration_Partition_fnc – The function that checks and validates records in the
configuration_partition before starting the actual partitioning procedure. This function is the first
step of CreateTBLPartition_P.

l ADDPartition_P – The procedure adds a partition when needed, according to the partitioning
methods. It creates new Partitions for a givenObject that is already partitionned. It executes as
one of the last step in XS ETL run.
o Date_boundary
o Integer_Boundary
o Period_Boundry
If the SP fails it writes the errors into APPLICATION_ERROR_LOG table.

Note:

l Snapshots partitioning is done automatically. When each Staging ETLis running, the Create
Partitioning procedure is running. It searches for new Snapshots tables in Staging: if there
are new tables it will insert their names/details into the Configuration_Partition table.

l ForSnapshot_Boundary (TSNP, SSNP staging tables) the portioning is fixed (0-9 and A-
Z), so no need to add partition.

l For Snapshot with CSNP tables the partition column is MD_BUSSINES_KEY and the
partitioningmethod is Integer_Boundary.

l Tables

l Configuration_Partition – The configuration table that includes the list of candidates Objects for
partitioning.

l APPLICATION_ERROR_LOG – The auditing and error log table. The procedures above write
the errors into this table in case of failure.

Note:

l The tables above are created as part of the Init_DB orUpgrade processes.

l TheCreateTBLPartition_P andCheck_Configuration_Partition_fnc procedures are
executed at the last step in XS ETL run.

l Table Partitioning

XS partition supports (right now) four ways of partitioning, all RIGHT range partition:
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l Date Boundary Range

l Integer Boundary Range

l Period Boundary Range

l Snapshot Boundary Range – Fixed Range (0-9 , A-Z)

l Configuration Table

This table is provided out-of-the-box.

Column Name Description

Entity_Name Services, Person, Projects, SLA....

Entity_Type Target_core orSnapshot
Snapshots are located in staging DB(SSNP,TSNP)or in target
(CSNP)

Table_Name The name of the Partition Table.

Table_Schema dwt, dws, or itaapp

Partition_Method Date_Boundary, Integer_Boundary, Snapshot_Boundary,
Period_Boundary

Partition_Policy Date_Boundary (Month)
Integer_Boundary (NULL)
Snapshot_Boundary (NULL)
Period_Boundary (Month)

Partition_Columns MUST beDATETIME or Integer types

Amount_of_Records_Per_
Partition

Amount_of_Records_Per_Partition (minimum of 1,000,000)
Active only for Integer_Boundary

Retention_Policy In Days, how long to keep the data, default 36,525= 100 years

Partition_Status Normal - For new not partitioned tables.
Partitioned - For partitioned tables.

Activation_Status True. Continue the partitioning of the object. Default.
False. Stop the partitioning of the object.

Archive_Status This is for future use.
True. The table is to be archived.
False. The table is not to be archived. Default.
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4 Servers Configuration - Server
Connection
When you are configuring an allocation scenario and youmark it as Affect Dashboard, all the KPI
calculations based on the FinancialManagement context run on the allocated data.

Tomake sure that the data is extracted using the correct schema, when you work in a 4 Servers
configuration, youmust make sure that the server on which XS is installed and the server on which
DataWarehouse (DWH) is installed are connected via the network using port 10002.

In addition, youmust make sure that this setting (connection using port 10002) is reestablished every
time the session is restarted.

This connection enables the Dashboard to pull data from the COST_FACT_V view:

l Using the ITAAPP schemawhen theAffect Dashboard option has been selected for an allocation.
l Using the DWH schemas when theAffect Dashboard option has not been assigned.
For details about allocations, see AllocationManagement in the IT Executive Scorecard Financial
Analyst Guide.
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About KPI and Metric Data Lineage
The data lineage of a KPI or aMetric enables you to see, in graphical format, for a specific KPI or
Metric, the chain of entities, fields, views, tables, and contexts that are used to obtain data from the
data source, import it into the DataWarehouse, and calculate the value, status, and trend of the KPI or
Metric.

For details about the KPIs, Metrics, and their data lineages, see the IT Executive Scorecard Content
ReferenceGuide for the relevant data source.

HP IT Executive Scorecard (9.50) Page 223 of 342



Work with Enhanced Telecom Operations
Map KPIs
The eTOM (enhanced TelecomOperations Map), published by the TM Forum, is a guidebook that
defines themost widely used and accepted standard for business processes in the
telecommunications industry. The eTOMmodel describes the full scope of business processes
required by a service provider and defines key elements and how they interact. As a not-for-profit
organization, TM Forum is driven by a Board of senior executives from across the industry.

Learn More
More information about eTOM’s Business Metrics and Benchmarking Programs

Developed by service providers, for service providers, eTOM’s Business Metrics and Benchmarking
Programs define and gather quantitativemetrics ranging from tactical to business performance data
and conduct qualitative surveys on topics of service provider interest. There are two primary aspects to
Business Metrics Automation (BMA): Inclusion of the appropriate, standard eTOM Business Metrics in
products and systems used by service providers and support for the programmatic interface into the
Forum’s secure Benchmarking Database, via controlled, secure data transfer. Service providers can
also implement these aspects directly in their internal systems and can then work with the BMA
interface.

The following figure presents the complete set of eTOM Business metrics in release 5. The 2 groups
currently implemented in Executive Scorecardhave been highlighted.
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How does it work?

Formany service providers, the easier approach is simply to use products from suppliers who have
added the Business Metrics and BMA interface to their commercial off the shelf (COTS) products.
These products bear amark indicating that they have been tested for their inclusion of the appropriate
group of metrics (such as the set of revenue assurancemetrics for a revenue assurance product) and
the BMA interface functionality. Service providers can ensure consistent, accurate, and apples-to-
apples comparisons for both benchmarking studies and internal dashboards by procuring products with
TM Forum Business Metrics built in. eTOM’s Business Benchmarking Programmanages and delivers
metric-based business performance benchmarking studies on topics including Broadband, Mobile,
Business IP Services, and Self-Service.

HP IT Executive Scorecard is certified (from this version and above) in the following areas: Customer
Problem Resolution andService Problem Management.The certification provides a secure
interaction with the eTOM Business Benchmarking database, including uploading data for the specified
standardmetrics in the correct format, generating queries, and downloading the query results.
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HP IT Executive Scorecard offers the standardmetrics in the following areas: Customer Problem
Resolution andService Problem Management.

A special tool extracts the results from the eTOM-related KPIs from the Results database, the values
extracted aremapped to TM Forum business metrics and business metrics details.This information is
then structured as XML and changed into an XML file and the XML files are sent to the eTOM
Benchmarking database via the eTOM secureWeb Portal.

eTOM-Related KPIs Location in the Studio

After they have been imported, the eTOM-related KPIs are listed in the Active KPIs pane, in the
Industry StandardsScorecard, in the eTOM Perspective, and are distributed under two
Objectives: Customer Problem Resolution andService Problem Management.

Tip: Though these KPIs also appear by default in the KPI Template pane, it is recommended not to
drag and drop these KPIs from the KPIs Template pane to the Active KPIs pane to activate them,
because in such a case, the KPI Breakdowns do not appear in the Active KPIs pane and these KPI
Breakdowns are important for TMF. It is recommended instead to import the TMF-related tree of
Scorecards, Perspectives, Objectives, KPIs, and KPI Breakdowns directly as described below into the
Active KPIs pane.

eTOM-Related KPIs

A directory of XML files is available to be imported into the Studio to provide the relevant components
needed to create the corresponding eTOM-related KPIs.
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Each file corresponds to a KPI.

Data Displayed by the eTOM-Related KPIs

The data displayed by the eTOM-related KPIs is extracted from the Incident and Interaction Data in the
IT Infrastructures Library (ITIL) of HP ServiceManager related to SQM or CME.

Tasks
This section includes:

View the eTOM-Related KPIs in the Dashboard
1. Make sure that the integration with the HP Service Manager data source has been

performed

For details, see SM Data Source in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP ServiceManager.

2. Import Source Data using ETL tool

Import the source data into the Studio using the ETL tool. For details, see ETLManagement in the
IT Executive Scorecard Administrator Guide.

3. Import the TM Forum-related KPIs into the Active KPIs pane in the Studio

a. Copy the files from the <install-root>\tools\TMF\ContentApp directory in the Executive
Scorecard DVD to the following directory:
<HP_
XS>\agora\glassfish\glassfish\domains\BTOA\config\kpiconfiguration\import\load

b. Activate <HP_XS>\agora\jdk\bin\j-Console.exe.
c. Select Remote process and enter localhost:10008 in the field below.
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d. Click theMBeans tab.
e. Expand theKPILoader and click the importKPIs button. Close the j-Console.
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4. Calculate All Breakdown Paths

In the Active KPI Pane in the Studio, under the Industry Standards Scorecard, under the
TM Forum Perspective, the KPIs are distributed between the Customer Problem Resolution
Objective and the Service ProblemManagement Objective.

Click the TM Forum Perspective, and click and select the
Calculate now option, and in the Calculate now dialog box, select the ServiceDesk universe.
This operation calculates the values, statuses, and trends of all the KPIs and KPI Breakdowns as
well as the values of the related Objectives, Perspectives, and Scorecards and displays the
relevant data in the Dashboard.
For details on calculating KPIs, see Calculation.

5. Generate XML Data and Send the Data to the BMA Portal for Certification

a. Set the XS server information and BMA web service information in the
xmlTemplateConfig.properties file. The file is used to store information about the XS server
and the BMA web service.

#CPR --- Customer Problem Resolution
CPR = CPR-BB-Max-Data,CPR-IP-Min-Short-Data
CPR_Data = CPR-BB-Max-Data,CPR-IP-Min-Short-Data
CPR_App = CPR-BB-Max-App,CPR-BB-Min-App
#SPM --- Service Problem Management
SPM = SPM-BB-Max-Data,SPM-IP-Min-Short-Data
SPM_Data = SPM-BB-Max-Data,SPM-IP-Min-Short-Data
SPM_App = SPM-BB-Max-App,SPM-BB-Min-App
#All metric names - the names of the separate Metric XML files that are
created by the import operation.
#batch file and that are sent to the BMA site.
Metric_All = CPR-BB-Max-Data,CPR-IP-Min-Short-Data,CPR-BB-Max-App,CPR-BB-
Min-App,
SPM-BB-Max-App,SPM-BB-Max-Data,SPM-BB-Min-App,SPM-IP-Min-Short-Data
#Periods (Don't change the Periods name) - The periods for which you want to
calculate the metrics.
Periods = FY2011/04(Apr),FY2011/05(May),FY2011/06(Jun)
#Logon TMF info (Don't change the key name) - the username and password are
provided by BMA: #BMA WS
logon name:
ws_name = xyz
#BMA Web Service logon password:
ws_password = xyz
#BMA Web Service URL:
ws_url = http://
#BMA Web Service port:
ws_port =
# The host name of the XS Server:
server = xyz
# The port of the Executive Scorecard server:
port = 10004
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b. For eachmetric group, generate the relevant XML file based on the templates using the
command:
java -jar BMA_16.jar <metric_group_code> <research_stream> 0
wheremetric_group_code can be:
o CPR - Customer Problem Resolution
o SPM - Service ProblemManagement
and <research_stream>. For certification, TM Forum has defined Research Streams which
corresponds to different types of industry. Current research streams are:
o BB (Broadband) - Includes xDSL, cable fiber and satellite.
o Mobile - Includes 2G, 3G and 4G. It represents network equipment used to be provide the

service.
o IP - IP Business Services.

Example java -jar BMA_16.jar CPR BB 0

c. For eachmetric group, send the relevant XML file to the BMA web service using the
command:
java -jar BMA_16.jar <metric group code> BB 1

Example java -jar BMA_16.jar CPR BB 1, where CPR represents the Customer Problem
Resolutionmetric group and BB means Broadband.

6. Check Certification Results in BMA Portal

Access the BMA portal and check the certification results.
A typical certification results screen is as follow:
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The failed tests in the above picture, are due to optional (Extended) Business Metrics not
supported by HP ServiceManager.

7. View the eTOM-Related KPIs in the Dashboard

Create a page in Dashboard to display components that include the eTOM-Related KPIs. For
details, see Page Layout and Components.

Example

Click the or to display the tooltip of the Objective and click the relevant KPI or KPI
Breakdown.
The EXPLORER tab opens and displays the KPI or KPI Breakdown details:

For details about the EXPLORER tab, see Explorer

Reference

eTOM-Related KPIs
Customer Problems Resolution

TheMetric IDs are standard in eTOM.
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Metric ID KPI Name Description

A-CE-2a Incident Closure Time KPI Time for resolving incidents (customer contact through
informing customer of resolution) / total number of
incidents resolved.

1. By Problem Severity: Critical, Major, Minor (3)
(Optional)

A-CE-2b Mean Time ToResolve
Customer Incident KPI

Time for resolving incidents (customer contact through
informing customer of resolution) / total number of
incidents resolved.

1. By Customer Segment: Consumer & SME, Large
Enterprise & Government (2) (Optional)

2. By Service Component: Voice Services, Data
Services (2) (Optional)

A-CE-4a % of Incidents Reported
More ThanOnce By
Customer KPI

Number of incident re-reports / total number of customer
reported incidents

1. By Customer Segment: Consumer & SME, Large
Enterprise & Government (2) (Optional)

A-CE-4c % Of Problems Reported
By Customers KPI

Total number of problems reported by CUSTOMERS /
Total number of problems reported

1. By Problem Severity: Critical, Major, Minor (3)
(Optional)

A-OE-3b % Maintenance Time
Used For Repair KPI

Repair time / Total assurance time (Maintenance +
Repair)

Service Problem Management

TheMetric IDs are standard in TM Forum.

Metric ID KPI Name Description

A-CE-2c % Of Problems
Resolved By
DueDate KPI

Number of problems resolved to customer satisfaction by
committed date / total number of problems occurring during the
reporting period

A-CE-4c % Of Problems
Reported By
Customers KPI

Total number of problems reported by CUSTOMERS / Total
number of problems reported

1. By Problem Severity: Critical, Major, Minor (3) (Optional)

A-OE-2a Service Problem
Resolution Time
KPI

Aggregate time to resolve SO service problems for AssuranceMeta
Process Blocks (1-4) inclusive / number of closed problem reports

1. By Problem Severity: Critical, Major, Minor (3) (Optional)

2. By Customer Segment: Consumer & SME, Large Enterprise &
Government (2) (Optional)

Administrator Guide
Work with Enhanced TelecomOperations Map KPIs

HP IT Executive Scorecard (9.50) Page 232 of 342



Metric ID KPI Name Description

A-OE-2b Mean Time To
Resolve Service
Problems KPI

Time to resolve SOService Problems by process block (Meta
Blocks 1-4) / Number of Service Problems closed within period

1. By META process blocks: resource data collection and
processing, service problemmanagement, resource trouble
detection/handling, customer QoS/SLA management (4)

2. By Customer Segment: Consumer & SME, Large Enterprise &
Government (2) (Optional)

3. By Problem Severity: Critical, Major, Minor (3) (Optional)

A-OE-3a % of Problems
By Cause Type
KPI

Number of problem reports of type X / Total number of problem
reports

1. By Cause Type: customer caused, technology caused,
workforce caused, datamismatch problems for internal systems,
other (5)

A-OE-3b % Maintenance
TimeUsed For
Repair KPI

Repair time / Total assurance time (Maintenance + Repair)

A-OE-3c Mean Time
Between
Failures KPI

((Revenue System Size) - (MTTR*number of trouble tickets closed
inmonth)) / number of trouble tickets closed inmonth

A-OE-6a NOC FTE
Efficiency KPI

Total Number of problem reports resolved / Total number of NOC
FTEs working on problem resolution
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Localization and Globalization
You can localize and globalize Executive Scorecard. The user interface of HP Executive Scorecard
supports multiple languages.

Tasks
• Localize the out-of-the-box KPI Library pane contents 234
• Localize the out-of-the-box Dashboard content (pages and components) 235

Localize the out-of-the-box KPI Library pane
contents
The localized installation adds the language libraries of XML files in specific directories. You copy and
then import these files to display the out-of-the-box template Scorecards, Perspectives, Objectives,
Folders, and KPIs in the KPI Library in the selected language.

To localize the out-of-the box content of the KPI Library: Scorecards, Perspectives, Objectives, and
KPIs, proceed as follows:

1. In the Executive Scorecard server, locate the
<HP_XS>\agora\glassfish\glassfish\domains\BTOA\config\
kpitemplates\import\languages\<language_code>_<country_code> directory relevant for the
language you want to use in the application. The .xml files in the directory represent both KPIs and
KPI directories.
The language code and country codes are as follows:

Language Language Code Country Code

Brazilian Portuguese pt BR

French fr FR

Spanish es ES

German de DE

Japanese ja JP

English en US

Dutch nl NL
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Language Language Code Country Code

Italian it IT

Simplified Chinese zh CN

Korean ko KR

Russian ru RU

Turkish tr TR

2. Copy these .xml files to the <HP_
XS>\agora\glassfish\glassfish\domains\BTOA\config\kpitemplates\import\load directory.

Tip:

If the directory contains other sets of files (for different languages), it is recommended to keep
in the directory only the required set of language files and tomove the other files outside the
directory to prevent the loading of both set of language files and an unknown result.

3. Import the out-of-the-box language files using theKPILoader > importKPIs() procedure
described in "Migrate Trees, Metrics, and Unassigned KPIs" on page 251in the IT Executive
Scorecard Administrator Guide.

Localize the out-of-the-box Dashboard
content (pages and components)
The localized installation adds the language libraries of XML files in specific directories. You copy and
then import these files to display the out-of-the-box template pages and components in the selected
language, in the Dashboard.

To localize the out-of-the box pages and components, proceed as follows:

1. Prerequisite
You have performed the installation and post-installation procedures or the upgrade to the current
version.

2. Copy the libraries
a. In the Executive Scorecard server, locate the

<XS server>\agora\glassfish\glassfish\domains\BTOA\config\
uimashup\import\languages\<language_code>_<country_code> directory relevant to the
language you want to install. These .uim.xml files represent the components and the pages
used in the Dashboard.

b. The language code and country codes are as follows:
o Components_<lang>_<country_code>.uim.xml
o Pages_<lang>_<country_code>.uim.xml,
where lang is the language code and country_code is the code of the country:
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Language Language Code Country Code

Brazilian Portuguese pt BR

French fr FR

Spanish es ES

German de DE

Japanese ja JP

English en US

Dutch nl NL

Italian it IT

Simplified Chinese zh CN

Korean ko KR

Russian ru RU

Turkish tr TR

c. Copy these files to the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\
import\toload directory.
Tip:

If the directory contains several sets of files (for different languages), it is recommended
to keep in the directory only the required set of language files and tomove the other files
outside the directory to prevent the loading of both set of language files and an unknown
result.

d. Import the out-of-the-box language files (only for the pages and components - events are
not localized) using the relevant procedure described in "Migrate User-defined Pages or
Components" on page 254 in the IT Executive Scorecard Administrator Guide.
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Enterprise Readiness (ER) Tools
The ER tools provide better manageability and awareness of processes in the system, and enable you
to clean problematic entities or all data, as well as re-stream existing data with problematic logic
according to batch or specific date. The Restream and CleanData streams are hidden by default.
However, they can bemanaged, as any other stream, in the ETLManagement tab.

When you have specific KPI and data problems in Executive Scorecard, or after you run the ETL,
check the Target tables for any issues. If you find a problem with specific entities, note the specific
batch ID or the specific load date in the Target tables. Depending on the issue, you will need to either
clean or restream the data to fix the issues.

To access:

To access the CleanData and Restream streams, click Admin > ETL Management and select the
Show Hidden Streams checkbox.

For ETL stream details, see " ETLManagement " on page 159.

Learn More
CleanData

Note: The CleanData stream is an advanced ETL tool. Running the CleanData stream erases all
existing data in the Staging tables.

CleanData does not clean historical data in the Target tables.

The DW ABC Streams Management User Interface enables you to clean corrupted data by specific
criteria and then reload data from the source by running the Upstream ETL stream.

CleanData is used to enable the data in DWH to be restored to a specific version, as follows:

l CleanData by batch, entity or all entities.
l CleanData by date, entity or all entities.

Note: Running the CleanData streammay not recover all existing data.

Restream

The DW ABC Streams Management User Interface enables you tomanage re-streaming the entire
ETL loading process. This functionality allows you to re-stream the entire ETL stream from a previous
batch to the latest batch, as well as revise incorrect data in the DWH Target.

Restream is used to re-stream the entire ETL loading from a specific batch point to the latest point, as
follows:

l Re-stream by batch, entity or all entities.
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Command Line Interface Tool

To run the ER tools in ETLManagement youmust first use command line batch files to set the stream
parameters. The two batch files are found in the DWH/bin directory.

The log information is inDWH/log/dw_abc.log.

The log level can bemodified inDWH/conf/abc-log4j.xml.

Note: The arguments are populated into an ABC table called CONTROL_ARGS. If there are
unexecuted commands in CONTROL_ARGS, the batch files cannot insert new records into the
CONTROL_ARGS table.

CleanData Command

dw_abc_cleandata

[-batch <batch_id>] [-entity <entity_name>] [-inputdate <input_date_of_batch>] [-display] [-delete] [-
help]

Options:

l -batch: The batch ID of the point in DWH from which you want the data to be cleaned.

Example If the DWH system has 5 batches, and the problem is with batch 2, then it will delete
batch numbers 2, 3, 4, and 5.

l -entity: Themodel name of the entity that you want cleaned.
l -inputdate: The date of the restore point in DWH from which you want data cleaned.
l -display: Display all existing commands.
l -delete: Delete the unexecuted commands.
l -help: Print the helpmessage.

Example

dw_abc_cleandata -batch 1 -entity LOCATION
dw_abc_cleandata -batch 1 -entity LOCATION,SERVICE,ORG
dw_abc_cleandata -batch 1 -entity ALL
dw_abc_cleandata -inputdate 2012-09-30 -entity LOCATION,SERVICE,ORG
dw_abc_cleandata -inputdate 2012-09-30 -entity ALL
dw_abc_cleandata -help
dw_abc_cleandata -display
dw_abc_cleandata –delete

Returns:

l 0 success
l 1 success with warnings
l >1 errors present

Restream Command:

dw_abc_restream
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restream. bat [–batch <batch_id>] [-entity <entity_name>] [-full <full_restream>] [-display] [-delete] [-
help]

Options:

l -batch: The batch ID of the point in DWH from which you want the batch re-streamed.

Example If the DWH system has 5 batches, and the problem is with batch 2, then it will re-
stream batch numbers 2, 3, 4, and 5.

l -help: Print the helpmessage.
l -entity: Themodel name of the entity you want re-streamed.
l -full: The flag of the re-stream indicator that allows only re-streaming the error data from the VALF
table when it is equal to N, otherwise it re-streams all data.

l -display: Display all existing commands.
l -delete: Delete the unexecuted commands.
l -help: Print the helpmessage.

Example

dw_abc_restream -batch 1 -entity LOCATION -full Y
dw_abc_restream -batch 1 -entity LOCATION,SERVICE,ORG -full Y
dw_abc_restream -batch 1 -entity ALL -full Y
dw_abc_restream -batch 1 -entity LOCATION -full N
dw_abc_restream -batch 1 -entity LOCATION,SERVICE,ORG -full N
dw_abc_restream -batch 1 -entity ALL -full N
dw_abc_restream -help
dw_abc_restream -display
dw_abc_restream –delete

Returns:

l 0 success
l 1 success with warnings
l >1 errors present

Tasks
This section includes:

• Utilize the Restream or CleanData streams 240
• Display hidden streams 240
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Utilize the Restream or CleanData streams
1. Run the following command line batch files found in the DWH/bin directory to set the stream

parameters.
dw_abc_cleandata
dw_abc_restream

2. After you run the command line batch files, access the ER tools and run the Restream or
CleanData streams.

Display hidden streams
1. Select Admin > ETL Management and select Show Hidden Streams.
2. The hidden ETL streams are displayed.
3. You can then schedule the batches, as needed.

4. Click to load and run the batch.

5. Click to refresh and check the running status of the ETL.
6. Once the ETL is running successfully, re-run the Upstream stream.

For ETLManagement details, see " ETLManagement " on page 159.

UI Description
DW ABC Streams Management
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<Stream Display>

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

<Stream
Information>

Displays the following stream details:

l Stream Name
l Status: Active or Suspended or None
l Duration
l Date

Show Hidden
Streams

Click to display the hidden ETL streams.

Refreshes the stream information. There is an automatic refresh of the stream
information every twominutes.

More Info Opens the Stream Attributes dialog box. For details, see "Stream Attributes
Dialog Box" on page 166

Load Batch/Resume. Starts or resumes the running of the specific batch of
ETL stream.

Opens the Stream Scheduler dialog box. Enables you to schedule the load
batch and run_steps commands. For details, see "Stream Scheduler Dialog
Box" on page 169.
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UI Element Description

Suspend Stream. Temporarily suspends the stream.

Abort Stream. Stops the stream that is running.

<Node Display> Displays the nodes representing the groups of steps within one level of
execution of an ETL run, the steps that can run in parallel. A node is a collection
of steps that all run in parallel. The icon for each node represents the worst
status of all of the steps in the node.

Indicates that the particular step or all steps in the node have finished
successfully in the execution.

Indicates that a step or a step in the node is currently running

Indicates an error in one of the steps. The step is automatically retried
four times by default.

Click the Error node to display the Node Step List in order to retry steps. Click

to retry the step.

Indicates a warning in one of the steps.

Click a node to open the Node Step list.

If there is an error in any of the steps, then all steps in the execution of the
stream are stopped. In order to move to the next node, the error must be
resolved.

Click More Info to display the Step Details dialog box pertaining to the
particular step. For details, see "Step Attributes Dialog Box" on page 168.

For more details onmanaging ETL streams, see " ETLManagement " on page 159.
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Migrate from Development or Test
Environment to Production
This section lists the tasks involved inmoving from aDevelopment or Test environment to a
Production environment.

This section includes:

• Change Data Sources 244
• Restore from Backup 245
• Migrate the Data Services 246
• Activate the Data Sources 247
• Run the ETLs to Pull Data from the Data Sources 248
• Migrate contexts 249
• Migrate Data Imported using .CSV files 250
• Migrate Trees, Metrics, and Unassigned KPIs 251
• Migrate Scorecards, Perspectives, Objectives, Metrics, and KPIs 252
• Export nodes using CAPs 252
• Import nodes using CAPs 253

• Migrate User-defined Pages or Components 254
• Migrate user-defined Dashboard pages and components, and events 255
• Export user-defined pages and components and eventsusing CAPs 255
• Import user-defined pages and components and events using CAPs 255

• Perform the calculation 257
• Calculate for the current period 257

• Migrate the SAP BusinessObjects Enterprise reports and BIAR files 259
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Change Data Sources
If you changed one or more of the data sources (for examplemoving from one version of a data source
to a higher version of the data source in the Development or Testing environment, youmust modify the
data source settings in the Data SourceManagement page in the Production environment. Click
Admin > Data Source Management andmake your changes.

For details, see "Data SourceManagement" on page 131.
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Restore from Backup
To restore your system from backup follow the backup instructions. For details, see "Executive
Scorecard Back Up " on page 268.
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Migrate the Data Services
SAP BusinessObjects Data Services is the access mechanism that performs the physical data
extraction from the source repository to the staging database. Each stage of the ETL is embodied in a
Data Services job, from the extraction of source data to the target database.

Tomigrate the Data Services from the Development/Testing environment to the Production
environment:

1. In the Development/Testing environment, export the Data Services files using the dw_etl_export
command. For details, see "dw_etl_export" on page 313.

2. In the Production environment, import the Data Services files you exported, using the dw_etl_
import command. For details, see "dw_etl_import" on page 314.
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Activate the Data Sources
In the XS application , activate the relevant data sources:

1. Select Admin > Data Source Management.
2. The Data Sources page opens. Click theActivate button for the relevant data source.
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Run the ETLs to Pull Data from the Data
Sources
In the Production environment, run the relevant ETLs to pull data from the data sources.

For details, see " ETLManagement " on page 159.
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Migrate contexts
Tomigrate the contexts, proceed as follows:

1. Prerequisite:Make sure your schemas are the same in the Development or Testing environment
and in the Production environment.

2. Create a CAP that only includes the contexts you created or modified in the Development or
Testing environments. For details, see Create a CAP with the Executive Scorecard application
data.

Note: You canmigrate Contexts, trees, KPIs, Metrics, user-defined pages, or components
using one CAP per type of item or one CAP for all the items you want to
export/import/migrate.

Note: You can select to perform a recalculation during the CAP activation by specifying a
recalculation date when you create the CAP.
You can also perform the calculation after all the items aremigrated. For details, see "Perform
the calculation" on page 257.

3. Export the CAP you created. For details, see Download a CAP to the user's local system.
4. Copy the CAP you downloaded from the Development or Testing environment to the Production

environment or from the user's local system to the system where you want to import the item.
5. Upload the CAP to the Production environment. For details, see Upload a CAP from the user's

local system to the Executive Scorecard application.
6. Activate the CAP inAdmin > Content Acceleration Pack. For details, see Activate a CAP.
7. Verify the upload by accessing the contexts inAdmin > Semantic Layer. For details, see View

existing out-of-the-box Contexts (universes).

Note: If the context you import already exists in the Production environment, it is deleted and
replaced by the context imported using the CAP.
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Migrate Data Imported using .CSV files
Tomigrate data imported into Executive Scorecard using .CSV files, proceed as follows:

1. Create a CAP that only includes the contexts used to import the .CSV files you created or
modified in the Development or Testing environments. For details, see Create a CAP with the
Executive Scorecard application data.

Note: You canmigrate Contexts, trees, KPIs, Metrics, user-defined pages, or components
using one CAP per type of item or one CAP for all the items you want to
export/import/migrate.

Note: You can select to perform a recalculation during the CAP activation by specifying a
recalculation date when you create the CAP.
You can also perform the calculation after all the items aremigrated. For details, see "Perform
the calculation" on page 257.

2. Export the CAP you created. For details, see Download a CAP to the user's local system.
3. Copy the CAP you downloaded from the Development or Testing environment to the Production

environment or from the user's local system to the system where you want to import the item..
4. Upload the CAP to the Production environment. For details, see Upload a CAP to the Executive

Scorecard application.
5. Activate the CAP inAdmin > Content Acceleration Pack. For details, see Activate a CAP.
6. Verify the upload by accessing the contexts inAdmin > Semantic Layer. For details, see View

existing out-of-the-box Contexts (universes).
7. Reimport the data by accessing the relevant context inAdmin > Semantic Layer. For details,

see Semantic Layer - Context Management.
8. Perform the calculation for the relevant contexts in the Studio. For details, see Calculation in the

IT Executive Scorecard Business Analyst Guide.

Note: If the context you import already exists in the Production environment, it is deleted and
replaced by the context imported using the CAP.
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Migrate Trees, Metrics, and Unassigned KPIs
You can export complete trees (with their Scorecards, Perspectives, Objectives, and KPIs) from the
Active KPIs pane.

You can import existing template trees or sub-trees, active trees, active sub-trees, Metrics, or
Unassigned KPIs into the Active KPIs pane.

The import or export flows aremeant to be used whenmoving from staging to production and not as a
way to update system configuration. If you want to use the import or export flows to update the system
configuration, youmust delete all the nodes in the active KPIs pane, before performing the import
operation.

The export and import flows are alsomeant to be used for localization purposes, when you want to
work with other languages than English.

Learn More
About Exporting or Importing Trees

You use the export or import feature when you want to import or export out-of-the-box templates,
automatically update existing templates, or import new templates, or active trees into the Executive
Studio.

The export and import feature is the process used tomove from staging environment to production.

The export feature collects the contents of the Active KPIs tree (Scorecards, Perspectives,
Objectives, KPIs, Metrics, and Unassigned KPIs). It converts the contents to a configuration.xml file
that describes the structure of the active tree or to a <Scorecard_name>.xml file for each Scorecard.
These files include the UUID, KPI name of the KPIs, andMetrics name of theMetrics included in the
trees. In addition, the process creates a <kpi_or_metric_name>.xml file per KPI or Metric in the
system; that file describes the configuration of the KPI or Metric. The XML files are created in a specific
directory on themachine.

The import feature collects the content of a specific directory on themachine. The directory can include
configuration.xml files, and <kpi_or_metric_name>.xml files according to the same format used by
the export feature or can include .xml files with other names. The import feature uses these files to
upload the information in the specific area in the Active KPIs tree.

The export and import operations work with XML files with a specific structure. Each configuration.xml
file includes information about the hierarchy from the lowest node to the tree root. That information is
used to add the new node is added to the relevant location in the relevant tree, or the imported node
overrides the relevant node. Each <KPI_or_Metric_name>.xml file includes information about the KPI
or Metric configuration. That information is used so that the relevant configuration and calculation
details are added to the relevant KPI or Metric.

The export operation uses the KPI or Metric UUID to identify the KPI or theMetric.
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In addition, you can import KPIs from Excel files. You can use this capability to import KPIs without
consideration about their location in the tree. You can also create an .xml file that provides information
about a tree structure and that refers to KPIs that are imported from the Excel file. The import feature
uses these files to upload the information in the specific area in the Active KPIs tree.

Note:  When the server on which the Executive Studio is located starts, if the system detects files
in the
<XS_server>\agora\glassfish\glassfish\domains\Config\KPI Template\ Import directory, it
automatically uploads that information. This feature is used when you log on to the Executive
Studio for the first time, to upload the out-of-the-box templates.

Tasks
This section includes:

• Migrate Scorecards, Perspectives, Objectives, Metrics, and KPIs 252
• Export nodes using CAPs 252
• Import nodes using CAPs 253

Migrate Scorecards, Perspectives, Objectives, Metrics,
and KPIs
Export complete trees (with their Scorecards, Perspectives, Objectives, and KPIs), Metrics, or
Unassigned KPIs from the Active KPIs pane of the Development/Test environment. For details, see
"Export nodes using CAPs" below.

Import these template trees or sub-trees, active trees, active sub-trees, Metrics or Unassigned KPIs
into the Active KPIs pane of the Production environment. For details, see "Import nodes using CAPs"
on the next page.

Export nodes using CAPs
To export nodes and hierarchical structure (trees and their Scorecards, Perspectives, Objectives, and
KPIs, Unassigned KPIs or Metrics), proceed as follows:

1. Create a CAP that only includes the items you want to export. For details, see Create a CAP with
the Executive Scorecard application data.

Note: You canmigrate Contexts, trees, KPIs, Metrics, user-defined pages, or components
using one CAP per type of item or one CAP for all the items you want to
export/import/migrate.

Note: You can select to perform a recalculation during the CAP activation by specifying a
recalculation date when you create the CAP.
You can also perform the calculation after all the items aremigrated. For details, see "Perform
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the calculation" on page 257.

2. Export the CAP you created to the user local system. For details, see Download a CAP to the
user's local system.
You can now copy the CAP to the another server (for example to the Production server) and then
import it into the application. For details, see "Import nodes using CAPs" below.

Import nodes using CAPs
To import nodes, proceed as follows:

1. Copy the relevant CAP from the Development or Testing environment to the Production server or
from the user's local system to the system where you want to import the item.

2. Upload the CAP to the application. For details, see Upload a CAP from the user's local system to
the Executive Scorecard application.

3. Activate the CAP inAdmin > Semantic Layer. For details, see Activate a CAP.
4. Verify the upload by accessing Studio and checking that all the items you wanted to import appear

in the Active KPIs.
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Migrate User-defined Pages or Components
You can export or import user-defined pages and components from or into the Dashboard page.

You use the import or export flows for localization purposes (when you want to work with other
languages than English) or whenmoving from staging to production and not as a way to update system
configuration.

Learn More
About importing or exporting user-defined Pages and Components

Pages are available or created in the Dashboard. Pages can include components. Components in a
page can be wired and can interact with each other using events. For details, about the Dashboard, see
Dashboard Display in the IT Executive Scorecard Business Analyst Guide.

The export operation collects the contents of user-defined pages and components. It converts the
contents to components.uim.xml, and pages.uim.xml files that describes the structure and content
of the pages and components . These files include the universally unique identifier (UUID) of the pages
and components.

The export operation uses the page and component UUID to identify the page or component .

The import operation collects the contents of a specific directory on themachine. The directory can
include components.uim.xmland pages.uim.xml files according to the same format used by the
export feature. The import feature uses these files to upload the information into the database. After the
import operation, the file is moved to the Loaded directory if the import operation succeeds, or to the
Errors directory if the import operation fails.

Note:  When the server on which the Dashboard is located starts and detects files in the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\uimashup\import\toload directory, it
automatically uploads that information.

Tasks
This section includes:

• Migrate user-defined Dashboard pages and components, and events 255
• Export user-defined pages and components and eventsusing CAPs 255
• Import user-defined pages and components and events using CAPs 255
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Migrate user-defined Dashboard pages and
components, and events
1. Export user-defined pages and components from the Dashboard page of the Development/Test

environment. For details, see "Export user-defined pages and components and eventsusing
CAPs" below.

2. Import these user-defined pages and components into the Dashboard page of the Production
environment. For details, see "Import user-defined pages and components and events using
CAPs" below.

Export user-defined pages and components and
eventsusing CAPs
To export user-defined pages and components , proceed as follows:

1. Create a CAP that only includes the user-defined pages and components you want to export. For
details, see Create a CAP with the Executive Scorecard application data.

Note: You canmigrate Contexts, trees, KPIs, Metrics, user-defined pages, or components
using one CAP per type of item or one CAP for all the items you want to
export/import/migrate.

Note: You can select to perform a recalculation during the CAP activation by specifying a
recalculation date when you create the CAP.
You can also perform the calculation after all the items aremigrated. For details, see "Perform
the calculation" on page 257.

2. Export the CAP you created to the user local system or to the Production environment. For details,
see Download a CAP to the user's local system.
You can now copy the CAP to the another server (for example to the Production environment) and
then import it into the application. For details, see "Import user-defined pages and components and
events using CAPs" below.

Import user-defined pages and components and
events using CAPs
To import user-defined pages and components , proceed as follows:

1. Copy the relevant CAP from the Development or Test environment to the Production environment
or from the user local system to the server where you want to import the items.

2. Upload the CAP to the application. For details, see Upload a CAP to the Executive Scorecard
application.
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3. Activate the CAP inAdmin > Semantic Layer. For details, see Activate a CAP.
4. Verify the upload by accessing the Dashboard and checking that all the user-defined pages and

components that you wanted to import appear in the Dashboard.
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Perform the calculation
In the Production environment, perform the calculation to populate the KPIs, Objectives, Perspectives,
Scorecards, and Dashboard pages with data.

Note: You can select to perform a recalculation during the CAP activation by specifying a
recalculation date when you create the CAP.
You can also perform the calculation after all the items aremigrated. For details, see "Perform the
calculation" above.

Tasks

Calculate for the current period
When you change the definition of a KPI (formula or threshold), the change impacts the KPI's value and
impacts the Objectives related to the KPI. Youmay want to perform the calculation for each KPI in the
selected business context for the period specified in the KPI configuration, so the impact of the change
is felt immediately in the results displayed in the Dashboard.

To calculate the current data:

1. In the Active KPIs pane, click theCalculation options button in the Active KPIs toolbar, and

select the option.
2. In the Calculate Now dialog box that opens:

l InUniverse/context for recalculation, select the relevant context (data source) you want to
use for the recalculation.

l Select the I understand the implications of this process and would like to proceed with
the calculation option to proceed with the calculation.

Limitations: You perform the calculation for the current period of each KPI within the selected
business context.

3. Click Calculate.
4. Select the I understand the implications of this process and would like to proceed with the

calculation option to proceed with the calculation.
The calculation is performed for all KPIs andObjectives with the selected context (universe).

Note:

l The calculation deletes the data that was available for the same period as the period selected
for the calculation.
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l No backup is available.

For details, see Calculation in the IT Executive Scorecard Business Analyst Guide.
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Migrate the SAP BusinessObjects Enterprise
reports and BIAR files
You export the relevant BIAR files from the Development/Test environment, and then import it in the
Production environment.

Tasks
1. Export BOE data to BIAR file

a. Open Import Wizard under BusinessObjects 3.1 of the Development/Test environment.
Click Next.

b. TheSource environment page of the Import Wizard opens. Select your BOE source and
enter the CMS Name, User Name and Password. Click Next.

c. TheDestination environment page opens. Select the relevant BIAR file option from the

Destination list. Click and select the file name and location of the BIAR file. Click
Next.
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d. TheSelect objects to import page opens. Click Clear All and select the options as shown
below:
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e. Click Next until the Folders and objects page opens and check the relevant directories and
object:

f. Click Next until the Import options for universes and connections page opens and select
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the 3rd option:

g. Click Next until theUniverses directory and universes page opens and select the relevant
universes (universes related to objects selected before are automatically checked):
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h. Click Next until theReady to import page opens, where you can see what is included in the
BIAR file and if the content is OK, click Finish.
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i. The creation of the file begins. When it is completed, click Done orView detail log to see the
list of objects that were not transferred and the reason why, and then click Done.

2. Import data from BIAR file to BOE system
In the BusinessObjects 3.1 of the Production environment proceed as above but with the source
being the BIAR file and the destination being the existing BOE installation.
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Data Warehouse Back Up
It is critical that you backup DataWarehouse so that you can rebuild your DataWarehouse
infrastructure and content in disaster scenarios such as the following:

l In a total disaster recovery scenario.
l The RDBMS server failed but all Executive Scorecard component servers are fully functioning.
l When the DataWarehouse server failed, but the RDBMS server and its databases are intact.
l When aDataWarehouse database is corrupt.
l When an ETL is deleted.
l When an ETL job fails.
This section includes:

l "What to Back Up" below
l "General BackupGuidelines" on the next page
l "Files to Back Up" on the next page

What to Back Up

It is strongly recommended that you back up the following resources that may be used if one of the
above scenarios occurs.

1. Microsoft SQL Server 2008 enterprise SP2 databases
a. Target database
b. SAP BusinessObjects Data Services database
c. SAP BusinessObjects CMS database, and if necessary the Audit database.
d. Management database
e. Executive Scorecard database

Note: The host and database names can be found in theManagement database
configured in the Executive Scorecard Configuration wizard.

2. Staging database
3. It is highly recommended that you keep the passwords for the Staging, Target and SAP

BusinessObjects Data Services database logon users in a safe place for usage in disaster
recovery situations.

4. External source files that can be found in the external source file location configured in the
Executive Scorecard Configuration wizard.
a. If the default external source file location was configured in the wizard, the Content Pack flat

files created during the ETL process can be found in: 
<Installation Directory>\agora\DataWarehouse\ExternalSources\<Content pack name>

Example The BSM content pack flat file would therefore located in the following

HP IT Executive Scorecard (9.50) Page 265 of 342



directory:
<Installation Directory>\agora\DataWarehouse\ExternalSources\BSM

5. DataWarehouse Configuration files.

General Backup Guidelines

It is recommended that you use the following backup and restore guidelines:

l A best practice for data warehouse administrators is to back up critical data on a regular basis.
l Database backups should consist of a weekly full database backups, and daily differential backups.
l Backups should be periodically verified by restoring a copy onto a test system.
l External source files and DataWarehouse configuration files should be backed up as required.
l Although out of scope for this document, regular backups should be taken of all source databases.
l Start scheduled backups before running the daily ETLs.
l Use backup compression.
l Perform full backups in off-peak times.
l Maintain the External Source Directory.
In the <ExternalSource> directory , there are folders that contain extracted data from each data
source.
This data is infinitely accumulated and is never cleaned by the DataWarehouse. You are required to
periodically backup and remove old files from those folders in order to free disk space if available
disk space is low on the DataWarehouse platform machine.

Files to Back Up

The contents of the following directories and their sub-directories should be included in the backup
schedules:

Directory Name Backup Frequency
Description
of files

<HP_
XS>\Agora\DataWarehouse\<ExternalSourceslocation>

Daily .xls, and the
ETL flat files

<HP_XS>\Agora\DataWarehouse\Conf When configuration
changes aremade

Configuration
files

<HP_XS>\Agora\DataWarehouse\etc After the installation, and
when configuration
changes aremade.

When you recover from a
DataWarehouse server
failure, it is important that
this directory and it's sub-
directories are restored.

Configuration
files
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<HP_XS>\Agora\DataWarehouse\log Daily Log files

<HP_XS>\Agora\ContentPacks Before activating or
deactivating a content
pack in the Executive
Scorecard Admin
application, or when
changes aremade to
content packs

Content pack
configuration
files

<HP_XS>\Agora\DataWarehouse\etc\ABC
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Executive Scorecard Back Up
It is critical that you backup your databases, configuration files, logs and configuration settings so that
you can rebuild your IT Executive Scorecard solution and content in circumstances such as the
following:

l When you need to recover from a total disaster recovery scenario.
l The RDBMS server failed but all HP Executive Scorecard component servers are fully functioning.
l When a database is corrupted.
l When a component server fails, but the RDBMS server and it's databases are intact.
The section includes the following topics:

l "What to Back Up" below
l "General BackupGuidelines" on the next page

What to Back Up

HP recommends that you back up the following resources that may be used when one of the above
scenarios occurs.

1. Microsoft SQL Server 2008 enterprise SP2 databases
a. Staging database
b. Target database
c. SAP BusinessObjects Data Services database
d. SAP BusinessObjects CMS database, and if necessary the Audit database.
e. Management database
f. Executive Scorecard database

Note: The host and database names can be found in theManagement database
configured in the Executive Scorecard Configuration wizard.

2. DataWarehouse Configuration files. For more information, see "DataWarehouse Back Up " on
page 265.

3. SAP BusinessObject Enterprise configuration. This can be backed up with the BusinessObjects
Enterprise XI 3.1 Import Wizard. For more information, see Chapter 7 of the BusinessObjects
Enterprise XI 3.1 Import Wizard Guide at http://help.sap.com/businessobject/product_
guides/boexir31/en/xi3-1_bip_importwiz_en.pdf.

4. It is highly recommended that you keep the passwords for the Staging, Target and SAP
BusinessObjects Data Services databases in a safe place for usage in disaster recovery
situations.

5. Back up <agora>\dat\Version.txt (youmay need to restore it later).
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General Backup Guidelines

It is recommended that you use the following backup and restore guidelines:

l Your database administrator should back up critical data and configuration settings on a regular
basis.

l Database backups should consist of a weekly full database backups, and daily differential backups.
l Backups should be periodically verified by restoring a copy onto a test system.
l External source files and DataWarehouse configuration files should be backed up as required.
l Although out of scope for this document, regular backups should be taken of all source file
databases.

l Start scheduled backups before running the daily ETLs.
l Use backup compression.
l Perform full backups in off-peak times.
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Disaster and Recovery
The HP IT Executive Scorecard, DataWarehouse, or SAP BusinessObjects Data Services servers
have become unusable, for example the hard disk has crashed. The following procedure describes how
to recover the XS, DWH, and Database servers.

When you start the recovery process, youmust have complete backups of the relevant databases,
configuration files and settings that are readily available. It is possible that you will lose history data.
For details about the backups, see "Executive Scorecard Back Up " on page 268and "DataWarehouse
Back Up " on page 265.

The following scenarios are independent from the external data sources and entities. Recovering from a
scenario means that the component returns to a stable state.

About the recovery procedure
This section is a reference for the HP IT Executive Scorecard recovery process. The recovery process
for your environment may vary according to your business needs andmay require customization. Verify
that the following processes are consistent with your architecture and environment before you proceed
with real data.

Recovery for BOE server failure when BO was
not installed using XS for a 4 Servers
configuration
To recover from amajor SAP BusinessObjects Enterprise server failure where SAP BusinessObjects
Enterprise was not installed using Executive Scorecard, follow the instructions in the SAP
BusinessObjects Enterprise Disaster Recovery documentation.

Recovery for a DWH server failure in a 4 Servers
environment
The following procedure describes how to recover from aDWH server failure in a 4 Servers
environment.

1. Back up the external sources directory contents and the external sources archive directory from
the disaster DWH machine.

2. On a clean machine where you want to install a new DWH server in a 4 Servers
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environment:
a. Run the XS 9.50 installer.
b. When the post-install wizard pops up, restore the external sources directory contents and the

external sources archive directory that were backed up prior to the disaster.
c. Run the following SQL statement:

USE <Mng_Db_Name>
delete dbo.SETTINGS_MANAGEMENT
where NAME = 'dwh.is.installed' or NAME =’ fnd.dbverify.done’ or NAME = ’
bods.db.name'

d. On the BOE server, navigate toStart > SAP Business Intelligence > SAP
BusinessObjects BI platform Central Management Console, logon to the console,
navigate toData Services > Repositories, and delete the old repository.

e. Activate the post-install wizard:
i. In theManagement Database - Configure Management Database Settings page,

connect to your existing Configure Central Management (CCM) database.
ii. In theSAP BusinessObjects Data Services for HP XS page, enter a new bods DB

name to create a new BODS database..
iii. In theConfigure Target DatabaseSettings page, if displayed, choose to use the

existing target database.
iv. In theData Warehouse - Define Staging Database Logins page, provide the original

logons.
v. In theData Warehouse - Define Target Database Login page, provide the original

logons.
vi. When the post-install wizard is successfully completed, click Finish.

f. Redeploy the Core Content Pack (CP)manually by executing: dw_ds_automation.bat -task
Redeploy -cp Core

g. Redeploy all the CPs that were activated before the disaster, by executing: 
dw_ds_automation.bat –task Redeploy –cp <Content_Pack_Name>

h. For each CP activated before the disaster, execute:
dw_ds_automation.bat –task Activate -cp <Content_Pack_Name>

3. On the old XS App server, reconfigure the URLs for the data source management (DSM)
page and ETL management page as follows:
a. Disable Executive Scorecard.
b. Open <agora>\agora\glassfish\glassfish\domains\BTOA\config\appFW\applications.
c. Edit the dwh.xml file:
d. For the DSM page, change:

https://[OLD DWH server: port]/dw-web/DataSourceManagement.jsp
to
https://[NEW DWH server: port]/dw-web/DataSourceManagement.jsp

e. For the ETLmanagement page, change:
https://[OLD DWH server: port]/dw-abc-web/abc.jsp
to
https://[NEW DWH server: port]/dw-abc-web/abc.jsp
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f. Open <agora>\glassfish\glassfish\domains\BTOA and delete the generated and osgi-
cache directories if they exist.

g. Open <agora>\glassfish\glassfish\domains\domain1\imq and delete the instances
directory if it exists.

h. Enable HP Executive Scorecard.
4. Continue to run your ETLs on the new DWH server.

Recovery from a XS server failure in a 4 Servers
environment
The following procedure describes how to recover from an XS server failure in a 4 Servers environment.

1. On a clean machine where you want to install a new XS server in a 4 Servers
environment:
a. Run the XS 9.50 installer.
b. When the post-install wizard pops up, run the following SQL statement:

USE <Mng_Db_Name>
delete dbo.SETTINGS_MANAGEMENT
where NAME = 'xs.is.installed'.

c. Run the following SQL statement:
USE <Mng_Db_Name>
UPDATE [dbo].[SYS_VER] SET [MN] = 41
truncate table [dbo].[DB_UPGRADE]

d. Activate the 9.50 post-install wizard:
i. In theManagement Database - Configure Management Database Settings page,

connect to your existingManagement database.
ii. In theSAP BusinessObjects Enterprise Configure Central Management Server

(CMS) Database page, if displayed, connect to your existing central management
database.

iii. In theConfigure Target Database Settings page, if displayed, choose to use the
existing target database.

iv. In theData Warehouse - Define Staging Database Logins page, provide the original
logons.

v. In theData Warehouse - Define Target Database Login page, provide the original
logons.

vi. In theExecutive Scorecard - Configure Executive Scorecard Database page, select
to connect to an existing database.

vii. When the post-install wizard is successfully completed, click Finish.
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Recovery from the DWH, XS app, and BOE
server failure in a 2 Servers environment
The following procedure describes how to recover from aDWH, XS application, and BOE server failure
in a 2 Servers environment.

1. Back up the external sources directory contents and the external sources archive directory from
the disaster server machine.

2. On the clean machine where you want to install XS in a 2 Servers environment:
a. Run the XS 9.50 installer.
b. When the post-install wizard pops up, restore the external sources directory contents and the

external sources archive directory that were backed up prior to the disaster.
c. Run the following SQL statement:

USE <Mng_Db_Name>
delete dbo.SETTINGS_MANAGEMENT
where NAME = 'dwh.is.installed'
or NAME =’ fnd.dbverify.done’
or NAME = 'xs.is.installed'
or NAME = 'bo.engine.is.installed'
or NAME='bo.in.use'
or NAME='bods.ds.name'.

d. Activate the post-install wizard:
i. In theManagement Database - Configure Management Database Settings page,

connect to your existingManagement database.
ii. In the SAP Business Objects Enterprise - Configure Central Management Server

(CMS) Database page, create new CMS table and Audit table (the Audit can be inside
the CMS)..

iii. In theConfigure Target Database Settings page, if displayed, choose to use the
existing target database.

iv. In theData Warehouse - Define Staging Database Logins page, provide the original
logons.

v. In theData Warehouse - Define Target Database Login page, provide the original
logons.

vi. In theExecutive Scorecard - Configure Executive Scorecard Database page, select
to connect to an existing database.

vii. When the post-install wizard is successfully completed, click Finish.
e. Redeploy the Core Content Pack (CP), and all the CPs that were activated before the

disaster.
i. For the Core CP, execute: dw_ds_automation.bat -task Redeploy -cp Core
ii. For each content CP activated before the disaster, execute:

dw_ds_automation.bat -task DeActivate -cp >Content_Pack_Name>
dw_ds_automation.bat -task Redeploy -cp >Content_Pack_Name>

Administrator Guide
Disaster and Recovery

HP IT Executive Scorecard (9.50) Page 273 of 342



dw_ds_automation.bat –task Activate -cp >Content_Pack_Name>

Note: Youmust check the dws.content_pack table in the Staging database.

3. Continue to run your ETLs on the new DWH server.

Recovery of a database server failure in a 2
Servers or a 4 Servers environment
The following procedure describes how to recover from a database server failure.

1. Verify that XS is stopped.
2. Restore the databases from the backup (CMS, MNG, REP, RES, STG, TRG) into the new

dbServer.

Note: The new dbServer must use same IP and name as the disaster dbServer.

3. Change the settings as follows.

Note: Passwords, including the admin password, in the new server cannot be changed. You
can change them once XS is up and running again.

UPDATE [<new_mng_database_name>].[dbo].[SETTINGS_MANAGEMENT]
SET VALUE =
CASE
WHEN NAME = 'new.tenant.db.host.name' THEN '<mng_new_db_server>'
WHEN NAME = 'new.tenant.db.port' THEN '<mng_ new_db_port>'
WHEN NAME = 'target.db.server' THEN '<target_ new_db_server>'
WHEN NAME = 'target.db.mssql.dbname' THEN '<target_ new_db_name>'
WHEN NAME = 'target.db.port' THEN '<target_ new_db_port>'
WHEN NAME = 'target.db.admin.username' THEN '<target_new_admin_logon_name>'
WHEN NAME = 'bods.db.name' THEN '<bods_new_db_name>'
WHEN NAME = 'bods.db.admin.username' THEN '<bods_new_db_admin_logon>'
WHEN NAME = 'bods.db.username' THEN '<bods_new_db_logon>'
WHEN NAME = 'bods.db.server' THEN '<bods_new_db_server>'
WHEN NAME = 'bods.db.port' THEN '<bods_db_port>'
WHEN NAME = 'staging.db.mssql.dbname' THEN '<staging_db_name>'
WHEN NAME = 'staging.db.admin.username' THEN '<staging_db_admin_logon>'
WHEN NAME = 'staging.db.server' THEN '<staging_db_admin_server>'
WHEN NAME = 'staging.db.port' THEN '<staging_db_port>'
WHEN NAME = 'result.db.host' THEN '<result_db_server>'
WHEN NAME = 'result.db.server' THEN '<result_db_server>'
WHEN NAME = 'result.db.mssql.dbname' THEN '<result_db_name>'
ELSE VALUE
END
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For example:

UPDATE [dvm1319_MNG_new].[dbo].[SETTINGS_MANAGEMENT]
SET VALUE =
CASE
WHEN NAME = 'new.tenant.db.host.name' THEN 'labm3amdb38.devlab.ad'
WHEN NAME = 'new.tenant.db.port' THEN '1433'
WHEN NAME = 'target.db.server' THEN 'labm3amdb38.devlab.ad'
WHEN NAME = 'target.db.mssql.dbname' THEN 'dvm1319_TRG_new'
WHEN NAME = 'target.db.port' THEN '1433'
WHEN NAME = 'target.db.admin.username'THEN 'sa'
WHEN NAME = 'bods.db.name' THEN 'dvm1319_REP_new'
WHEN NAME = 'bods.db.admin.username' THEN 'sa'
WHEN NAME = 'bods.db.username' THEN 'dvm1319_REP_new'
WHEN NAME = 'staging.db.mssql.dbname' THEN 'dvm1319_STG_new'
WHEN NAME = 'staging.db.admin.username' THEN 'sa'
WHEN NAME = 'staging.db.server' THEN 'labm3amdb38.devlab.ad'
WHEN NAME = 'staging.db.port' THEN '1433'
WHEN NAME = 'result.db.host' THEN 'labm3amdb38.devlab.ad'
WHEN NAME = 'result.db.server' THEN 'labm3amdb38.devlab.ad'
WHEN NAME = 'result.db.mssql.dbname' THEN 'dvm1319_RES_new'
ELSE VALUE
END

4. Mng DB Details:On each DWH and XS server you install, in <agora>\conf\mngdb.properties,
change the values of the following keys:
l central.db.name

l central.host.name

l central.user.name

l central.server

l central.port

l mng.db.name

l mng.host.name

l mng.user.name

l mng.server

l mng.port

l jdbc.url (server, port and DBName)

l db.username
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5. In <agora>\glassfish\glassfish\domains\BTOA\config\domain.xml change the connection
pool properties (User, URL, databaseName) in three locations for DWH server and in four
locations for XS server, by searching for:
<property name="user"
<property name="url"
<property name="databaseName"

6. On each server where you are performing an installation, restart Glassfish
In a 4 Servers environment, it is recommended perform the restart on the servers in the following
order: DWH and XS servers.

7. Verify that XS is up and running, as follows:
l Execute the following URL on the server browser:http://localhost:11021/invoke?operation=
showServiceInfoAsHTML&objectname=
Foundations%3Atype%3DSupervisorManager

l If you are prompted for authentication, enter:
Username: admin
Password: admin

l Refresh the execution until the status of XS is STARTED.

8. Recreate the logons and and regenerate logons and users for:
l DWH logons: (Run the command on the DWH server)
<HPXS>\agora\DataWarehouse\bin\dw_foundation_setup.bat -taskName initDB

l Other logons:

Note: If the logon exists use alter instead of create.

i. For BODS: Run a query on the relevant DB Server (BODS Repository dbServer).

Use master
CREATE LOGIN <bods_new_logon_name> WITH PASSWORD=N'<the_same_password>',
DEFAULT_DATABASE=<bods_logon_name >, DEFAULT_LANGUAGE=[us_english],
CHECK_EXPIRATION=OFF, CHECK_POLICY=OFF
GO
use <bods_database_name>

ALTER USER <bods_user_name> WITH LOGIN = <bods_new_logon_name>
GO
ALTER USER <bods_user_name> WITH DEFAULT_SCHEMA=[dbo]
GO
EXEC sp_addrolemember N'db_datareader', N'<bods_user_name>'
GO
EXEC sp_addrolemember N'db_ddladmin', N'<bods_user_name>'
GO
EXEC sp_addrolemember N'db_owner', N'<bods_user_name>'
GO
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Note: <the_same_password> is the password used for the old BODS database
server.

ii. For XS: Run a query on the relevant DB Server (Target dbServer).

Use master
CREATE LOGIN XS WITH PASSWORD=N'<the_same_password>',
DEFAULT_DATABASE=<new_target_database_name>,
DEFAULT_LANGUAGE=[us_english], CHECK_EXPIRATION=OFF, CHECK_POLICY=OFF
GO
use <new_target_database_name>
ALTER USER XS WITH DEFAULT_SCHEMA=XS
GO
EXEC sp_addrolemember N'db_datareader', N'XS'
GO
EXEC sp_addrolemember N'db_ddladmin', N'XS'
GO
EXEC sp_addrolemember N'db_owner', N'XS'
GO
EXEC sp_addrolemember N'DWT_USER_ROLE', N'XS'
GO
ALTER AUTHORIZATION ON SCHEMA::XS TO XS
GO
ALTER USER XS WITH LOGIN = XS
GO

Note: <the_same_password> is the password used for the sa logon to the target
database server.

iii. For ITFM:Run a query on the relevant DB Server (Target dbServer).

Use master
CREATE LOGIN itaapp WITH PASSWORD=N'<the_same_password>',
DEFAULT_DATABASE=<new_target_database_name>, DEFAULT_LANGUAGE=[us_
english],
CHECK_EXPIRATION=OFF, CHECK_POLICY=OFF
GO
use <new_target_database_name>
ALTER USER itaapp WITH DEFAULT_SCHEMA= itaapp
GO
EXEC sp_addrolemember N'db_datareader', N'itaapp'
GO
EXEC sp_addrolemember N'db_ddladmin', N'itaapp'
GO
EXEC sp_addrolemember N'db_owner', N'itaapp'
GO
EXEC sp_addrolemember N'DWT_USER_ROLE', N'itaapp'
GO
ALTER AUTHORIZATION ON SCHEMA:: itaapp TO itaapp
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GO
ALTER USER itaapp WITH LOGIN = itaapp
GO

Use master
CREATE LOGIN itafpaqry WITH PASSWORD=N'<the_same_password>',
DEFAULT_DATABASE=<new_target_database_name>, DEFAULT_LANGUAGE=[us_
english],
CHECK_EXPIRATION=OFF, CHECK_POLICY=OFF
GO
use <new_target_database_name>
ALTER USER itafpaqry WITH DEFAULT_SCHEMA= itafpaqry
GO
EXEC sp_addrolemember N'db_datareader', N'itafpaqry'
GO
EXEC sp_addrolemember N'db_ddladmin', N'itafpaqry'
GO
EXEC sp_addrolemember N'db_owner', N'itafpaqry'
GO
EXEC sp_addrolemember N'DWT_USER_ROLE', N'itafpaqry'
GO
ALTER AUTHORIZATION ON SCHEMA:: itafpaqry TO itafpaqry
GO
ALTER USER itafpaqry WITH LOGIN = itafpaqry
GO

9. On the DWH server:
l BODS Job Server

i. On the DWH server, locate the <BODS> \conf\DSConfig.txt file.
ii. Search for the section that includes your jobServer details (typically it should be named:

“[AL_JS_JobServer_1]”).
Change the relevant entries (User, database, server) to match the new database details.
Do not change the password.

Note: User refers to the BODS logon name, not to the BODS user name.

l Resync BODS
i. On the DWH server, navigate toStart > SAP BusinessObjects Data Services 4.1 >

Data Services Server Manager.
ii. Click Edit Job Server Config.
iii. Double-click the JobServer.
iv. Click Resync.
v. Enter the BODS logon password and click Apply.
vi. Click OK to close the window.
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vii. Click OK to finish the configuration.
viii. Restart your JobServer from the button at the bottom of themain dialog.

l Repository Manager:
i. On the BOE server, navigate toStart > SAP Business Intelligence > SAP

BusinessObjects BI platform Central Management Console.
ii. Log on to the console.

A. Navigate toData Services > Repositories.
B. Delete the old repository and create a new one according to the new database

details by clickingConfigure repository.
C. Click Test Connection to verify the connection information, and click Save.

iii. On the BOE server, navigate toStart > SAP BusinessObjects Data Services 4.1 >
Data Services Management Console.

iv. Log on the console. The default is admin/admin, if it has not been changed.
A. Go toAdministrator > Web Services.
B. Click theWeb Services Configuration tab.
C. Go to the bottom of the screen and select theSelect All check box.
D. In the combo box below it, click Add Batch Job.
E. Click Apply.

l BODS Datastores (glassfish must be up and running):
Run the following commands on the DWH server:
o <HPXS>\agora\DataWarehouse\bin\dw_ds_gen.bat -datastore all -outputdir

"<HPXS>\agora\DataWarehouse\tmp\datastores"
o <HPXS>\agora\DataWarehouse\bin\dw_ds_import.bat -inputdir

"<HPXS>\agora\DataWarehouse\tmp\datastores"

10. On the BOE Server:
l BOE – Update ODBC Connections

i. OpenC:\Windows\SysWOW64\odbcad32.exe.
ii. OpenSystem DSN and configure the BOE ODBC connection to connect the new CMS

database.

l BOE – Update JDBC Connections

Note: OnBOE server, youmust install SAP BusinessObjects BI platform 4Client Tools
manually.

i. Navigate toStart > SAP Business Intelligence > SAP BusinessObjects BI platform
4 Client Tools > Universe Design Tool.

ii. In the dialog box that opens, enter the following parameters:
l System: localhost:6400
l Username: administrator

Administrator Guide
Disaster and Recovery

HP IT Executive Scorecard (9.50) Page 279 of 342



l Password: <BOE_Password>
l Authentication:Enterprise

iii. Click Cancel in theWelcome page.
iv. Navigate to Tools > Connections.
v. Change all connection details and test the connection for the following: XS_MNG_JDBC,

ita_admin, ita_operations.
vi. After the tests are successful, click Next.
vii. In the next dialog box, enter the recommended numbers as follows:

l Connection Pool Mode:Keep the connection active for
l Pool timeout: 600
l Array fetch size: 100
l Array bind size: 500
l Login timeout: 500

viii. Click Finish.

11. On the DWH server, run the ETL.

Administrator Guide
Disaster and Recovery

HP IT Executive Scorecard (9.50) Page 280 of 342



BODS Maintenance
Compact the BODS repository after each redeployment

Tip: For versions prior to 9.40, with each additional CP redeployment, mainly performed during the
content development process, the SAP BusinessObjects Data Services repository database gets
heavier because the records in the Data Services are not deleted from the tables but only marked
accordingly. This leads to large local repositories, corruption, bad response times, andmore.

It is recommended to compact the SAP BusinessObjects Data Services repository from time-to-time
(ideally after each CP redeployment) as follows:

1. Open the SAP BusinessObjects Data ServicesDesigner.
2. Specify the SAP BusinessObjects Data Services repository database connection details.
3. Select Open File > Compact Repository.
4. Select Local Repository and click OK.
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Data Warehouse Back-End Maintenance
You canmonitor and the ETL and other functions of the DataWarehouse using the back-end tools.

This section includes:

• Clean Up the Staging and Target Databases 284
• Clean up the staging and target databases 284

• Time Zone Configuration 285
• Update the DST time zone 286
• Change period dimensions 286
• Change the time zone using the dw_tz_update_dst utility 286

• Tracing and Logging 288
• Configure the Logs 290
• Access DataWarehouse log information 290

• Add Additional Data Sources 292
• Add additional data sources 292

• Change the Configuration Definition 293
• Change the data source configuration 293

• Change the DataWarehouse Period Dimensions 294
• Change period dimensions 294

• Naming Conventions 295
• DataWarehouse CommandReference 302
• ABC CommandReference 303
• DWH CommandReference 311
• The Automation Tool 319

• Advanced DataWarehouse Administration 322
• Advanced Utilities 323
• Validate Catalog and Stream Definitions 325
• Change the Number of Retries for a Failed ETL Step 326
• Change DataWarehouse Passwords 328
• Improve Performance 330
• Check the Runtime Status of Batch Jobs 331
• Resolve an ETL Error 332
• Monitor and Tune the DataWarehouse 333
• Purge Validation Tables 334
• Upgrade Content Packs 335
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• Upgrade Content Packs: dw_ds_automation.bat -task Upgrade -cp [cp name] -
newContentPackPath [path of the new cp] 335
• Consolidate Entities using the XREFMechanism 336
• SA Password Change 339
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Clean Up the Staging and Target Databases
You clean up the databases when you want to rerun the initial load.

The tables that are cleaned are: 

l All the data in the dwt tables in the target database.
l All the data in the dws, dwst, and xrefgen schemas in the staging database.

Note:

l The clean up tool cleans all data.
l The clean up tool cannot be activated during an ETL run.
l There is no possibility of rollback after the clean up.

Tasks

Clean up the staging and target databases
1. Backup the staging and target databases (so they are synchronized at the time of the backup)

using the tools of the relevant database servers.
2. Clean up the databases using the dw_cleandb tool.

Syntax

dw_clean_data [-help]

Options

Option Required? Description

-help N Display command syntax.

Examples

dw_clean_data.bat

For details, see "DWH CommandReference" on page 311
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Time Zone Configuration
The DataWarehouse (DWH) contains data extracted from external sources. The original data sources
can be repositories in separate locations. It is important that the DWH maintains accurate date and
time stamps that normalize the differences between the source time zones and the current time of the
data warehouse location. These differences include both Coordinated Universal Time (UTC) offset and
daylight savings time (DST) variations.

The data warehouse foundation has transparent internal functions that convert a source time zone
value to a UTC value, and convert the UTC value to the DWH local time zone during the ETL process.

To access:

At aWindows command prompt, switch to the <Installation folder>\Agora\Data Warehouse\bin
folder.

Learn More
DST Time Zone Information

The administrator must make sure that time zone information is current on the server hosting the Data
Warehouse. Although the definition of time zones and DST rules are fairly static, changes can occur,
for example, whenmoving the DST conversion date on a country-wide basis.

You can synchronize these changes to the Olson Timezone Database by obtaining and running the
Java TZUpdater Tool that is available on the Sun Developer Network (SDN). For more information,
visit the Java SE Timezone Updater Tool home page.

Change the Data Warehouse Period Dimensions 

This procedure should be followed when expanding the DWH First and Last Year period dimension
range.

It is highly recommended that once you enter First and Last Year period dimensions in the Executive
Scorecard Configuration wizard, any future changes should take the following into account:

1. The First Year period dimension should only be changed downwards, thereby including the current
First Year period dimension.

Example If the First Year dimension is currently set to 2005, any change should be a year
lower than 2005. Entering a year higher than 2005 can cause some data inconsistencies.

2. The Last Year period dimension should only be changed upwards, thereby including the current
Last Year period dimension.

Example If the First year dimension is currently set to 2025, any change should be a year
higher than 2025. Entering a year lower than 2025 can cause some data inconsistencies.
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Time Zone Update

The dw_tz_update_dst utility updates the DWH DST time zone information.

Tasks

• Update the DST time zone 286
• Change period dimensions 286
• Change the time zone using the dw_tz_update_dst utility 286

Update the DST time zone
1. Download and run the TZUpdater tool.
2. To update DWH Server tables, run the dw_tz_update_dst as described in "Change the time zone

using the dw_tz_update_dst utility" below.
To change data source Time Zone settings:

1. In the Executive Scorecard application, click Admin > Data Source Management, and for the
relevant Content Pack, click Activate to open the relevant activation page.

Note: If the content pack is already activated, youmust deactivate, and then reactivate the
content pack .

2. Change the Time Zone for the relevant data source, and click Next.
The TimeZoneInfo table, which is part of the Staging database, is automatically updated.

Note: There is a discrepancy in the status time display between ETL runs when BSM has a
different time zone than the BSM server.

Change period dimensions
1. In the Executive Scorecard application, click Admin > Settings > Data Warehouse , under

General, make the required changes in the First year handled by DWH dates and Last Year
handled by DWH dates settings, and click Save.

2. From a command prompt:
a. Navigate to

<Installation Directory\Agora\DataWarehouse\Bin
b. Run dw_period_dim_generator.

Change the time zone using the dw_tz_update_dst
utility
1. At aWindows command prompt, switch to the <Installation folder>\Agora\Data
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Warehouse\bin folder.
2. Run this command:

dw_tz_update_dst
a. Load or update the time zone information for a data source and the data warehouse.
b. Run this utility whenever you deploy new source data or when youmanually change the time

zone.
c. Time zone is expressed in GMT format: GMT +\-nn:nn.

Syntax

dw_tz_update_dst.bat
[-help]
[-verbose]

Options

Option Required? Description

-help N Display command syntax.

-verbose N Producemore detailed output.

Return codes:

0 – Success
1 – Success with warnings
>1 – Errors

Example

dw_tz_update_dst -verbose
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Tracing and Logging
This section describes the DataWarehouse (DWH) logging and tracingmechanism.

Learn More
The Java Logging Mechanism

The DWH scripts generate one log file for each batch utility, using the Java application Log4J. Each log
file is stored in the following directories:
<HP_XS>\agora\DataWarehouse\logs and
<HP_XS>\agora\glassfish\glassfish\domains\BTOA\logs

Example

l dw_initdb.log
l dw_generateschemas.log

The loggingmechanism allows each new block of log information to be appended to the existing log
until it reaches themaximum size of 1MB. At that point, new logging information is stored in a backup
file. There can be amaximum of five log files for a single script. You can change the log file name, size,
andmaximum number of backup files in the configuration files (XML files) in the <HP_
XS>\HPXS\agora\DataWarehouse\conf\ directory.

The SQL Command Logging Mechanism

All the SQL commands that are executed by the DWH software are redirected to a log file. You can
view the log file to trace the execution of all SQL commands. All log files are in the following directory:
<HP_XS>\agora\Datawarehouse\conf

The prefix of the log file name is the RDBMS type:mssql. The rest of the name is the name of the
SQL command.

If the log file name include the suffix _LastRun, the file contains the last run output of the SQL
command.

l mssql_TablesAndSeqsResult.log
l mssql_create_dw_schema_LastRun.log
To simplify interpreting SQL errors, the DWH applications parse the SQL server log files to report the
most critical SQL error to the user. For more information, you can review the entire log file. Because the
DWH appends log information in a history format in certain log files, you can review prior errors. Other
log files retain only the history of themost recent execution. These files always have the _LastRun
suffix.

Example:
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l mssql_check_db_options_LastRun.log
l mssql_create_dw_schema_date_time_dim_LastRun.log

These history log files contain the date and time the SQL command runs, the date and time it
completes, and the returned status of the SQL command.

Example:

----------------------------------------------------------------------
Start of command: sqlcmd -S localhost -d BTODW -U dwmetadata -P **** -i
"C:\...\\foundation\etc\sql\mssql\create_dw_staging_resources.sql" -o
"C:\...\\foundation\log\mssql_create_dw_staging_resources_LastRun.log"
At: Wed Jul 02 13:35:59 PDT 2009
----------------------------------------------------------------------
1:
2: ********** Creating staging resources **********
----------------------------------------------------------------------
End of command: sqlcmd -S localhost -d BTODW -U dwmetadata -P **** -i
"C:\...\\foundation\etc\sql\mssql\create_dw_staging_resources.sql" -o
"C:\...\\foundation\log\mssql_create_dw_staging_resources_LastRun.log"
At: Wed Jul 02 13:35:59 PDT 2009
Returned code is: 0

SAP BusinessObjects Enterprise Logs

SAP BusinessObjects Data Services produces many run-time logs. You can locate these logs in the
relevant directory
structure:
<HP_XS>\BO\bods\BusinessObjects Data Services\log

The \log directory has sub-directories to further organize the SAP BusinessObjects Data Services
logs.

Log Files

You can access the DataWarehouse Log files in:

l datawarehouse\logs
l C:\<Installationdirectory>\agora\glassfish\glassfish\domains\btoa\logs\server.log
All information in the DataWarehouse log files is automatically sent to theWindows Event Viewer
Application log.

Tasks

• Configure the Logs 290
• Access DataWarehouse log information 290
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Configure the Logs
1. Access the log configuration files in the following directory:

<HP_XS>\agora\DataWarehouse\conf
2. You can customize logging behavior of DWH utilities by editing a related log configuration file with

this naming convention: xxx-log4j.xml. For example, importdefs-log4j.xml. Open the related xxx-
log4j.xml file with a text editor:
a. Select the trace levels to control the amount of information stored in the logs: trace, debug,

info, warn, error, or fatal.
The default value is info. You can experiment with different levels to see how much
information that you want to display or suppress.

b. Change the other relevant parameter values.
c. Save the file before you close it.

3. For ABC utilities, (abc-xxxx) there is a single log configuration file: abc-log4j.xml. The values that
you specify in this file apply to all log files generated by any ABC utility.

Access Data Warehouse log information
1. On theWindows taskbar, click Start > Administrative Tools > Event Viewer.
2. ExpandWindows Logs, right-click Application, and then click Filter Current Log.
3. Select the relevant Event Levels, select the relevant Event Sources, and then click OK.

Note:  All the DataWarehouse Event Sources begin with DWH.

Reference
Sample Log Information

The following examples show the type of information you can find in these log files.

l The first example shows that a fatal error has occurred.

2008-07-02 13:33:10,652 INFO [com.hp.bto.dw.sqlbatch.SqlBatch] -
Checking database options...
2008-07-02 13:33:10,949 FATAL
[com.hp.bto.dw.dbcreate.DbCreateCommandLine] - Problem during DB
options check:
An error that can be corrected by the user has been found. Check the
log file to correct the problem.
Check the error log file
'C:\...\\foundation\log\mssql_check_db_options_LastRun.log', line
number 2
008-07-02 13:33:10,949 FATAL
[com.hp.bto.dw.dbcreate.DbCreateCommandLine] - Exit code: 6
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l The second example shows successful execution.

2008-07-02 13:36:27,136 INFO
[com.hp.bto.dw.dbmetadatatool.DbMetadatatool]
Creating Date and Time stored procedures and populating the dimension
tables...
2008-07-02 13:36:30,511 INFO
[com.hp.bto.dw.commons.dblogparser.LogParserStatus] - Command
successfully executed.

It is possible to change the format of the reported information by changing the corresponding
configuration files.
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Add Additional Data Sources
You can add additional Content Packs to the data warehouse that can then be activated or deactivated.

Tasks

Add additional data sources
1. Copy the Content Pack file into the CP directory: <Installation directory>\agora\Content

Packs.
2. Run the following batch file: dw_cp_register.bat -name <new CP>. The name enteredmust

match the Content Pack file name.
3. Activate the data source using the Data SourceManagement page. For details, see "Data Source

Management" on page 131.
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Change the Configuration Definition
You can change data source configuration information only after you deactivate and then re-activate the
specific data source.

Tasks

Change the data source configuration
1. Select Admin > Data Source Management.

2. If necessary, deactivate the data source by clicking .
3. Click Edit Settings and edit the configuration parameters.
4. Click Next to validate your changes.

5. Click next to the specific source and the source is activated.
For details, see "Data SourceManagement" on page 131.
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Change the Data Warehouse Period Dimensions 
This procedure should be followed when expanding the DataWarehouse First and Last Year period
dimension range.

Tip: It is highly recommended that once you enter First and Last Year period dimensions in the
Executive Scorecard Configuration wizard, any future changes should take the following into
account:

1. The First Year period dimension should only be changed downwards, thereby including the
current First Year period dimension.

Example If the First Year dimension is currently set to 2005, any change should be a
year lower than 2005. Entering a year higher than 2005 can cause some data
inconsistencies.

2. The Last Year period dimension should only be changed upwards, thereby including the
current Last Year period dimension.

Example If the First year dimension is currently set to 2025, any change should be a year
higher than 2025. Entering a year lower than 2025 can cause some data inconsistencies.

Tasks

Change period dimensions
1. In the Executive Scorecard application, click Admin > Data Warehouse, underGeneral, make

the required changes in the First year handled by DWH dates and Last Year handled by
DWH dates settings, and click Save.

2. From a command prompt, navigate to
<Installation Directory>\agora\DataWarehouse\Bin
Run dw_period_dim_generator.
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Naming Conventions
Data Warehouse Naming Conventions

The following describes table and field naming conventions.

Type _Value Description

Table
Name
Suffixes

_DIM Dimension or bridge table.

_FACT Fact table.

_MS Monthly snapshot table that shows the last known value for the data at
the end of amonth.

_HIER Hierarchy table.

_ AGG Aggregate roll up table.

Field
Name
Prefixes

MD_ Metadata.

SRC_ Used for all fields that exist just for data warehouse internal processes.
Source. Used for all field drawn from the source for ETL purposes only
(not pushed to the target).

PK_ Primary key.

FLAG_ A binary field: Y/N.

DATE_ A date type.

DURATION_ A measure representing a length of time.

COUNT_ A measure representing a raw count.

AVG_ A measure representing an average roll up.

MAX_ A measure representing amaximum roll up.

MIN_ A measure representing aminimum roll up.

PCT_ A measure representing a percentage.
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Type _Value Description

Field
Name
Suffixes

_ID A surrogate key field that is primary or foreign.

_BASE A financial amount, currency, or exchange rate in the default currency of
the data warehouse.

_ UTC A date expressed in the UTC time zone. For dates: a date expressed in
the default display time zone for the data warehouse. For money: a
financial amount, currency, or exchange rate in the original currency of the
source data.

_LOC A date expressed in the local time zone.

Target and Staging Databases Naming Conventions

The first character of the Target and Staging databases namemust begin with an alpha character. The
init_db utility fails if you use database names that begin with numbers.

SAP BusinessObjects Data Services Naming Conventions

This section describes the naming conventions used by tables that are part of the SAP
BusinessObjects Data Services ETL process.

This section includes:

l "Datastore " below
l "Datastore Alias " on the next page
l "Project" on the next page
l "Job Names" on the next page
l "Workflows" on page 298
l "Dataflows" on page 298
l "Variables - Global - Local Variables - Parameters" on page 298
l "Custom Functions" on page 299
l "Scripts" on page 299
l "Try/Catch" on page 299
l "Conditionals" on page 300
l "Flat File Targets" on page 300
Datastore

Description Naming Convention and Examples

Connection to database with source
application views

Datastore names have a prefix with the datastore name
and a suffix of _DS.

Format:

<SOURCE APP>_DS

Examples:
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l AMVIEW_DS
l PPMVIEW_DS
l SMVIEW_DS

Connection to transactional entity
staging database

SRCSTAGING_DS

Connection to target entity staging
database

DWSTAGING_DS

Connection to data warehouse database DW_DS

Datastore Alias

Description Naming Convention and Examples

Name of Datastore for the specific source in
SAP BusinessObjects Data Services

Alias names have a prefix with the source
application name and a suffix of  _ALIAS.

Format:

<SOURCE APP>_ALIAS

Example AMVIEW_ALIAS

Alias user for transactional entity staging
database

SRCSTAGING_ALIAS

Alias user for target entity staging database DWSTAGING_ALIAS

Alias user for data warehouse database DW_ALIAS

Project

Description Naming Convention and Examples

Allows you to group jobs that have
dependent schedule or belong to the same
application

Project names have a prefix with the source
application name or purpose of the project and a suffix
of  _PJ.

Format:

<DESCRIPTION>_PJ

Example FPA_PJ

Job Names
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Description Naming Convention and Examples

SAP BusinessObjects Data Services job
which is a group of objects that you can
schedule and execute together

Job names have a prefix with the name of the source
application. An internal segment can describe the job
purpose. There is a suffix of _JB.

Format:

<SOURCE APP>_<PURPOSE>_JB or
<PURPOSE>_JB

Examples:

l AM_SOURCE_EXTRACT_JB
l DW_JB

Workflows

Description Naming Convention and Examples

Defines a decisionmaking
process to execute a
dataflow

Workflow names have a prefix with the source or target name. A SUB-
CATEGORY segment describes the ETL phase. There is suffix of _
WF.

Format:

<SRC NAME/TARGET NAME>_<SUB-CATEGORY>_WF

Examples:

l AM_AMRIGHTSUSESCOUNT_EXT_WF
l AM_MSI_CONTAINER_WF

Dataflows

Description Naming Convention and Examples

Data flows extract,
transform and load
data

Dataflow names have a prefix with the source or target name. A SUB-
CATEGORY segment describes the ETL phase. There is a suffix of _DF.

Format:

<SRC NAME/TARGET NAME><SUB_CATEGORY>_<ACTION>_DF

Examples:

AM_AMRIGHTSUSESCOUNT_EXT_DF

AM_SWAUDITDETAIL_MSI_DF

Variables - Global - Local Variables - Parameters

Description Naming Convention and Examples
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Variables defined in a job
Variables defined in a job/
workflow Parameters in a
workflow/ dataflow

Variable names have a dollar sign ($) and prefix to identify the
type of variable (G for global, L for local, or P for parameter). The
suffix identifies the purpose or identifying parameter name.

Format:

$G_<PURPOSE> or $L_<PURPOSE> or $P_<PURPOSE>

Examples:

l $G_BATCH_ID
l $L_STARTDATE
l $P_STATUS

Custom Functions

Description Naming Convention and Examples

Script functions in Data Integrator
scripting language

Custom function names have a prefix that describes the
purpose of the function.

The suffix is _FN.

Format:

<PURPOSE>_FN

Example STARTJB_FN

Scripts

Description
Naming Convention and
Examples

Scripts created in jobs or work flows. Description can refer to
function the script is performing or the name of the table the
script is loading

Script names have a prefix that
describes the data source or
target name.
A SUB-CATEGORY segment
describes the ETL phase. The
suffix is _SC.

Format:

<SRC NAME/TARGET NAME>
or <SUB_CATEGORY>_SC.

Example AM_
AMRIGHTSUSESCOUNT_
EXT_FAIL_SC

Try/Catch
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Description Naming Convention and Examples

Specify alternative workflows if errors
occur while executing a job

Try/catch names have a prefix that describes the data
source or target name.
A SUB-CATEGORY segment describes the ETL phase.
The suffix is _TRY or _CATCH.

Format:

<SRC NAME/TARGET NAME><SUB_CATEGORY>_
TRY
or <SRC NAME/TARGET NAME><SUB_
CATEGORY>_CATCH

Examples:

l AM_AMRIGHTSUSESCOUNT_EXT_TRY
l AM_AMRIGHTSUSESCOUNT_EXT_CATCH

Conditionals

Description Naming Convention and Examples

Conditionals are single-use objects used to
implement if-then-else logic in a work flow

Conditional names have a prefix that describes
the data source or target name.

A SUB-CATEGORY segment describes the
ETL phase. The suffix is _COND.

Format:

<SRC NAME/TARGET NAME><SUB_
CATEGORY>_COND

Example AM_
AMRIGHTSUSESCOUNT_EXT_COND

Flat File Targets

Description Naming Convention and Examples

Flat file
extracts of
source view

Flat file target names have a prefix that describes the datastore name. Segments
describe the source table name, batch ID, and A SUB-CATEGORY segment
describes the ETL phase. The suffix is .txt.

Format:

<DATASTORENAME (without _DS)>_<SOURCETABLENAME_BATCHID>
_<SUB-CATEGORY>.txt

Example AMVIEW_AMRIGHTSUSESCOUNT_' ||$G_Batch_ID||'
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_EXTRACT_FF.TXT AMVIEW_AMRIGHTSUSESCOUNT
_' ||$G_Batch_ID||'_EXTRACT_DELETE_FF.TXT
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Data Warehouse Command Reference
This section is a syntax reference for the out-of-box scripts that are available to ETL designers and
developers.

The data warehouse contains out-of-box .xml files in this directory:
<DWH_home_directory>\DataWarehouse\conf

The table in the Command Summary section lists the out-of-box scripts that you can use to accomplish
command line tasks. These scripts produce specific results. Changing themmay produce
unpredictable results when they run. For details, see "DWH CommandReference" on page 311.

This section includes:

"ABC CommandReference" on the next page

"DWH CommandReference" on page 311

"The Automation Tool" on page 319
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ABC Command Reference
This section describes all of the out-of-box ABC command files that are available to administer the
ABC functions. The table in the Command Summary section lists the out-of-box files that you can use
to accomplish ABC tasks.

Although SAP BusinessObjects Data Services runs the jobs that extract, transform, and load data,
ABC manages the actual launch, execution, and sequencing of the steps in these jobs. If you run jobs
using SAP BusinessObjects Data Services only, there can be conflicts, sequence errors, and data
corruption, and run-time statistics can be lost.

The data warehouse provides the out-of-box file (upstream.xml) that contains the required job steps.
The primary ABC tasks are to launch ETL batch jobs at regularly scheduled intervals and ensure that
the individual job steps run as soon as they are ready. In addition, the ABC Audit and Control reports
enable you to view information pertaining to the utilities.

Reference

Syntax Conventions

Command options in square brackets ([ ]) are optional.

Italicized lowercase expressions are variable values.

If a command option argument is a text string that contains blank spaces, youmust enclose it in
quotationmarks. Otherwise, the text before the blank space is considered the entire argument and the
remaining text becomes an undefined option.

Command Summary

The following command script files are available in this directory:
<Installation directory>\agora\DataWarehouse\bin

Name Purpose Primary User

"dw_abc_batch_control"
on the next page

Start and stop batch job streams. Administrator

"dw_abc_load_batch " on
page 305

Load a batch job stream or register it as a
scheduled task.

Administrator

Run job stream steps (the ABC engine) or register
it as a scheduled task.

Administrator

"dw_abc_retry_step " on
page 308

Restart a job stream step. Administrator

"dw_abc_job_launcher "
on page 309

Start or stop job steps within a job stream. Administrator or
ETL developer

"dw_abc_set_status " on
page 309

Capture the status of job stream steps that are
implemented as batch scripts.

Administrator or
ETL developer
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dw_abc_batch_control
Use this script to start and stop batch job streams. The dw_abc_batch_control utility enables you to:

l Suspend an active batch job stream
l Resume a suspended batch job stream
l Abort a running batch job stream
User

Administrator

Syntax

DWH_Admin

dw_abc_batch_control (-abort | -resume | -suspend)
(streamID <streamid> | -all)
[-help]

Options

Option Required? Description

Choose one of the following options:

-commandName all No Complete the named command action on all loaded
job streams.

-abort No Terminate -all or a specific streamID where the
streamID value is the catalog parameter value for
dwid="xxxx".

-abortAndKillJobs No Abort the specified stream and kill all currently running
SAP BusinessObjects Data Services jobs (if any
currently running).

-resume No Re-start -all or a specific streamID where the
streamID value is the catalog parameter value for
dwid="xxxx".

-suspend No Temporarily stop -all or a specific streamID where the
streamID value is the catalog parameter value for
dwid="xxxx"
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Choose one of the following options:

l -streamId streamId No The streamID value is the catalog parameter value for
dwid="xxxx" found in the xml file that describes the
stream: <Installation directory>\agora\Content
Packs\Core\ABC\upstream.xml

l -all No All streams currently executing.

-help No Display command syntax

Examples

l dw_abc_batch_control -suspend -streamid Stream1
l dw_abc_batch_control -resume -all

dw_abc_load_batch
Use this script to load a batch job stream or register it as a scheduled task.

The dw_abc_load_batch utility is responsible for starting an ABC ETL track. You can run this utility
manually at the command line, or scheduled it to run at scheduled intervals.

Batch job streams can run concurrently if each job stream is independent of other job streams;
however, if two concurrent batch jobs invoke the same job stream, they cannot run successfully. If the
dw_abc_load_batch utility successfully loads a batch job, as long as that batch job is running, any
attempt to load a second instance of the same batch job will fail. Running the out-of-box upstream.xml
job stream in overlapping batches produces errors.

The dw_abc_load_batch utility initializes the ABC stream and prepares the stream steps for
execution.

The dw_run_steps utility looks for these steps that are ready and starts each one individually. The
batch jobmanages the details of extracting entities from source databases.

All the job steps in the batch job reference the same batch ID. The initial state of the batch is Active.
The initial state of all of the pending processes (job steps) is Waiting.

User

Administrator

Syntax

dw_abc_load_batch -streamId <string>

[-register (-every <string> |-starttime <string>)]
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[-unregister]

[-list]

[-help]

Options

Option Required? Description

Choose one of the following options:

-list No List tasks scheduled to run.

-list _streamId <streamId> Yes Identify the stream ID value that is specified in the
stream file parameter dwid="xxxx".

-register No Create a scheduled task to run dw_abc_load_batch at
regular intervals.

-unregister _streamId
<streamId>

No Unregister all the events for the specified streamId
stream.

-starttime hh:mm No Start the task to load the batch where the value for hh is
00–24 and the value for mm is 00–59.

-streamid stream_id Yes Enter the stream ID of the stream for which a batch is to
be loaded: Cleandata, Restream, orUpstream.

-help No Display command syntax.

Examples

l dw_abc_load_batch -streamId streamId
l dw_abc_load_batch -streamId streamId -register -every 720
l dw_abc_load_batch -streamId streamId -register -starttime 22:30
l dw_abc_load_batch -unregister -streamId streamId
l dw_abc_load_batch -list -streamId streamId
l dw_abc_load_batch -unregister
l dw_abc_load_batch -list
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dw_abc_run_steps
Use this script to run job stream steps or register the action as a scheduled task.

The command verifies the successful execution of each step before a dependent step begins. It also
compiles a list of parallel and sequential execution steps that are ready to run, then launches each step
that is ready for execution.

The command:

l Determines which steps are ready to run and starts them.
l Creates processes for each step in a batch job stream.
l Reports execution state for each process, then updates a final execution status for the batch.
l Sets a status of Max_Execution_Time_Exceeded if a step exceeds its maximum execution time.
l If Max_Execution_Time_Exceeded occurs, stops job step execution.
l Finds all steps that are blocking the execution of a job stream and reports them.
l Retries any step that terminates with an error and has not exceeded the specifiedmaximum number
of retries.

You can specify amaximum number of retries when an error occurs, and amaximum execution time for
each step in the job stream definition file. Because they are optional parameters, they have default
values of no retries and unlimited execution time. For details see "Change the Number of Retries for a
Failed ETL Step" on page 326.

User

Administrator

Syntax

dw_abc_run_steps [-streamId <string>]

[-every <interval>]

[-register]

[-unregister]

[-list]

[-help]

Options

Option Required? Description

-every nnn No Start the batch load task every nnnminutes.

-list No Display a list of the registered events for all the stream
Ids.

-list _streamId
<streamId>

No Display a list of the registered events for the specified
streamId.
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-register No Create a scheduled task to run dw_abc_run_steps at
regular intervals.

-unregister _streamId
<streamId>

No Unregister all the events for the specified streamId
stream.

-streamId stream_id No Stream ID value for the step to restart.

-help No Display command syntax for this command.

Examples

l To run all possible steps with a ready status:
dw_abc_run_steps -streamId Upstream

l To create a scheduled task that executes the dw_abc_run_steps command every 60minutes:
dw_abc_run_steps -register -every 60 -streamId Upstream

l To remove a scheduled task that starts the dw_abc_run_steps:
dw_abc_run_steps -unregister -streamId Upstream

l To list a scheduled task that starts the dw_abc_run_steps:
dw_abc_run_steps -list -streamId Upstream

l To remove all scheduled tasks that starts the dw_abc_run_steps:
dw_abc_run_steps -unregister

l To list all scheduled tasks that starts the dw_abc_run_steps:
dw_abc_run_steps -list

dw_abc_retry_step
Use this script to restart a job stream step.

The dw_abc_retry_step utility re-starts a job step. When you specify amaximum number of retries,
the ABC engine blocks the job stream when that number is exceeded.

User

Administrator

Syntax

dw_abc_load_batch -streamId <string>
-stepId <string>
[-help]

Options

Option Required? Description

-stepId step_id Y Step ID value for the step to restart.

-streamId stream_id Y Stream ID value for the step to restart.
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-help N Display command syntax.

Example

dw_abc_retry_step -streamId Upstream -stepId step_id

dw_abc_job_launcher
Use this script to start or stop specific SAP BusinessObjects Data Services jobs.

User

Administrator or ETL developer

Syntax

dw_abc_job_launcher -jobname <string>
[-stop]
[-help]

Options

Option Required? Description

-jobname job_name Y Name of the job that you want to run.

-stop job_name N Stop job execution.

-help N Display command syntax.

If you omit the -process option, youmust set an environment variable%DW_PROCESS_ID% that
contains the value of the process ID.

Example

l dw_abc_job_launcher -jobname DW_JB
l dw_abc_job_launcher -stop -jobname DW_JB

dw_abc_set_status
Use this script to set the status of job stream steps that are implemented as batch scripts.

User

Administrator or ETL developer

Syntax

dw_abc_set_status (-error | -final | running | -success | -warning)
[-info <string>]
[-help]
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Options

Option Required? Description

Choose one of the following status parameters:

l -error N If an error occurs, update the data warehouse with
the error status.

l -final N If an error occurs, update the data warehouse with
themost severe status.

l -running N If an error occurs, update the data warehouse with
the run status.

l -success N If successful, update the data warehouse with the
success status.

l -warning N If a warning status occurs, update the data
warehouse with the warning status.

-help N Display command syntax.

The -info "message_text" is optional free text that you can display.

This script requires the DW_PROCESS_ID environment variable to be set with the value of the
process ID before you run this script.

Example

dw_abc_set_status -error -info "Job failed"
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DWH Command Reference
The following command script files are available in this directory:
<DWH_home_directory>\DataWarehouse\bin

Reference

DataWarehouse Script Files

dw_bods_xml_import
Use this script to import ETL from XML files to the SAP BusinessObjects Data Services repository.
The input XML files are located in the indicated directory, or its subdirectories.

Primary user: Administrator

Syntax

dw_bods_xml_import [-help] [-fromfile "<xmlfile>" | -fromdir "<directory>"]

Options

Option Required? Description

-fromdir <fromdir> N The directory, in the data source repository, that
contains the ETL XML files to import .

-fromfile <fromfile> N The XML file, in the data source repository, from
which the ETL is imported .

-help N Display command syntax.

Examples

dw_ds_gen -datastore all -outputdir c:\datastores dw_ds_gen -datastore PPM -outputdir
c:\datastores\PPM

dw_cleandb
Clean data from staging and target databases to start an initial load. For details, see "Clean Up the
Staging and Target Databases" on page 284.

Primary user: Administrator

Syntax

dw_clean_data [-help]
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Options

Option Required? Description

-help N Display command syntax.

Examples

dw_clean_data.bat

dw_ds_gen
Use this script to generate one or more datastores. SAP BusinessObjects Data Services imports these
datastores to enable SAP BusinessObjects Data Services jobs to connect to the database.

Primary user: ETL developer

Syntax

dw_ds_gen -datastore <dws|dwst|dwt|dwabc|PPM|AM|SM|all>
-outputdir <directory>
[-verbose]
[-help]

Options

Option Required? Description

-datastore Y Generate the specified data source (dws, dwst,
dwt, dwabc, PPM or AM). Specify all to
generate all sources.

-outputdir directory_name Y Path and name of the target directory where the
data source files are to be generated.

-verbose N Producemore detailed output.

-help N Display command syntax.

Examples

dw_ds_gen -datastore all -outputdir c:\datastores dw_ds_gen -datastore PPM -outputdir
c:\datastores\PPM
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dw_ds_import
Use this script to import source files from a named directory into themetadata repository. For example,
to import a collection of files into the datastore directory.

Primary user: ETL developer

Syntax

dw_ds_import -inputdir directory
[-help]

Options

Option Required? Description

-inputdir directory_name Y Path and name of the directory where the data
source files are to be imported.

-help N Display command syntax.

Example

dw_ds_import -inputdir "c:\datastore\Source Files"

dw_etl_export
Use this script to export SAP BusinessObjects Data Services jobs, workflows, data flows, functions
and other ETL components to a zip file.

Primary user: ETL developer

Syntax

dw_etl_export -zip <zipfile>
[-help]

Options

Option Required? Description

-zip zip_file_name Y Export to the specified archive file.

-help N Display command syntax.

Example

dw_etl_export -zip c:\etlFiles.zip
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dw_etl_import
Use this script to import SAP BusinessObjects Data Services jobs, workflows, data flows, functions,
and other ETL components t to a zip file.

Primary user: ETL developer

Syntax

dw_etl_import [-atl <atlFile>]
-topdir <directory>

[-zip <zipfile>]
[-help]

Options

Option Required? Description

-atl atl_file_name N Import the specified .atl file.

-topdir directory_name Y Import all .atl files under a specified directory and
subdirectory.

-zip zip_file_name N Import the contents of the archive file.

-help N Display command syntax.

Examples

dw_etl_import -topdir c:\etlFiles

dw_etl_import -topdir "c:\ETL Files"

dw_etl_import -zip c:\etlFiles.zip

dw_etl_import -atl c:\functions.atl

dw_etl_update_containers
This script loads .etl files during the installation process.

Primary user: ETL developer

Syntax

dw_etl_update_containers -topdir <directory>
[-verbose]
[-help]

Options

Option Required? Description
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-topdir directory_name Y Name of the directory that contains all application-
specific .atl files.

-verbose N Producemore detailed output.

-help N Display command syntax.

Return codes

0 – Success
1 – Success with warnings
>1 – Errors

Examples

dw_etl_update_containers -topdir "c:\My Application"

dw_etl_update_containers -topdir c:\MyApplication

dw_foundation_setup
Use this script to call the scripts that initialize the data warehouse, or load themetadata for data source
connections into the database, to build the data warehouse foundation

Primary user: Installer

Syntax

dw_foundation_setup [-args <taskArguments>]
-taskName <taskName>

[-verbose]
[-help]

Options

Option Required? Description

-args task_argument N Name of the task argument.

-taskName task_name Y Name of the requested task.

-verbose N Producemore detailed output.

-help N Display command syntax.

You can see the individual tasks and associated arguments called by dw_foundation_setup if you open
this file with a text or xml editor:
<DWH_home_directory>\DataWarehouse\etc\xml\dw_foundation_setup.xml

Return codes

0 – Success
1 – Success with warnings
>1 – Errors
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dw_generateschemas
Use this script to generate schemas and tables.

Primary user: ETL developer

Syntax

dw_generateschemas [-aggregates]
[-application <application>|all]
[-autoloadingmode true|false]
[-interface]
[-noninteractive]
[-product <product>|all]
[-staging]
[-target]
[-verbose]
[-help]

Options

Option Required? Description

-aggregates N Generate or update the aggregation tables.

-application application_
name | all

N Load the named application or load all applications. All
is the default if you are in non-interactivemode.

-autoloadingmode N Specify true or false. True is the default value.

-interface N Generate the SQL script files to create the interface.

-noninteractive N Run this script without prompting for user input. Use
all default values.

-product product_name | all N Load the specified product. All is the default value.

-staging N Generate or update the staging tables.

-target N Generate or update the target tables.

-verbose N Producemore detailed output.

-help N Display command syntax.

Interfaces will always be written to a file, whether autoloadingmode is on or not. Each interface for a
Data Source Connection is written to a separate file. If you do not specify a specific phase, all phases
execute.
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Example

dw_generateschemas -application myApp -autoloadingmode true -target

dw_initdb
Use this script to initialize data warehouse foundation database schemas.

Primary user: Administrator

Syntax

dw_init.bat [-confdir <directory>]
[-schema <schemaname>]
-sqldir <directory>

[-help]

Options

Option Required? Description

-confdir directory N Name of the directory that contains the .properties
file for the designated schemaname.

-schema schemaname N Name of the schema, such as dwmetadata, dws,
dwst, or dwt.

-sqldir directory Y Name of the directory that contains the schema and
.properties file.

-help N Display command syntax.

Examples

dw_init.bat -sqldir c:\myDbdirectory
dw_init.bat -sqldir c:\myDbdirectory -schema dwmetadata -confdir “c:\my Config
directory”

dw_tz_update_dst
Load or update the time zone information for a data source and the data warehouse. Run this utility
whenever you deploy new source data or when youmanually change the time zone. Time zone is
expressed in GMT format: GMT +\-nn:nn.

Primary user: Administrator

Syntax

dw_tz_update_dst.bat
[-help]
[-verbose]
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Options

Option Required? Description

-help N Display command syntax.

-verbose N Producemore detailed output.

Return codes:

0 – Success

1 – Success with warnings

>1 – Errors

Example

dw_tz_update_dst -verbose

dw_ds_automation
Data Source Configuration using the Automation Tool. For details, see "The Automation Tool" on the
next page.

Primary user: Administrator
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The Automation Tool
The automation tool is built and designed to simplify the different tasks of Data SourceManagement.

It contains Data SourceManagement back-end tools that simplify the usage, add some necessary
validations, and set the different statuses. The functions are used by the Data SourceManagement
user interface but also provides a command line interface so it can be used outside the application
server.

Reference

The following Command Line Interface (CLI) is available for Data SourceManagement functionality
outside the UI. The command script files are found in this directory:
<DWH_home_directory>\DataWarehouse\bin

TestConnection
Usage: dw_ds_automation.bat -task TestConnection -cp xxx -xmlFilePath [Path to datasources.xml
file]

Description: Test the connection to the data source. Should be used before running the configuration
task in order to validate correct connection details.

Register Instance
Usage: dw_cp_register.bat -addInstance –name <CP_NAME>

Description:

l Use to add an additional instance of the data source.
l The DataWarehouse then looks for the CP in the Content Packs Folder.
l The instance ID is displayed in the output.“Instance ID: XX has been added to Content Pack: <CP_
NAME>”

l It is also added to the CONTENT_PACK table.

ConfigureInitial
Usage: dw_ds_automation.bat -task ConfigureInitial -cp <content pack name>-instance
<INSTANCE_ID>-xmlFilePath [Path to datasources.xml file]

Description:

l Configure the CP connection settings before the CP has been initialized.
l Use prior to CP initialization (Deploy).

Note: To successfully run this command, the ALM passwordmust be encrypted before saving it in
the Staging database.
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Configure
Usage: dw_ds_automation.bat -task Configure -cp <content pack name>-instance <INSTANCE_ID> -
xmlFilePath [Path to datasources.xml file]

Description:Configure the CP connection settings and regenerate the datastore of the product. Can
be used only after the CP has been successfully initialized.

Note: If any the following sources HP Application Lifecycle Management, HP Business Service
Management, or HP Universal ConfigurationManagement Database are configured via a back-end
too, the relevant URL listed below should be run before the ETL is run:

l HP Application Lifecycle Management:
http://localhost:10002/dw/integrations/generic/reset/ALM

l HP Business Service Management:
http://localhost:10002/dw/integrations/bsm/reset/connection

l HP Universal Configuration Management Database:
http://localhost:10002/dw/integrations/ucmdb/ucmdb/reset/connection

Deploy
Usage: dw_ds_automation.bat -task Deploy -cp <content pack name>-instance <INSTANCE_ID>

Description: Initialize the CP and set the CP status as Initialized.

Activate
Usage: dw_ds_automation.bat -task Activate -cp <content pack name>-instance <INSTANCE_ID>

Description:Activate the CP using the stream Assembler and set the CP status as Activated.
Activating the CP causes its ABC stream to bemerged with theMain (Core) CP stream. Activated CP
stream steps will be executed during the execution of theMain (Core) ABC Stream.

Deactivate 
Usage: dw_ds_automation.bat -task DeActivate -cp <content pack name>-instance <INSTANCE_
ID>

Description:Deactivate the CP using the stream assembler and set the CP status as Non-Activated.
Deactivate performs the opposite action from Activate. Deactivate subtracts the deactivated CP ABC
Steps from theMain ABC Stream Steps.

AutoActivate
Usage: dw_ds_automation.bat -task AutoActivate

Description:Deploy and activate all CPs with "autostart" flag according to the order set by
"autostartpriority" in themanifest
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used by the post- install tool. Themanifest found in cp_manifest.properties, is a list of attributes
located in the root directory of the Content Pack.
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Advanced Data Warehouse Administration
This section describes some of the advanced commands for DWH processes. DWH also provides a
set of reports that provide the administrator with awareness and insight into the DWH processes.

This section includes:

"Advanced Utilities" on the next page

"Validate Catalog and Stream Definitions" on page 325

"Change the Number of Retries for a Failed ETL Step" on page 326

"Change DataWarehouse Passwords" on page 328

"Improve Performance" on page 330

"Check the Runtime Status of Batch Jobs" on page 331

"Resolve an ETL Error" on page 332

"Monitor and Tune the DataWarehouse" on page 333

"Purge Validation Tables" on page 334

"Upgrade Content Packs" on page 335

"Consolidate Entities using the XREFMechanism" on page 336

"SA Password Change" on page 339
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Advanced Utilities
The DataWarehouse enables you to run advanced ABC utilities.

Reference

dw_abc_job_launcher
Use this script to start or stop specific SAP BusinessObjects Data Services jobs.

User

Administrator or ETL developer

Syntax

dw_abc_job_launcher -jobname <string>
[-stop]
[-help]

Options

Option Required? Description

-jobname job_name Y Name of the job that you want to run.

-stop job_name N Stop job execution.

-help N Display command syntax.

If you omit the -process option, youmust set an environment variable%DW_PROCESS_ID% that
contains the value of the process ID.

Example

l dw_abc_job_launcher -jobname DW_JB
l dw_abc_job_launcher -stop -jobname DW_JB

dw_abc_set_status
Use this script to set the status of job stream steps that are implemented as batch scripts.

User

Administrator or ETL developer

Syntax

dw_abc_set_status (-error | -final | running | -success | -warning)
[-info <string>]
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[-help]

Options

Option Required? Description

Choose one of the following status parameters:

-error N If an error occurs, update the data warehouse with
the error status.

-final N If an error occurs, update the data warehouse with
themost severe status.

-running N If an error occurs, update the data warehouse with
the run status.

-success N If successful, update the data warehouse with the
success status.

-warning N If a warning status occurs, update the data
warehouse with the warning status.

-help N Display command syntax.

The -info "message_text" is optional free text that you can display.

This script requires the DW_PROCESS_ID environment variable to be set with the value of the
process ID before you run this script.

Example

dw_abc_set_status -error -info "Job failed"
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Validate Catalog and StreamDefinitions
ABC utilities automatically validate xml syntax and perform more sophisticated validation, such as loop
detection in a job stream and valid catalog references to the job stream (dwid=Upstream).

If an error occurs, you can view the DW ABC Streams Management UI for stream information. Fore
details, see " ETLManagement " on page 159.

Additionally you can review the ABC Operational Status report to see where the process failed. For
details, see ABC -Operational Status Report.
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Change the Number of Retries for a Failed ETL Step
The job stream batch file has a job stream step for each required task in the end-to-end ETL process
and for each data source. Each job stream step has a parameter value that specifies the number of
retries allowable before the job step terminates with an error. You canmanually edit this value to
increase or decrease the number of retries.

Tasks

Change the number of retries
1. Navigate to the installation directory structure to locate the following file:

<Installation directory>\agora\contentpacks\{$CP}\ABC\${stream name}.xml, (depending on
the ${CP})

2. Save a backup copy of the file before you proceed.
3. Open upstream.xml with a text editor. There is a sequential list of job stream steps that manage

the entire ETL process.

<ns1:JobStreamSteps>
<ns1:JobStreamStep dwid="SYS_READY" businessname="check ETL pre
conditions" ... maxretries="4"/>
<ns1:JobStreamStep dwid="EXTERNAL_FILE" businessname="extract External
Files" ... maxretries="4"/>
<ns1:JobStreamStep dwid="PPM_SOURCE_EXTRACT" businessname="extract PPM
to FF"... " maxretries="4"/>
<ns1:JobStreamStep dwid="AM_SOURCE_EXTRACT" businessname="extract AM to
FF" ... maxretries="4"/>
<ns1:JobStreamStep dwid="ENTERPRISE_XREF" businessname="load Xref
table" ... maxretries="4"/>
<ns1:JobStreamStep dwid="PPM_EXT" businessname="load PPM FF" ...
maxretries="4"/>
<ns1:JobStreamStep dwid="AM_EXT" businessname="load AM FF" ...
maxretries="4"/>
<ns1:JobStreamStep dwid="PPM_SSI" businessname="PPM Single Source
Identity" ... maxretries="4"/>

4. Locate the job stream step that you want to modify and changemaxretries="4" to
maxretries="nn"where nn is the number of retries before the job step terminates.

5. Save and close the file.
6. In order to activate the new ABC definitions, youmust activate the changed CP ABC definitions.

a. If the ABC definitions weremodified in the CORE content pack, any change to the content
packs state would update the change.

b. If the ABC definitions weremodified in any of the Integration Content packs, youmust re-
activate the content pack to import the new definitions.
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7. Open the Data SourceManagement user interface, and re-activate themodified CP of which
definitions youmodified. For details, see "Data SourceManagement" on page 131.
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Change Data Warehouse Passwords
The installation and configuration process gathers all data warehouse and SAP BusinesObjects
passwords, encrypts them, and stores them in the DataWarehouse platform settings management.

Tasks

Note: In order for the ETL to successfully run after you have changed a password, youmust
change the Database Password and the Database Login Password in DataWarehouse Settings
UI. For details, see "DataWarehouse" on page 177.

Change a password
1. Stop any ETLs that are running, or abort a job stream if it is running.
2. On the RDBMS server, change the password for a specific logon name.
3. Click Admin > Data Warehouse, and update the relevant logon with the new password from step

2.

Note: Changing the password in the DataWarehouse user interface does not modify the
password in the database servers. It is preferable to rely on the user performing the password
updatemanually.

4. The DataWarehouse creates a database link which then uses the DataWarehouse and SAP
BusinessObjects Enterprise passwords. The Linked Server is created in the following situations:

5. a. The staging and target databases are installed on different servers.
b. The populated database server name in the post-install is different than the database host

name on the system server for server id_0.
In these situations, if you reset DWH user passwords (for dwabc, dwmetadata, dws, dwst, or,
dwt), go to Linked Servers in theMicrosoft SQL Server Management Studio, and change the
relevant passwords in theSecurity tab of the Linked Server Properties, as follows.
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6. When you change the passwords in the DataWarehouse user interface as well as the database
server youmust run the following:
l <DWH root dir>\bin\dw_ds_gen.bat -outputdir \tmp\datastores -datastore all

l <DWH root dir>\bin\dw_ds_import -inputdir \tmp\datastores

7. Reload the batch using dw_abc_load_batch.bat.
8. Run ETL.
9. Note that a reboot is recommended after passwords change.

Note: It is recommended to avoid using localhost as the server database name.
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Improve Performance
Normal procedures require database administrators to set up aggregation, indices, and partitions that
can enhance performance.

Enhancing and tuning overall database performance also improve the data warehouse performance.

Because the end-to-end ETL process involves accessing remote source databases and network
connections, youmay want to evaluate where performance degradation occurs and apply tuning
strategies to these external connections.
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Check the Runtime Status of Batch Jobs
You can check the status of batch jobs and step status using the DW ABC Streams Management UI.

Additionally, the data warehouse produces operational and administrative reports that contain
information about job status and other critical data warehouse activities.

When you view the ABC Operational Status report, you can see the global status and state of each
ETL job stream and a snapshot of the runtime status of each job stream step.

For details, see " ETLManagement " on page 159

To view reports, see ABC -Operational Status in Control ReportsControl Reports.
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Resolve an ETL Error
ETL jobs contain stream steps that you can restart. Using the DW ABC Streams Management UI, you
can view relevant step information.

If the stream step is ready for processing, the next scheduled execution of abc_run_steps.batwill
restart the stream step automatically.

If there is another impediment, such as source database or connection issues, youmust resolve that
issue before the step can complete successfully.

In the DW ABC Streams Management UI you can view step status, manually retry steps, as well as
schedule run_steps command.

For details on viewing errors and step information, see " ETLManagement " on page 159.

For back-end details, see "ABC CommandReference" on page 303.
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Monitor and Tune the Data Warehouse
The overall health of the data warehouse depends on the administrative skill of the RDBMS
administrator.

TheMicrosoft SQL Server 2008 database administrator uses standard operating procedures for daily
database operations.

The data warehouse is governed by these same processes and procedures.

For monitoring and tuning details, see theMicrosoft SQL Server 2008 documentation.
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Purge Validation Tables
There is no automated process to purge these tables on a regular schedule.

Because organizations require audit and validation information to be retained for varying amounts of
time, you should verify what the appropriate retention period is in your organization.

Tasks

Purge Validation Tables
Use the following SQL script to delete all records in each of the validation tables that are older than the
defined retention period.

CREATE OR REPLACE PROCEDURE sp_del_valf_info AS
--declare variables
BEGIN
--Delete All Required records in selection
DELETE FROM *.VALF
WHERE --trunc(Date) < '09-FEB-06'
);
COMMIT;
END sp_del_valf_info >
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Upgrade Content Packs
In a case where you have a newer Content Pack directory that contains updates or fixes for the OOTB
CP you can perform the following.

Tasks

Upgrade Content Packs: dw_ds_automation.bat -task
Upgrade -cp [cp name] -newContentPackPath [path of
the new cp]
The following steps are automatically included in the upgrade tool:

1. Deactivate all Integration Content Packs that are activated. It is recommended to stop ETL
running and cancel all scheduling.

2. Zip the original Content Pack directory.
3. Copy the Content Pack to a new directory and run the upgrade command for that path.

This overwrites the existing Content Pack directory.
4. Activate the Core Content Pack as well as the remaining Content Packs.
5. Update the content_pack table according to the new manifest, cp_manifest.properties, a list of

attributes located in the root directory of the Content Pack being upgraded.
For activation and deactivation details, see "Data SourceManagement" on page 131.

Note the following usage limitations:

l ETL Stream should not be in a runningmode - all streams must be aborted.
l The new CP directory must be a valid CP directory.
l CP should not be in Installed state, Integration Content Packs should be activated at least once
before upgrade.

l If Core is being upgraded, it must be in theActivated state.

Note: In order to avoid upgrade failure, do not change the executables in the ABC catalog.
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Consolidate Entities using the XREF Mechanism
The consolidation process for data sources enables you to take information from the various sources
and consolidate it into a single entity. Information from two or three sources is incorporated in the data
warehouse in order to create a new entity. The XREFmechanism enables you to give priorities to a
specific source when the same entity is extracted from different sources. Additionally you can give
priority to instances of the same source.

Learn More

Set Consolidation Priorities
You can change the specific consolidation priority at the entity level using an Excel spreadsheet. Each
source has an Excel which contains a list of the entities that can be consolidated, which you can
prioritize according to number, starting with 1. If you do not want an entity from a particular source to be
consolidated, enter a priority of -1.

Tasks

Change the entity priority
1. UsingWindows Explorer, navigate toC:\<Installation Directory>\agora\ContentPacks\<name

of CP>\ETL\flatfiles. For XREF consolidation following deployment, navigate toC:\<Installation
Directory>\agora\DataWarehouse\ExternalSources.

2. Open the specific consolidation file, for example: CONSOLIDATION_PRIORITIES_PPM.
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3. Enter the priority you want to assign to each entity (DW_ID).

Source Instance Name Consolidated Name Name Priority

AM PERSON 1

PPM PERSON 2

SM PERSON 3

AM ORG 1

PPM ORG 2

SM ORG 3

AM LOCATION 1

PPM LOCATION 2

SM LOCATION 3

AM ACTUALCOST 1

PPM ACTUALCOST 2

AM PROJECT 1

PPM PROJECT 2

AM BUDGETLINE 1

PPM BUDGETLINE 2

4. Save and close the file.

Note:

Administrator Guide
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l Consolidation priorities for multiple instances of the same data source are given according to
the order of deployment.

l If in the same instance several records have the same priority qualifier, there is consolidation
between those entities (the process does not fail), and the latest priority is utilized.

Cancel the consolidation of a specific entity
1. In the database, open [dwmetadata].[ConsolidationPriorities].
2. Change the priority number to -1 for the specific entity.
3. Save the changes.

Note: It is not permitted tomanually change the -1 priority for OOTB entities that cannot be
consolidated.
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SA Password Change
The procedure for changing this password is complex, therefore it is recommended not to be done
often.

Tasks

Change the SA password
l On BOE server:

a. Change the password in BOE ODBC connection to the new password and restart the BOE.
b. Perform the following only if you created your own universes and you are using your own

connections (not one of the following: XS_APP_JDBC, XS_DWH_JDBC, ita_admin, ita_
operations).
i. Import all of your universes into the BOE designer.
ii. In the Tools menu, select Connections.
iii. Change the SA password for all of your connections.
iv. Save and export the Universes.
v. Make sure that Period_Universe appears under the XS_Studio directory.

l On the DWH server:

a. Stop running Executive Scorecard.
b. Copy the run_postinstall.bat file from \<Installation

Directory>\installation\HPXS903\backup\agora\confwizard to \HPXS\agora\confwizard
and execute this file.

c. In theMNGDB page of the wizard, change the password for the SA user.
d. Before the final wizard step, select Skip Data Warehouse configuration and continue

completing the post-install wizard.
e. Open the DataWarehouse UI, using the following url: http://<DWH Server name

(FQDN>/dwh
f. Log on to the application using the same credentials you used to log on to the XS application.
g. Navigate toAdmin > Data Warehouse and change the passwords for all SA users.
h. Restart the DWH server.
i. If you used the SA user as a BODS user (not recommended configuration), perform the following

from the CMD dir <<Installation Directory>\agora\DataWarehouse\bin>:
i. dw_ds_import.bat -inputdir \tmp\datastores
ii. dw_etl_update_containers.bat –topdir \tmp\datastores -upgrade

j. If you are not sure which user was used for BODS repository configurations, navigate toAdmin
> Data Warehouse and check theRepository Username parameter in the SAP
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BusinessObjects Data Services for HP FPA area.

l On the XS server:

a. Stop running Executive Scorecard.
b. Remove biar XS_SP2.biar from \<Installation Directory>\agora\confwizard\conf\scripts

and renameXS_SP3.biar toXS_SP2.biar.
c. Remove dwh_target_sp2_views from \<Installation

Directory>\agora\confwizard\conf\scripts\database\mssql and rename dwh_target_sp3_
views to dwh_target_sp2_views.

d. Copy the run_postinstall.bat file from \<Installation
Directory>\installation\HPXS903\backup\agora\confwizard to \HPXS\agora\confwizard
and execute this file.

e. In theManagementDatabase page of the wizard, change the password for the SA user.
f. In the Result Database page of the wizard, change the password for the SA user.

Make sure that you always connect to the existing DB when running configurations.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Administrator Guide (IT Executive Scorecard 9.50)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to SW-Doc@hp.com.

We appreciate your feedback!
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